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 برق چیست؟   -1 درس

ای روی ریموت کنترل شود. دکمهکننده موسیقی را فشار دهید، ناگهان آهنگی از بلندگو پخش میای روی پخش دکمه

انگیز با کمک جادوی برق  شوند. این کارهای شگفتتان در یک لحظه زنده میهای مورد علاقهتلویزیون را بزنید، برنامه

اندازد. وقتی  مبحث الکترونیک را تمام کنید،  افتند؛ نوعی انرژی که تمام وسایل فناوری خانه شما را به کار میاتفاق می

شده الکترونیک  جادوگر  یک  میشما  خود  دانش  از  استفاده  با  و  کند،  اید  طراحی  ذهنتان  که  را  اختراعی  هر  توانید 

، با نحوه کار  درس  در این   .کند تا برق را درک کنید و از آن استفاده عملی ببریداین مبحث  به شما کمک می  !بسازید

کنید: یک هشدار دزدی که در صورت ورود فرد ناشناس  شوید و سپس یک پروژه کامل الکترونیکی بنا میبرق آشنا می

کننده  توانید وسایل جالب و سرگرمکند. وقتی یاد بگیرید که چطور از برق استفاده کنید، میبه اتاق، شما را متوجه می

با دوستان بسازید. در ادامه همین مباحث، ما   یا یک بازی نوری برای بازی  الکترونیکی  دیگری مثل یک ساز موسیقی 

 دقیقاً این کارها را با هم انجام خواهیم داد! 

 !: روشن کردن یک لامپ1پروژه شماره 

شود  شود. بیایید ببینیم برق چگونه باعث میدهید، لامپ بلافاصله روشن میوقتی که در یک اتاق کلید چراغ را فشار می

 .دهیماین لامپ نور کند. برای شروع، یک آزمایش ساده انجام می

 :برای انجام این پروژه به قطعات زیر نیاز دارید

 .منبع انرژی مورد نیاز برای مدار شما :ولتی استاندارد  ۹باتری  •

 ولت طراحی شده باشد.  ۱۲تا  ۹ای( که برای ای )نور رشتهیک لامپ کوچک رشته •

 : بررسی لامپ 1گام 

نگاهی دقیق به لامپ خود بیندازید. باید یک رشته باریک فلزی )فیلامنت( را درون شیشه لامپ مشاهده کنید. یک سر 

به تماس قاعده لامپ وصل شده است و سر دیگر آن  فلزی کناری  به قسمت  فیلامنت  قاعده  این  پایین  فلزی در  دهنده 

 شود. متصل می
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 : وصل کردن لامپ به باتری۲گام 

ولتی خود را به حالت ایستاده روی میز قرار دهید. حالا لامپ را بردارید و به آرامی آن را طوری روی باتری قرار   ۹باتری  

های باتری تماس داشته باشد و قسمت فلزی کناری آن هم با قطب دیگر دهید که نقطه فلزی پایین لامپ با یکی از قطب 

 .باتری در تماس باشد. وقتی هر دو قسمت لامپ با باتری تماس کامل داشتند، لامپ روشن خواهد شد 

شود چون وقتی دو سر آن با باتری در تماس است، تبریک! شما فقط که با استفاده از برق نور تولید کردید! لامپ روشن می 

 کند. کند. این رشته به شدت گرم شده و شروع به نور دادن می جریان برق از داخل رشته فلزی )فیلامنت( لامپ عبور می 

 کند؟ برق چگونه لامپ را روشن می

می  سیم درون لامپ  باعث گرم شدن  برق  می اما چطور  بلافاصله روشن  نور  و چرا  اصلی وجود شود  مفهوم  شود؟ چهار 

 :شوند تا این اتفاق بیفتد دارند که با هم ترکیب می 

 ها الکترون •

 جریان •

 ولتاژ  •

 مقاومت •

 اند و در این بخش، هر یک را بررسی خواهیم کرد. ای برق همگی به هم مربوطاین مفاهیم پایه

 الکترون چیست؟

ها ذراتی بسیار کوچک هستند که بدون استفاده از یک  بینید از اتم ساخته شده است. اتمهمه چیزی که اطراف خود می

تری به نام پروتون ، نوترون و الکترون تشکیل  ها هم از ذرات کوچکشوند. اما حتی اتممیکروسکوپ ویژه، دیده نمی 

مثل    -  چرخندها دور این هسته میدهند و الکترونها، هسته اتم )یعنی مرکز آن( را تشکیل میها و نوترونپروتون.اندشده

 :هر دو ذره پروتون و الکترون دارای بار الکتریکی هستند.گردندسیاراتی که دور خورشید می

 پروتون بار مثبت دارد،  •

 . و الکترون بار منفی •

کنند مثل دو  ها به اتم بچسبند. چون بارهای مخالف همدیگر را جذب میشوند الکترونهمین بارهای الکتریکی باعث می

 .چسبندسر مغناطیسی که با هم قطبند و به هم می
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 ۲تصویر

برخی از مواد رسانا هستند، این به چه معنی است؟ اگر به این مواد انرژی بدهید )مثل انرژی ذخیره شده در یک باتری(،  

رشته فلزی )فیلامنت( درون لامپ شما از یک فلز رسانا    !کنندها شروع به حرکت از یک اتم به اتم دیگر میالکترون

 ها را به حرکت دربیاورد! هایی است که فقط منتظرند تا یک نیروی کوچک آنساخته شده است. این یعنی پر از الکترون

 دهدها را هل میولتاژ الکترون

باتری را به لامپ وصل می ولتاژ روی فیلامنت درون لامپ ایجاد میوقتی  این ولتاژ  .کنیدکنید، در واقع یک اختلاف 

می باعث  که  الکتروناست  ایجاد شود شود  الکتریکی  و جریان  کنند  سیم حرکت  درون  از  اندازه.ها  ولتاژ  واحد  گیری 

فکر کنید که    .کنند، بیشتر خواهد بودهایی که از سیم عبور میهرچه ولتاژ بیشتر باشد، تعداد الکترون.است (V) ولت

بیرون   پر از گلوله دارید: وقتی از یک طرف یک گلوله را فشار دهید، گلوله از طرف دیگر در همان لحظه  لوله  یک 

الکترون    -  پردمی برای  اتفاق  همین  تأخیر.  میبدون  هم  میها  وارد  سیم  سر  یک  از  الکترون  یک  وقتی  شود،  افتد؛ 

 شود. الکترون دیگری از سر دیگر آن خارج می

 

 3تصویر
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 جریان الکتریکی  

است که معمولاً   (A) شود و واحد آن آمپرکنند گفته میهایی که از درون یک سیم عبور میجریان به مقدار الکترون

را در توصیف رودخانه هم شنیده باشید،    " جریان"شاید قبلًا کلمه.داریمبرمی  "آمپ"یا    "آمپر"تر  آن را با کلمه کوتاه

جریان الکتریکی هم   .این یعنی مقدار زیادی آب در حال حرکت است .ای دارداین رودخانه جریان قوی :مثل این جمله

الکترونهرچه جریان قوی  :طور استهمین  باشد، تعداد  بیشتر استهایی که از سیم عبور میتر  و وقتی ولتاژ در    .کنند 

مثل این که آب به دلیل نیروی گرانش از بالای شیب به پایین    .یابدکند، جریان نیز افزایش مییک مدار افزایش پیدا می

می پیدا  )جریان  منفی  قطب  به سمت  باتری   )+( مثبت  قطب  از  هم  الکتریکی  دارد–کند، جریان  جریان  واقعیت،  .(  در 

میالکترون حرکت  عکس  جهت  در  خودشان  مثبت   -کنند  ها  سمت  به  باتری  منفی  از  جریان  . یعنی  از  ما  وقتی  اما 

 کند. کنیم که از مثبت به سمت منفی حرکت میکنیم، فرض میالکتریکی صحبت می

 دهد مقاومت، جریان را کاهش می

باعث می الکترونولتاژ  مقاومت  شود  جریان  این  برابر  در  مقاومت  اما  شود،  ایجاد  الکتریکی  و جریان  کنند  ها حرکت 

باغ هستید.کندمی در  آبیاری  لوله  با یک  بازی  به  کنید شبیه  ایجاد کرده  :فرض  مقاومت  دهید،  فشار  را  لوله  و  اگر  اید 

اما اگر شیر آب را بیشتر باز کنید )مثل این که ولتاژ را افزایش دهید (، فشار آب  .شودمقدار آب کمتری از آن خارج می

همین اتفاق  .حتی اگر همچنان لوله را به همان اندازه فشار داده باشید  —شود  رود و بیشتری آب از لوله خارج میبالا می

الکتریکی هم می مدارهای  ایجاد میدر  دارد، جریان کمتری  مقاومت وجود  وقتی  را    —شود  افتد.  ولتاژ  این که  مگر 

 ( است. Ωگیری مقاومت اهُم )واحد اندازه.افزایش دهید
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 روشن کردن لامپ

 :دو سر رشته فلزی )فیلامنت( درون لامپ شما به بیرون لامپ وصل هستند

 یک سر به قسمت فلزی کناری قاعده لامپ، •

 .دهنده فلزی در پایین لامپو سر دیگر به تماس •

می به لامپ وصل  را  باتری  ایجاد میوقتی  الکتریکی  مدار  نام  به  بسته    .کنیدکنید، یک چیز  مسیر  فقط یک  مدار  یک 

می اجازه  الکتریکی  جریان  به  که  کنداست  پیدا  آن جریان  منفی  قطب  به  )باتری(  ولتاژ  منبع  مثبت  قطب  از  ولتاژ  .دهد 

فیلامنت مقاومت دارد و این  .ها از درون مدار حرکت کنند از جمله از داخل فیلامنت لامپشود الکترونباتری باعث می

کنند،  ها از درون این مقاومت عبور میوقتی الکترون. شود جریان الکتریکی با کمی سختی عبور کندمقاومت باعث می

برای این که  .کندتا جایی که شروع به درخشیدن و تولید نور می  -شود  شود و فیلامنت گرم میانرژی زیادی تولید می

ها را هل دهد و جریان برقرار شود، باید یک حلقه بسته از قطب مثبت باتری به قطب منفی وجود  باتری بتواند الکترون

برق همیشه به یک مدار بسته    .شودداشته باشد. بدون این مسیر بسته، جریان الکتریکی نخواهیم داشت و لامپ روشن نمی

لامپ    —مثل این که سیم را ببرید یا لامپ را جدا کنید    -اگر حتی یک طرف مدار را قطع کنید  .نیاز دارد تا کار کند

تواند جریان پیدا کند. این به این دلیل است که جریان الکتریکی فقط در یک مسیر بسته می!شودبلافاصله خاموش می

تر به مدارها  بیایید کمی دقیق.تواند حرکت کندبدون یک حلقه کامل از باتری به لامپ و بازگشت به باتری، برق نمی

 کنند. نگاه کنیم و بفهمیم چطور تمام این قطعات با هم کار می
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 کند؟ کشی چگونه کار می مدار الکتریکی مثل یک سیستم لوله    -۲درس

 .کنیمکند، برق را با جریان آب مقایسه میبرای این که بهتر متوجه شویم مدار چگونه کار می

های حلقوی داریم که پر از آب است و یک پمپ در آن وجود دارد. در یک نقطه از این  تصور کنید یک سیستم لوله

 :دهندها هر کدام چیزی در مدار الکتریکی را نشان میخب، این قسمت. تر وجود داردلوله، نازل یا قسمتی باریک

 پمپ = باتری  •

لوله می در  و جریان آب  فشار  باعث  می  -شود  پمپ  ایجاد  ولتاژ  باتری که  به  مثل  مدار  در  را  الکتریکی  و جریان  کند 

 .آوردحرکت درمی

 (Resistance) باریکی در لوله = مقاومت •

 .شودمثل مقاومت در مدار که باعث کاهش جریان الکتریکی می -کند این قسمت جریان آب را کم می

 (Current) جریان آب در لوله = جریان الکتریکی •

پس مثل    .مثل عبور تعداد بیشتری الکترون در سیم  -هرچقدر آب بیشتری از داخل لوله عبور کند، جریان بیشتری داریم  

لوله سیستم  یک  در  که  مدار  این  در  باشد،  روشن  پمپ  و  باشد  کامل  حلقه  که  دارد  جریان  وقتی  فقط  آب  کشی، 

 .شودالکتریکی هم جریان فقط در یک مسیر بسته و با وجود منبع ولتاژ )باتری( برقرار می

 

 6تصویر

ها وارد کنید که نشان دهد هر ثانیه چقدر  گیری را در جایی از سیستم لولهحالا تصور کنید که بتوانید یک دستگاه اندازه

دقت کنید که منظور ما فقط مقدار آبی است که از یک نقطه خاص در لوله عبور    .کندآب از داخل آن نقطه عبور می

این دقیقاً همان روشی است که ما با آن درباره جریان الکتریکی صحبت  .  کند، نه مجموع آب موجود در تمام لولهمی

 کنند.هایی است که در هر ثانیه از یک نقطه مشخص در مدار عبور میجریان الکتریکی به معنی تعداد الکترون  :کنیممی
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 آشنا شدن با کلید )سوئیچ( 

می جا  همه  در  را  کلیدها  مطمئناً  کنید،  نگاه  خود  اطراف  به  آناگر  از  کردن  بینید.  خاموش  و  روشن  برای  روز  هر  ها 

وقتی چراغ یک اتاق روشن است، یعنی بخشی از یک مدار بسته است، چون جریان الکتریسیته  !کنیدها استفاده میچراغ

 .کنداز داخل لامپ عبور می

اتفاقی میاما وقتی کلید را خاموش می : این کار  کنید چه  افتد؟ خاموش کردن کلید مثل قطع یک سیم در مدار است 

 .دقیقاً مثل مدار باز که قبلًا دیدیم -شود جریان متوقف شود و چراغ خاموش گردد باعث می

 کلیدها در اطراف ما 

 :در اطراف خود انواع دیگری از کلیدها هم پیدا خواهید کرد، مثلًا

 کند، کلیدی که کامپیوترتان را روشن و خاموش می •

 کلید زنگ درب،  •

 دهد در یخچال باز است یا بسته، کلیدی که تشخیص می •

آن به  توجه  بدون  که  دارند  وجود  زیادی  کلیدهای  هم  هنوز  میو  استفاده  ازشان  می  .کنیمها  کار  کند؟ کلید چگونه 

 :ها این است کهوظیفه آن.ای هستندهای بسیار سادهکنند و دستگاهکلیدها جریان برق را کنترل می

 دو سیم را به هم وصل کنند تا مدار بسته شود،  •

 .یا دو سیم را از هم جدا کنند تا مدار باز شود  •

 .کنندکنند یا آن اتصال را قطع میدر درون یک کلید، فقط چند قطعه فلزی وجود دارد که به هم اتصال ایجاد می

 باز = خاموش  |بسته = روشن  •

 .چراغ خاموش است  →وقتی کلید باز است  •

 !چراغ روشن است →وقتی کلید بسته است   •

ای بسازید  و دقیقاً همین کار را در  توانید مدارهای جالب و خلاقانهبا همین اطلاعات، می. بسیار ساده، اما خیلی کاربردی

 مرحله بعدی انجام خواهیم داد! 

 

 7تصویر
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 : هشدار دزدی )آلارم( ۲پروژه شماره 

نیاز دارد. همچنین دیدیم که یک کلید   بسته  مدار  به یک  انجام هر کار جالبی،  برای  برق  یاد گرفتیم که  این فصل  در 

اما در این پروژه، کلید ما یک درِ  !حالا وقت آن است که یک مدار با کلید بسازیم  .کندچگونه مدار را باز و بسته می

ما قرار است در را تبدیل کنیم به یک کلید عظیم که وقتی کسی سعی کند وارد اتاق کند، یک هشدار    !خانه خواهد بود

 .صوتی به صدا درآید

افتاده را از بالای در آویزان میچگونه آلارم دزدی ما کار می بیرون  فُویل آلومینیومی    .کنیمکند؟ یک سیم  یک تکه 

 .کنیمهر کدام از این قطعات را به یک طرف مدار وصل می .چسبانیمروی بالای در می

 .افتدمدار باز است و هیچ اتفاقی نمی →سیم و فویل با هم تماس ندارند  →وقتی در بسته است  

شود و  مدار بسته می  →کند  رسد و با آن تماس پیدا میسیم آویزان به فویل آلومینیومی می  →شود  ولی وقتی در باز می

 !کندشروع به زنگ زدن می

 سیم بدون پوشش - سر باتری -  ورقه فویل  - لنت برق -بازر   -ولتی  ۹وسایل مورد نیاز :  باتری 

 قیچی   –ابزار مورد نیاز : سیم چین     

                         

 8تصویر

 دهد؟: آیا بازر صدا می1گام 

 .کنداول از همه، باید مطمئن شویم بازر )بلندگوی کوچک صوتی( به خوبی کار می

 

 ۹تصویر 

 :مراحل تست

 .سیم قرمز بازررا بردارید و آن را به قطب مثبت باتری )جایی که علامت + روی باتری است( بچسبانید •

 .است( لمس کنید –سیم مشکی بازر را با دست یا با یک پایه فلزی به قطب منفی باتری )جایی که علامت   •

 اگر همه چیز درست باشد، بازر باید صدای بوق بلندی تولید کند!
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 : آماده کردن فویل آلومینیومی۲گام 

با استفاده از یک قیچی ، یک نوار صاف و .ابتدا یک تکه فویل آلومینیومی بزرگ و درخشان را از روی رول جدا کنید

طول نوار باید به اندازه عرض رول فویل باشد یعنی تقریباً همان    . متر  سانتی  ۲٫5مستقیم از فویل ببرید به عرض حدود  

 .آوریدای که از رول بیرون میاندازه

در کلید   " اتصال الکتریکی"فویل را خوب صاف کنید و مراقب باشید پاره نشود. این نوار بعداً نقش یک  نکته:   

حالا که فویل را آماده کردید، وقت آن است که آن را روی در نصب کنید. در گام .کند دزدگیر شما را بازی می 

 رویم!بعدی به سراغ این کار می 

 : روکش کردن درب با فویل۳مرحله 

نوار فویل آلومینیومی را روی بالای درب قرار دهید و از هر دو طرف نوار آن را با چسب محکم کنید. فویل به عنوان  

 یک تماس الکتریکی برای سیم باتری و زنگ اخطار عمل خواهد کرد.

 

۱0تصویر  

 : آماده کردن سیم فعال گر۴مرحله 

طول  به  پلاستیکی(  پوشش  )بدون  باز  نرم  سیم  تکه  یک 

)تقریباً    ۱0حدوداً   باز، سانتی   ۲5اینچ  سیم  کنید.  تهیه  متر( 

وجود  آن  حول  پلاستیکی  پوشش  هیچ  که  است  سیمی 

عایق  سیم  برخلاف  درون ندارد،  آن  فلز  که  شده  بندی 

می  دارد.  قرار  قدیمی پلاستیک  فولادی  سیم  از یک  توانید 

مثل سیم گیتار یا هر سیم باز دیگر استفاده کنید، یا اینکه از 

سیم  این قیچی  موجودببرید.  سیم  از  تکه  یک  خودتان  بری 

 سیم، سیم فعال گر  شما خواهد بود.
 

 ۱۱تصویر
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 گرفعال م: اتصال زنگ اخطار و سی۵مرحله 

یک سر سیم  فعال گر باز را با سر فلزی برهنـه سیم سیاه کِلیپ باتری توسط چسب متصل کنید. اتصال دو سیم به هم کار  

ها را به هم  خواهید به هم وصل کنید بردارید و سر آن ای است. به این ترتیب آن را انجام دهید: دو سیمی که میساده

 ها را با چسب به خوبی دور بزنید.رسند! سپس آنبپیچید. مطمئن شوید دو قطعه فلز به هم می

 

 ۱۲تصویر

 گر: نصب زنگ اخطار و سیم فعال۶مرحله 

فعال  قرار می اکنون سیم  بالای درب  دهیم.  گر و زنگ اخطار را 

گر را با چسب روی بالای قاب درب بچسبانید، به  ابتدا سیم فعال 

فعال  سیم  است،  بسته  درب  وقتی  که  درب  طوری  جلوی  گر 

نوار   روی  و  درب  روی  است،  باز  درب  وقتی  و  شود  آویزان 

گیرد  قرار  به    .آلومینیومی  درب  قاب  به  را  اخطار  زنگ  سپس 

آلومینیومی  گونه  فویل  با  بتواند  آن  سیاه  سیم  که  بچسبانید  ای 

روی درب تماس پیدا کند. سیم سیاه را با چسب روی فویل قرار  

دهید به طوری که قسمت باز )بدون پوشش( سیم با فویل تماس  

 .داشته باشد 

 
 

 ۱3تصویر
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 : اضافه کردن منبع تغذیه۷مرحله 

باتری را روی قاب درب و نزدیک به کلیپ باتری قرار دهید. اگر لازم بود، از چسب برای ثابت نگه داشتن آن استفاده  

 شود.هنگامی که باتری متصل شد، آلارم شما به این شکل کامل می  .کنید. سپس کلیپ باتری را به باتری متصل کنید

 !: ایجاد هشدار مهاجم۸مرحله 

باز  وقتی درب  کنید.  امتحان  بستن درب  و  باز  با  را  آلارم 

زنگ می  و  پیدا کند  تماس  فویل  با  باید  برهنـه  شود، سیم 

آزمایش  انجام  برای  بیفتد.  کار  به  بلند  صدای  با  اخطار 

 تر، کسی دیگر را دعوت کنید تا درب را باز کند!واقعی 

 
 ۱4تصویر       

 

 : اگر آلارم کار نکرد چه باید کرد؟۹مرحله 

فعال  سیم  موقعیت  مقداری  باشد  است لازم  ممکن  نیامد،  در  به صدا  اخطار  زنگ  مطمئن  اگر  تا  کنید  تنظیم  را  گر 

گر به خوبی با فویل تماس داشته باشد،  شوید هنگام باز شدن درب، سیم با نوار فویل تماس پیدا کند. اگر سیم فعال 

باشد دوباره سیم  نکرد، شاید لازم  باز هم کار  اگر  امتحان کنید.  را  دیگری  با چسب  باتری  را  باتری  به  های متصل 

 تر کنید. محکم 
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 درآوردن اشیا با استفاده از برق و آهنربا  حرکت به   -۳ درس

فلزی کوچک را جذب می بزرگ اجسام  بزرگ میآهنربای  فلزی  به اجسام  برای کنند؛ آهنربای کوچک هم  چسبند. 

توانید با استفاده از آهنربای تزئینی  اند، بنابراین راحت میهای بزرگ فلز ساخته شدهمثال، درهای یخچال معمولاً از تکه

اید: ها هم دیدهها نگه دارید. شما قطعاً آهنربا را در کارتونها را روی آنها یا عکس کوچک، چیزهایی مثل یادداشت

های کارتونی دوست دارند از آهنربای بزرگ به شکل نعل اسبی برای ایجاد شرارت استفاده کنند. آهنربا را  شخصیت

آنمی خودتان  یا  کنید  پیدا  طبیعت  در  برق،  توانید  با  شده  ساخته  آهنربای  یک  بسازید.  برق  از  استفاده  با  را  ها 

 .الکترومغناطیس نام دارد

استفاده کنید، و حتی لازم نیست یک قهرمان فوق می  الکترومغناطیس برای به حرکت درآوردن اشیا  العاده توانید از یک 

مثل موتورها، بلندگوها و درهای خودکار   -بینید  باشید تا این کار را انجام دهید! در واقع، بسیاری از وسایلی که هر روز می 

 .آورند کنند و چیزی در داخلشان را به حرکت درمی ها کار می به خاطر وجود الکترومغناطیس   —ها فروشگاه 

توانید آن را با یک سازید که می شما یک الکترومغناطیس می  درس ساخت یک الکترومغناطیس بسیار ساده است، و در این  

 .کلید روشن و خاموش کنید. سپس از این الکترومغناطیس برای ساخت یک موتور شخصی خودتان استفاده خواهید کرد

 کنند چگونه آهنربا کار می 

 اند.(، و این دو قطب توسط یک میدان مغناطیسی احاطه شدهS( و قطب جنوب )Nآهنربا دو قطب دارند: قطب شمال )

 

 ۱5تصویر 

کند و قطب شمال آن اگر دو آهنربا را کنار هم قرار دهید، قطب شمال یک آهنربا قطب جنوب آهنربای دیگر را جذب می 

های ها را با زور به هم نفشارید، باید به طور طبیعی از قطب کند. سعی کنید دو آهنربا را به هم فشار دهید. اگر آن را دفع می 

تر است، درست است؟ مخالف به هم بچسبند. حالا سعی کنید دو قطب یکسان را به سمت هم هل دهید. این کار سخت 

 . کنند های یکسان یکدیگر را دفع می کنند و قطب های مخالف یکدیگر را جذب می قطب 
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 ۱6تصویر

ها دارای بسیاری ها دارای فقط دو قطب مشخص نیستند. بلکه آن پذیر یخچال آهنرباهای نازک و انعطاف   :نکته  

 تر است.ها کمی سخت های مخالف در کنار هم هستند، به همین دلیل احساس کردن جذب و دفع بین آن قطب 

گیرد. سعی کنید چند شیء کنند. به عنوان مثال، پلاستیک تحت تأثیر آهنربا قرار نمی اما آهنرباها تمام مواد را جذب نمی 
 !فلزی اطراف خود را امتحان کنید

 تمرین در خانه: 

 :هر آهنربایی را بگیرید و آن را روی اشیاء ساخته شده از مواد مختلف قرار دهید، مانند   !چند شیء مغناطیسی پیدا کنید 

 فویل آلومینیومی  •

 قاشق استیل ضدزنگ •

 کنسرو نوشابه  •

 میخ آهنی  •

 یک جواهرات فلزی  •

 چند سکه مختلف  •

به کدام اشیا جذب می  یا می آهنربا  اما تمام چسبد؟ متوجه خواهید شد که آهنربا بعضی از فلزات را جذب می شود  کند، 

 افتد؟با فویل آلومینیوم چه اتفاقی می   .کند فلزات را جذب نمی 

 الکترومغناطیس 

افتد: جریان الکتریکی یک میدان مغناطیسی اطراف کند، چیز عجیبی اتفاق می وقتی جریان الکتریکی از یک سیم عبور می 

 کند.سیم ایجاد می 

 

 ۱7تصویر
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قوی  مغناطیسی  میدان  یک  ایجاد  برای  است.  بسیار ضعیف  تنهایی  به  سیم  مغناطیسی یک  بین میدان  از  را  باید جریان  تر، 

توانید تنها اند عبور دهید. اما در واقع نیازی به استفاده از چندین سیم نیست؛ می ها که کنار هم قرار داده شده بسیاری از سیم 

های متعدد پیچانده و سپس جریان الکتریکی با یک سیم هم همین کار را انجام دهید: کافی است آن سیم را به شکل حلقه 

شوند و گیرند و ترکیب می ها روی هم قرار می های مغناطیسی ایجاد شده از هر یک از این حلقه را از آن عبور دهید. میدان 

 .کنند تر ایجاد می در نتیجه یک میدان مغناطیسی قوی 

 .تر خواهد شد بپیچید، میدان مغناطیسی حتی قوی   -مثل یک میخ، پیچ یا مهره    -اگر سیم پیچانده شده را دور یک قطعه آهنی  

برای ساخت یک الکترومغناطیس فقط کافی است دو سر سیم پیچانده شده را به یک باتری وصل کنید تا یک مدار بسته 

از سیم عبور می  الکتریکی  به رفتار تشکیل شود. وقتی جریان  پیچیده شده است شروع  فلزی که سیم دور آن  کند، قطعه 

( خواهد بود. این که کدام سر N(و سر دیگر آن قطب شمال) Sکند: یک سر آن قطب جنوب ) کردن مانند یک آهنربا می 

دارد  بستگی  پیچش سیم  الکتریکی و همچنین جهت  به جهت جریان  است،  باتری را قطع کنید، جریان  .چه قطبی  وقتی 

 .رودمتوقف شده و میدان مغناطیسی از بین می 

کند تا درک بهتری از نحوه استفاده از برق برای ساخت وسایلی مانند بلندگو ساخت یک الکترومغناطیس به شما کمک می 

توانید حتی در دنیای واقعی پیدا کنید. پس بیایید یکی بسازیم! با استفاده از جریان کافی، سیم مناسب و مدار صحیح، می 

تان بیرون آمده باشد، اما برای شروع، با یک الکترومغناطیس های مورد علاقه بسازید که مستقیماً از کارتون  "ابرآهنربا " یک 

 کوچک شروع خواهیم کرد.

 

 

 ۱8تصویر
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 !: الکترومغناطیس خودتان را بسازید۳پروژه شماره 

اید.  شما اکنون با نظریه ساخت الکترومغناطیس آشنا شده 

اما فقط خواندن درباره نحوه ساخت چیزی، مثل ساخت  

واقعی آن نیست. حالا وقت آن است که کمی هم تجربه  

ببرید  لذت  و  کنید  پیدا  پروژه،   !عملی  این  در 

الکترومغناطیس شخصی خودتان را با استفاده از یک سیم  

و یک پیچ  بسازید . تمام کاری که باید انجام دهید این  

است که سیم را چندین دور حول پیچ بپیچید و سپس دو  

تر  برای اینکه راحت .سر سیم را به یک باتری وصل کنید 

بتوانید الکترومغناطیس را روشن و خاموش کنید، در این  

این   کرد.  خواهید  اضافه  هم  )سوئیچ(  کلید  یک  مدار 

می  اجازه  شما  به  جر کلید  کنترل  دهد  را  الکتریکی  یان 

 . کنید و تصمیم بگیرید که آیا باید از سیم عبور کند یا نه 

 !بیایید شروع کنیم 

     

 
 

 ۱۹تصویر

 

 

 لنت الکتریکی  –کلید  -سیم    –باتری    -واشر  –وسایل مورد نیاز : پیچ  

 ابزار مورد نیاز : سیم چین و آهنربا تخت 

 : پیچ خود را بررسی کنید1گام 

اما همه مواد مناسب برای استفاده به پیچ شما هسته الکترومغناطیس شما خواهد شد و باعث افزایش قدرت آن می  گردد. 

پیچ  اکثر  نیستند!  الکترومغناطیس  هسته  ماده عنوان  جنس  از  پیچی  و  کردید  شانسی  بد  اگر  اما  هستند،  مناسب  فلزی  های 

الکترومغناطیس شما کارایی لازم را نخواهد داشت  برای    .غیرمغناطیسی )مانند برخی انواع استیل ضدزنگ( پیدا کردید، 

اینکه بفهمید پیچ شما برای این پروژه مناسب است یا نه، آن را نزدیک یک آهنربای معمولی نگه دارید. اگر آهنربا پیچ را 

 توانید از آن استفاده کنید. جذب کرد، یعنی پیچ مناسب است و می 
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 بندی یک سر سیم پیچ را بردارید: عایق۲گام 

برای اینکه بتوانید سیم پیچ را به باتری و کلید )سوئیچ( وصل کنید، باید فلز 

 (wire cutter) بر سیم در هر دو انتهای آن باز باشد. شما از یک قالیچه سیم 

می  )حدود  استفاده  اینچ  نیم  حدوداً  تا  عایق سانتی   ۱٫3کنید  روکش  از  متر( 

سیم را در ابتداى سیم جدا کنید. بعد از اینکه سیم را دور پیچ پیچیدید، همین 

ابتدا به آرامی انتهای سیم را   .کار را با انتهای دیگر سیم نیز انجام خواهید داد 

های قالیچه داخل لایه عایق بر گرفته و آنقدر فشار دهید تا دندانه با قالیچه سیم 

به آرامی  را  نبرید. سپس سیم  را  فلزی داخل  فرو روند، دقت کنید که سیم 

ید تا عایق دور سیم برش بخورد و بتوانید آن را جدا کنید. فشار دقیق بچرخان 

و کافی را به  روی سیم اعمال کنید تا فقط لایه پلاستیکی )عایق( دور سیم 

برش بخورد، ولی خود سیم فلزی زیرین نیفتد . وقتی عایق برش خورد، سیم 

 شما باید شبیه به این تصویر باشد:

 

 
 ۲0تصویر 

سیم  کرده سپس،  ایجاد  عایق  روی  که  شیاری  در  را  آنقدر  بر  دهید.  قرار  اید 

های آن قسمت عایق برش خورده را بگیرند. اکنون  قالیچه را فشار دهید که تیغه 

با دقت و آرامی از سیم بکشید تا لایه پلاستیکی )عایق( از روی فلز سیم جدا  

 شود، دقت کنید که قالیچه را نیفتد یا فشار زیادی به خود سیم فلزی وارد نکند . 

باشد که در یک سر آن مقداری از فلز   به این شکل  باید  اکنون، سیم شما 

 سیم باز و دیده شود، مثل این:

  
 ۲۱تصویر

 : پیچیدن سیم دور پیچ ۳گام 

بار به دور پیچ فلزی خود بپیچید. دقت کنید از   ۱00تا    50سیم را بگیرید و آن را  

های آزاد  متر سیم آزاد باقی بماند. این قسمت سانتی   7٫5هر دو طرف سیم حدود  

مراقب باشید تمام سیم را استفاده نکنید ؛ در    .شوند بعداً به باتری و کلید متصل می 

متر نیاز خواهید داشت،  سانتی   ۱0های بعدی به یک تکه سیم به طول حدود  گام 

 پس کمی از سیم را کنار بگذارید. 

 
 ۲۲تصویر 
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ها کاملًا کنار هم قرار بگیرند و فاصله نداشته باشند. سپس سیم را چنانچه ممکن است به محکمی دور پیچ بپیچید تا حلقه 

ها به هم نخورند. ما به این چسب یا نوار چسب( ثابت کنید تا سیم از جای خود بلغزد و حلقه انتهای سیم را با چسب )نوک 

را تکرار کنید تا عایق دیگر انتهای سیم پیچ نیز جدا  ۲گام   .گوییم می « پیچ الکترومغناطیس پیچه« یا »سیم » سیم پیچانده شده، 

 .شوند شود و فلز داخلی آن آشکار گردد. در این صورت هر دو انتهای سیم آماده اتصال به مدار می 

 پیچ : اتصال ترمینال منفی باتری به سیم ۴گام 

( وصل کنید. آن را با " −"کند کدام یک( به ترمینال منفی باتری )معمولًا با علامت  پیچ را )فرقی نمی یکی از سرهای سیم 

 چسب یا نوار چسب( محکم روی باتری ثابت کنید تا تماس الکتریکی خوبی برقرار شود.چسب )نوک 

 : وصل کردن کلید )سوئیچ( ۵گام 

ساخته( را به الکترومغناطیس خود متصل کنید تا بتوانید آن را روشن و خاموش حالا، شما قرار است یک کلید آماده )پیش 

ها وصل کرد. برای استفاده از کلید در این ها را به آن توان سیم یک کلید معمولًا دارای سه پین )اتصال( است که می .کنید 

 :مدار، به این ترتیب عمل کنید 

 

باقی .  ۱ آزاد  سیم سر  از  پین مانده  از  یکی  به  را  کلید پیچ  های 

 .وصل کنید 

اید، بگیرید کنار گذاشته   3یک تکه کوتاه سیم را که در گام . ۲

 .و یک سر آن را به پین دوم کلید وصل کنید 

پین سوم ممکن است استفاده نشود، مگر اینکه کلید شما از .  3

 .باشد  (SPDT) نوع دو حالته 

 

 

 

 ۲3تصویر 

تواند جریان را قطع و وصل کند. در گام بعدی، سر دیگر سیم کوتاه  در این مرحله، کلید شما بخشی از مدار است و می

 .را به ترمینال مثبت باتری وصل خواهید کرد تا مدار کامل شود

کند. این پین  عمل می (common) به عنوان پین مشترک  ۲در کلیدی که در وسایل خرید این پروژه آمده است، پین  

 :شودمتصل می( 3یا  ۱بسته به وضعیت دکمه کلید، به یکی از دو پین دیگر )پین 

 .شوند به هم متصل می ۱و  ۲های فشار داده شود ، پین  ۱اگر دکمه کلید به سمت پین  •

 .شوند به هم متصل می 3و  ۲های فشار داده شود ، پین  3اگر دکمه کلید به سمت پین  •
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 :ها به کلیدمراحل اتصال سیم 

 .کلید متصل کنید ۱اید( را بگیرید و آن را به پین پیچ )همان سری که تا حالا به باتری نچسباندهسر دوم سیم سیم

شود مدار در حالت عادی )وقتی دکمه فشرده نیست( باز  فشار دهید . این کار باعث می 3دکمه کلید را به سمت پین 

 .باشد و الکترومغناطیس روشن نباشد

سیم  از  کاملًا جدید  به طول )حدود  یک سیم  ببرید    ۱0پیچ خود 

 .. متر( سانتی 

 .از هر دو انتهای این سیم عایق بردارید تا فلز داخلی آن باز شود 

باتری )علامت   مثبت  ترمینال  به  این سیم جدید را  (  " ₊" یک سر 

 . وصل کنید و با چسب محکم کنید 

 .( کلید وصل کنید ۲سر دیگر آن را به پین میانی )پین 

 
 

 ۲4تصویر

 جا نشوند. ها را ثابت نگه دارید تا جابهچسب یا نوار چسب سیماز تمام اتصالات مطمئن شوید و با نوک

 : تست کردن ابرالکترومغناطیس شما۶گام 

اگر همه چیز را درست وصل کرده    .حالا وقت آن است که ببینیم چقدر قوی است !مدار شما ساخته شد !تبریک

 .ایدفشار داده 3باشید، الکترومغناطیس شما در حال حاضر خاموش است چون کلید را به سمت پین 

 :مراحل تست الکترومغناطیس

 .یک جسم فلزی مناسب پیدا کنید تا توسط الکترومغناطیس جذب شود .1

 .یک دبوی فلزی کوچک یا چند عدد واشر فولادی انتخاب خوبی است •

فولاد   • یا  مثل آهن  باشد  مغناطیسی  انتخابی  باشید که جسم  یا   .مراقب  آلومینیومی  فویل  مثل  موادی 

 .شوند برخی انواع استیل ضدزنگ جذب نمی

قبل از روشن کردن الکترومغناطیس، یک آهنربای معمولی را به جسم فلزی نزدیک کنید تا مطمئن شوید که   .2

 .توانید ادامه دهیدشود. اگر آهنربا آن را جذب کرد، مشکلی نیست و میجذب می

تا مدار بسته شود و جریان از سیم عبور کند. در این لحظه، پیچ )هسته فلزی  ( ۱کلید را فشار دهید )به سمت پین  .3

 .شود شما( به یک آهنربای الکتریکی تبدیل می

 .الکترومغناطیس را به جسم فلزی نزدیک کنید مثل یک دبوی کاغذی یا واشر فلزی .4

اگر همه چیز درست کار کند، جسم فلزی باید به سمت پیچ کشیده شود و حتی ممکن است به آن   •

 !بچسبد
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 ۲5تصویر

برق مصرف می توجهی  قابل  مقدار  باتری الکترومغناطیس  دارید،  نگه  زیادی روشن  مدت  برای  را  اگر کلید  کند. 

شوند این موضوع کاملًا  پیچ گرم میشود . همچنین ممکن است متوجه شوید که باتری و سیمخیلی سریع خالی می

 طبیعی است، اما باید مراقب باشید. 

 : اگر الکترومغناطیس کار نکرد چه باید کرد؟۷گام 

پیچ استفاده کردهمطمئن شوید که از سیم عایق پیچیدن دور  باید دارای یک لایه عایق )معمولاً  دار برای  اید. سیم 

نخواهد  به درستی کار  الکترومغناطیس  این صورت،  باشد؛ در غیر  فلز خود  یا لاک( روی  یک پوشش پلاستیکی 

رود و به جای آن مسیرهای  دلیل این موضوع این است که بدون لایه عایق، جریان الکتریکی از روی سیم نمی.کرد

 . کنددیگری را انتخاب می

 :مثلًا

 .روداگر پیچ فلزی شما هادی برق باشد، جریان از داخل پیچ می •

 .شودهای سیم به هم لمس کنند، جریان از یک حلقه به حلقه دیگر منتقل مییا اگر حلقه •

می • عبور  فرضی  ضخیم  سیم  یک  از  فقط  جریان  حالت،  دو  هر  ایجاد  در  قوی  مغناطیسی  میدان  و  کند 

 . شودنمی
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 آشنایی با موتور  -۴ درس

به برق    3پیچ پروژه شماره  کند. وقتی سیمکند، یک میدان مغناطیسی ایجاد میسیمی که جریان الکتریکی از آن عبور می

قطب با  مغناطیسی  میدان  یک  دارای  باشد،  دیگری.  متصل  آهنربای  هر  مانند  دقیقاً  بود،  خواهد  شمال  و  جنوب  های 

بنابراین، اگر سیمهای مخالف یکدیگر را جذب میکنند و قطبهای مشابه یکدیگر را دفع میقطب به  کنند.  پیچی که 

و قطب دهید  قرار  معمولی  آهنربای  را روی یک  است  تبدیل شده  آهنربا  یکسان آنیک  باشند،  های  به هم  نزدیک  ها 

 پیچ سعی خواهد کرد که خودش را بچرخاند. سیم

 

 ۲6تصویر

بتواند آزادانه روی آهنربا بچرخد، سیم اگر سیم  به طوری که  قرار دهید  پایه  اینکه یک دور پیچ را روی نوعی  پیچ بدون 

های مخالف پیچ نیم دور بچرخد، قطب کامل بزند، به جلو و عقب تکان خواهد خورد. دلیل این امر آن است که وقتی سیم 

چگونه   .پیچ در جهت عکس حرکت کند شود سیم کنند و این باعث می گیرند و یکدیگر را جذب می رو به هم قرار می 

 پیچ را مدام در یک جهت بچرخانید؟ توانید سیم می 

پیچ به نقطه شروع کافی است راهی پیدا کنید که باتری را درست در وسط چرخش قطع کنید و دوباره آن را وقتی سیم 

پیچ کند و سیم پیچ زمانی که برق دارد شروع به حرکت می سیم   :دهد برگشت، وصل کنید. در این صورت این اتفاق رخ می 

پیچ را به حرکت شود، اما حرکت اولیه )اینرسی( سیم دهد. چون در وسط چرخش باتری قطع می را نیم دور به جلو هل می 

پیچ را دوباره به جلو شود و سیم پیچ دوباره به محل اولیه خود بازگشت، باتری دوباره وصل می دهد. وقتی سیم خود ادامه می 

موتورهای الکتریکی دقیقاً بر اساس همین اصل اولیه جذب و   .کند دهد و این چرخه به همین ترتیب ادامه پیدا می هل می 

 کنند.های مغناطیسی کار می دفع قطب 
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 : ساخت یک موتور ۴پروژه شماره 

 !در این پروژه، شما یک موتور الکتریکی ساده از ابتدا بسازید

 چه چیزهایی نیاز دارید؟

 پیچ )همانند الکترومغناطیسی که قبلًا ساختید(یک سیم

 یک آهنربای قوی )مثل یک آهنربای دیسکی یا نواری(

 
 ۲7تصویر 

 :نحوه کار موتور         

شما موتور    .شودیا قسمت چرخان موتور گفته می (rotor) به همین دلیل به آن روتور   -پیچ شما خواهد چرخید  سیم

به گونه را  از سیمای میخود  دوران  از  نیمی  در  فقط  الکتریکی  این حین سازید که جریان  در   . عبور کند  آهنربا    :پیچ 

در نیم دور دوم، جریان قطع است ، اما   .دهد )به دلیل خاصیت جذب و دفع مغناطیسی(پیچ را در نیم دور اول هل میسیم

شود  این چرخه تکرار می  .شود روتور به چرخش خود ادامه دهدانرژی اولیه )اینرسی( حاصل از هل دادن اولیه باعث می

گیرید و با با این پروژه، شما در واقع اساس کار یک موتور الکتریکی واقعی را یاد می.چرخدو روتور به طور پیوسته می

 اید مراحل ساخت موتور را شروع کنید؟ آیا آماده .اندازیددستان خود آن را به کار می

 آهنربا و سیم چین   -سیم   -باتری  -لیوان یک بار مصرف  -: لنت الکتریکی   وسایل مورد نیاز

 

 ۲8تصویر
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 : ساخت روتور )قسمت چرخان موتور(1گام 

 .پیچ به عنوان روتور یا همان قسمت چرخان موتور شما عمل خواهد کرد سازیم؛ این سیم پیچ جدید می اول از همه، یک سیم 

 :مراحل ساخت

 :سیم پیچیده شده از روی باتری بپیچید

برداری کنید یعنی  متر( از انتهای آزاد سیم را عایقسانتی  4ابتدا )حدود  .سیم خود را از دوره )بالشته سیم( بیرون بکشید

   .لایه پلاستیکی روی سیم را بردارید تا فلز داخلی باز شود

دقت  .  بار به دور آن بپیچید  ۲0تا    ۱5باتری را به عنوان یک قالب استفاده کنید و سیم را حدود  : سیم را دور باتری بپیچید

بعد از پیچیدن، سیم را از دور باتری درآورده و دو سر سیم را به هم بپیچید تا شکل   .ها صاف و کنار هم باشندکنید حلقه

 .یک حلقه محکم به خود بگیرد

 

 ۲۹تصویر

دلیل این کار    . کنید، تعداد دورها را بیشتر کنیدتر استفاده میدور سیم بپیچید. اگر از سیمی نازک  30سعی کنید حدود  

شود ، اما در عین حال باید مراقب باشید  تر مغناطیسی میپیچ قویاین است که هرچه دورهای بیشتری داشته باشید، سیم

 .پیچ خیلی سنگین نشود و بتواند به راحتی بچرخدکه سیم

 

 30تصویر
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 : ساخت قاب موتور۲گام 

 .تان بیرون بیاوریدپیچ )روتور( خود را کنار بگذارید و یک لیوان کاغذی را از جعبه وسایلسیم

 :مراحل ساخت

 :در یک طرف لیوان، دو سوراخ ایجاد کنید 

پایین سانتی   ۱)حدود   لیوان متر(  بالایی  لبه  از  دیگری   .تر 

یک تکه سیم سفت و  .متر( بالاتر از ته لیوان سانتی  ۱)حدود 

)حدود   حدود  طول  به  دو سانتی   ۲0محکم  این  از  متر( 

کنید  رد  هم   .سوراخ  لیوان  دیگر  طرف  در  را  کار  همین 

نتیجه، دو عدد سیم عمودی در دو طرف   -انجام دهید   در 

لیوان را برعکس کنید )روی دهانه .  گیرند لیوان شما قرار می 

از دو انتهای هر دو سیم عمودی عایق بردارید  .آن بگذارید( 

چسب با استفاده از چسب )نوک  .ها باز شود تا فلز داخلی آن 

ها را به بدنه لیوان ثابت کنید تا حرکت یا نوار چسب(، سیم 

 .شند نکنند و تماس خوب الکتریکی داشته با
 

 3۱تصویر

 

شوند و سرهای بالایی برای اتصال به روتور و نگه داشتن  هایی که اکنون در پایین قرار دارند به باتری وصل میسر سیم

بتوانند روتور را نگه دارند.    Uها را به شکل حرف  آن استفاده خواهند شد. دو سر بالایی سیم به طوری که  خم کنید، 

برداری شده روتور تماس پیدا کند. این ساختار  های عایقفلز باز دارد تا با سیم  Uمطمئن شوید که قسمت پایین هر حلقه  

 ، اتصال باتری به روتور را فراهم خواهد کرد. Uبه شکل 

 : قرار دادن آهنربا۳گام 

 .یک آهنربا را روی بالای لیوان قرار دهید  .۱

 . یک آهنربای دیگر را درون لیوان بگذارید، به طوری که این دو آهنربا از طریق دیواره لیوان به هم بچسبند  .۲

 .قرار دهید U پیچ( خود را درون ساختار به شکلروتور )سیم  .3

  .پیچ )روتور( قرار دارندها دقیقاً در وسط لیوان و کمی زیر سیمموقعیت آهنرباها را تنظیم کنید تا مطمئن شوید آن   .4

 شود میدان مغناطیسی درست در مرکز و در تماس با روتور ایجاد شود و موتور به خوبی کار کند.این کار باعث می
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 پیچبندی مجدد بخشی از سیم : عایق۴گام 

پیچ روتور، شما حرکتی را مشاهده خواهید  اگر در این لحظه باتری را وصل کنید، موتور کار نخواهد کرد. با اتصال سیم

شود، چون همیشه به باتری متصل است. شما نیاز دارید راهی پیدا کنید تا  کرد، اما روتور فقط به جلو و عقب هل داده می

پیچ را درست در وسط چرخش از باتری قطع کنید، تا ابتدا از آهنربا دور شود و سپس رها شود تا بقیه چرخش را به  سیم

تواند دوباره با آهنربا تماس پیدا کند و دوباره هل داده شود، و به همین ترتیب ادامه  دلیل انرژی اولیه انجام دهد. بعد می

بندی یک طرف سیم با استفاده از یک ماژیک فراهم کنید. این کار را  توانید این اتفاق که بیفتد را با عایقیابد. شما می

 فقط روی یک طرف روتور انجام دهید. 

 

 

 3۲تصویر

پیچ خود را صاف روی میز بگذارید و از یک ماژیک رنگ ثابت استفاده کنید تا در امتداد سیم در یک طرف خطی  سیم

کنید )عایق(  غیرهادی  را  از سیم  قسمت  آن  و  به گونه.بکشید  را  و خط خود  افقی  در حالت  وقتی حلقه  بکشید که  ای 

 پیچ از باتری قطع شود و جریان الکتریکی متوقف گردد.بالای آهنربا قرار دارد ، سیم

 

 33تصویر
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 اندازی موتور: راه ۵گام 

چسب به ترمینال مثبت و منفی  ها را با نوار چسب یا نوکاندازی موتور! باتری را وصل کنید دو سر سیموقتی برسیم به راه

کند. حالا روتور  ها عبور کرده و موتور شما شروع به کار میبا اتصال باتری، جریان الکتریکی از سیم  .باتری متصل کنید

قرار دهید . موتور باید شروع به چرخش کند. ممکن است نیاز باشد آن را کمی با دست هل   U را درون ساختار به شکل 

تواند ماشینی را حرکت دهد، اما اگر کار کرد، یعنی شما واقعاً چیزی را فقط با  البته این موتور نمی  .دهید تا کار بیفتد

 تبریک! شما یک موتور ساده الکتریکی ساختید!  . استفاده از برق به حرکت درآوردید

 

 

 

 

 

 34تصویر

 : اگر موتور کار نکرد، چه باید کرد؟۶گام 

کند، اما احتمالاً نیاز است چند  کنید؟ اگر خوش شانس باشید، موتور از اول کار میآیا هرگونه حرکتی را مشاهده می

 :تنظیم انجام دهید. در اینجا چند نقطه برای شروع وجود دارد

یعنی قسمت فلز باز آن )نه قسمتی که با ماژیک عایق    -پیچ )روتور( به درستی قرار گرفته است  مطمئن شوید سیم -۱

 .شودپیچ مغناطیسی میتماس پیدا کند. به این ترتیب، وقتی باتری وصل شود، سیم U های باز ساختارکردید( با سیم

اتصال باتری را عوض کنید. ممکن است روتور در یک جهت بهتر بچرخد. سعی کنید باتری را برعکس وصل کنید  -۲

 .کندو ببینید کدام حالت برای موتور شما بهتر عمل می

اگر روتور خیلی سنگین است، مغناطیس کافی نخواهد داشت تا آن را تمام دور بچرخاند. چند دور اضافی از سیم را   -3

 .تر شودباز کنید تا روتور سبک

 .ها را دقیقاً در مرکز زیر روتور قرار دهیدموقعیت آهنربا را تنظیم کنید. سعی کنید آن -4

کمی   خود  انگشت  با  را  روتور  باشد.  داشته  آغازین  هل  یک  به  نیاز  فقط  است  ممکن  نکرد،  کار  همچنان  موتور  اگر 

 .شود شروع به چرخش کندحرکت دهید و ببینید آیا این کار باعث می
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 چگونه برق تولید کنیم؟  -۵ درس

کند و همچنین باتری ساده خودتان را بسازید و دستگاهی  ما در این بخش دستگاهی که از نیروی حرکتی برق تولید می

 .های تولید برق هستندترین روشکند. این دو روش،  رایجهای شیمیایی تولید میکه برق را از طریق واکنش 

 تولید برق با آهنربا 

شود، اما ارتباط دیگری هم  کند، یک میدان مغناطیسی اطراف سیم ایجاد میوقتی جریان الکتریکی از یک سیم عبور می

 :بین برق و مغناطیس وجود دارد

 !توانید با استفاده از یک سیم و یک آهنربا، الکتریسیته هم تولید کنیدشما می

 تولید برق با یک میدان مغناطیسی متغیر 

اگر یک آهنربا را روی یک سیم که در یک مدار بسته قرار دارد به جلو و عقب حرکت دهید، جریان الکتریکی در سیم  

می سیم  اطراف  مغناطیسی  میدان  تغییر  باعث  آهنربا  حرکت  شد.  خواهد  متغیر،  ایجاد  مغناطیسی  میدان  این  و  شود، 

به حرکت درمیالکترون را در سیم  متوقف میها  نیز  الکتریکی  متوقف کنید، جریان  اگر حرکت آهنربا را  شود  آورد. 

اگر دو سر    .حتی اگر سیم همچنان در میدان مغناطیسی قرار داشته باشد چون میدان مغناطیسی دیگر در حال تغییر نیست

تواند جاری شود. با این حال، جریانی که  سیم را به یک لامپ برقی وصل کنید و یک مدار بسته ایجاد کنید، جریان می

کند تا  شود، به اندازه کافی انرژی را به سرعت کافی فراهم نمیبا حرکت دادن یک آهنربا روی یک سیم ساده ایجاد می

برای روشن کردن یک لامپ یا به کار انداختن هر وسیله دیگری، باید راهی پیدا کنید تا قدرت    .لامپ را روشن کند

          بیشتری تولید کنید منظور از قدرت، مقدار انرژی تولید شده در واحد زمان است.

                   

 35تصویر            
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 کند؟ژنراتور چگونه کار می 

برای تولید  .کند ای است که حرکت مانند حرکت یک آهنربا روی یک سیم را به الکتریسیته تبدیل می ژنراتور وسیله 

سیم پیچانده شده  . توانید سیم را به شکل حلقه )پیچ( درآورید قدرت بیشتر با استفاده از یک سیم و یک آهنربا، می 

کند، جریان الکتریکی از هر حلقه  کند و وقتی میدان مغناطیسی از داخل آن عبور می ها عمل می مانند گروهی از سیم 

 شود.کند و در نتیجه قدرت بیشتری نسبت به یک سیم صاف تولید می عبور می 

 تولید برق از آب یا باد 

با دسته اگر یک سیم  قرار دهید و  به  ای سیم پیچ را در یک میدان مغناطیسی  پیچ را بچرخانید، حرکت دست خود را 

حالا اگر جای دسته یک چرخ آبی بگذارید و آن را در مسیر جریان آب قرار دهید، جریان آب . اید برق تبدیل کرده 

نتیجه سیم چرخ را به حرکت درمی  الکتریکی ایجاد می پیچ در میدان مغناطیسی می آورد و در   شود چرخد و جریان 

در یک نیروگاه، آب از میان یک ! کنند ها از آن برای تولید برق استفاده می این همان روشی است که برخی نیروگاه .

می  عبور  می چرخ  باعث  این چرخ  و  است  متصل  ژنراتور  به  که  از  کند  برق  این  کند. سپس  تولید  برق  ژنراتور  شود 

 شود.  های مردم منتقل می طریق خطوط انتقال برق به پریزهای برق خانه 

می  روش  همین  کنید به  تولید  برق  هم  طبیعی  نیروهای  سایر  از  می   .توانید  باد،  از  برق  تولید  برای  مثال،  توانید برای 

وزد، باد چرخ آسیاب را به حرکت درآورد و پیچ را به یک آسیاب بادی وصل کنید، به طوری که وقتی باد می سیم 

 چرخاند.پیچ را می سیم 

 

 36تصویر  
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 آشنایی با مولتی متر 

مولتی شما می  از یک  استفاده  با  بگیرید توانید  اندازه  را  ژنراتور ساده  توسط یک  تولید شده  انرژی  مقدار   .متر ساده، دقیقاً 

توانند بسیاری از مقادیر مختلف را شامل مقاومت، جریان مترها هنگام ساخت هر نوع مداری کاربردی هستند زیرا می مولتی 

 و ولتاژ اندازه بگیرند. 

 

 37تصویر

سیم   سیم  است،  مثبت  سیم  می   قرمز،  را  امکان  این  شما  به  وسطی  بزرگ  دکمه  و  است  منفی  سیم  که چگونه سیاه،  دهد 

گیری ولتاژ در نقاط کلیدی مدار، گیری تنظیم کنید. اگر در مداری مشکلی وجود داشته باشد، اندازه متر را برای اندازه مولتی 

 یک روش عملی برای تشخیص عیب مدار است.

 گیری ولتاژنحوه اندازه 

قرار دهید. در  (V) های ولتاژ متر را روی یکی از گزینه متر، ابتدا دکمه مولتی گیری ولتاژ با استفاده از یک مولتی برای اندازه 

ای را انتخاب کنید که عدد آن از بیشترین ولتاژی که انتظار دارید در مدارتان وجود داشته های شخصی خود، گزینه پروژه 

در   .متصل کنید  V قرمز را به سوکت  و سیم  COM سیاه را به سوکت   متر، سیم باشد، بالاتر باشد. سپس، در پایین مولتی 

 خواهید ولتاژ آن را اندازه بگیرید، بچسبانید )یک سیم در هر طرف(.ای که می را به دو طرف قطعه   نهایت، هر یک از سیم 

 

 38تصویر
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ولتی است. توجه کنید که دکمه    ۹های مثبت و منفی یک باتری  گیری ولتاژ بین ترمینال متر در حال اندازه در این مثال، مولتی 

دیگر هم روی    Vبا یک خط مستقیم نشان داده شده است. اما یک    Vولت قرار دارد، در بخشی که نماد    ۲0متر روی  مولتی 

 دار است. بیایید نگاهی بیندازیم به اینکه این نمادها چه معنی دارند. متر وجود دارد که کنار آن یک خط موج مولتی 

 جریان متناوب و جریان مستقیم چه هستند؟ 

مولتی تنظیم  آیا مینحوه  اینکه  به  دارد  بستگی  بگیرید. یک متر شما  اندازه  را  ژنراتور  یا یک  باتری  ولتاژ یک  خواهید 

به طور   اما یک ژنراتور چنین نیست! ژنراتور دو سیم دارد که  باتری دارای یک طرف مثبت و یک طرف منفی است، 

کند،  شوند. این امر به این دلیل است که وقتی یک طرف آهنربا از کنار یک سیملوله عبور میمتناوب مثبت و منفی می

کند،  کند و وقتی طرف دیگر آهنربا از کنار سیملوله عبور میجریان الکتریکی در سیملوله در یک جهت جریان پیدا می

(  ACوقتی جهت جریان به این صورت تغییر کند، ما آن را جریان متناوب )  .کندجریان در جهت دیگری جریان پیدا می

نامیم. معمولاً شما این نمادها را روی  ( میDCنامیم؛ و وقتی جهت جریان همواره ثابت باشد، آن را جریان مستقیم )می

 کنند: را مشخص می DCو   ACگیری های اندازهمتر خود خواهید دید که محدودهمولتی

 

مولتی باید  اندازهشما  برای  را  جریانمتر  آورید DC یا AC گیری  دست  به  صحیح  عدد  تا  کنید  مثال،    .تنظیم  برای 

 هستند.  DCها دارای ولتاژ باتری

 : ساخت یک ژنراتور دستی ۵پروژه شماره 

  .دهد که چگونه یک ژنراتور بسازید و ولتاژ آن را اندازه بگیریدمتر خود را بردارید ، این پروژه به شما نشان میمولتی

یک روش سریع برای ساخت یک ژنراتور ساده، حرکت دستی یک آهنربا جلو و عقب در داخل یک سیملوله است. در  

دهید و یک سیملوله را دور همان لوله میپیچانید. وقتی لوله را تکان  این پروژه، شما یک آهنربا را درون یک لوله قرار می

 دهید، آهنربا باید در داخل سیملوله جلو و عقب حرکت کند و ولتاژی تولید کند.

 

 3۹تصویر
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 گیره سوسماری -سیم  –آهنربا  –وسایل مورد نیاز : لوله پلاستیکی 

 

 40تصویر

 سازی لوله: آماده1مرحله 

ای را پیدا کنید که به اندازه کافی بزرگ باشد تا آهنربا بتوانند به راحتی درون آن جلو و عقب سُر بخورند. اگر از لوله

 شوند. کنید، خودکار را جدا کنید و مطمئن شوید که آهنربا به خوبی درون لوله جا مییک خودکار استفاده می

 

 4۱تصویر

 پیچیدن سیملوله : ۲مرحله 

ای ببندید تا سیملوله  دور سیم را در وسط لوله پیچانده کنید. پس از پیچاندن، دو سر سیم را با هم گره ساده  50حدود  

 .شما محکم بماند. سپس، عایق دو سر سیم را جدا کنید، مانند تصویر زیر

 

 4۲تصویر
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 متر متصل کردن مولتی: ۳مرحله 

گیری جریان  متر را روی حالت اندازههای سوسماری به دو سر سیملوله متصل کنید و مولتیمتر را با استفاده از گیرهمولتی
 .موجود را انتخاب کنید AC ترین محدوده ولتاژ قرار دهید. پایین  (AC) متناوب

 

 43تصویر
 تکان دادن : ۴مرحله 

 .شوندشوند و از هم باز نمیبعد، آهنرباها را درون لوله قرار دهید. مطمئن شوید که به راحتی درون لوله جا می

 

 44تصویر
متر در دست خود، یک انگشت از هر طرف لوله را بگیرید تا آهنربا از لوله بیرون نیفتند.  های مولتیبا داشتن لوله و سیم

 . سپس، لوله را قوی و پرشور تکان دهید

 
 45تصویر

 0.0۲آورید؟ من توانستم فقط  متر را مشاهده کنید. چه مقدار ولتاژ به دست میمقدار ولتاژ نمایش داده شده روی مولتی
 .ولت از ژنراتور خودم به دست آورم، بنابراین خیلی قدرتمند نیست

 
 46تصویر

 ..حالا دست به کار بشید برای خودتان یک زنراتور بسازید
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 کنند؟ ها چگونه کار می باتری  -۶ درس

من به شما نشان دادم که چگونه  به صورت دستی برق تولید کنید، اما این موضوع توضیح داده نشد  که تا به حال چگونه  

ها  اید و در این بخش، خواهیم دید که چه چیزی به باتریمدارهای شما با باتری روشن میشد. شما از باتری استفاده کرده

 .دهد برق تولید کننداجازه می

 داخل یک باتری چه  چیزی وجود دارد؟ 

 :برای ساخت یک باتری، به سه چیز نیاز دارید

 یک الکترود مثبت  •

 یک الکترود منفی  •

 یک الکترولیت  •

می استفاده  غیرفلزی  ماده  یک  با  ارتباط  برقراری  برای  که  است  فلزی  سیم  یک  باتریالکترود  یک  داخل  مثل   .شود 

 .تواند الکترون آزاد کند یا الکترون دریافت کندای است که میالکترولیت ماده

 کنند؟این سه قطعه چگونه در یک باتری کار می

 :افتددر یک باتری معمولی، این طور اتفاق می

 .کندالکترود منفی )معمولاً از جنس روی یا لیتیوم( الکترون آزاد می •

 .کندجا میها را جابهالکترولیت )معمولاً یک محلول شیمیایی( این الکترون •

 .کندها را دریافت میاکسید منگنز یا مواد دیگر( الکترونالکترود مثبت )معمولاً از جنس دی •

کنند و این  ها از الکترود منفی به الکترود مثبت حرکت میکنید، الکترونوقتی دو سر باتری را به یک مدار متصل می

دهد که در نتیجه آن  به همین سادگی! باتری یک واکنش شیمیایی داخلی انجام می  .کندحرکت الکتریسیته را ایجاد می

 .شودانرژی الکتریکی تولید می

 

 47تصویر          

الکترود و یک سیم  در واقع شما می به عنوان یک  با استفاده از یک میخ ساده  باتری بسازید، فقط  توانید خودتان یک 

این    .مسی به عنوان الکترود دیگر. هر دو را داخل یک لیمو فرو کنید و آب لیمو نقش الکترولیت را بازی خواهد کرد

 !توانند انرژی الکتریکی تولید کنندهای شیمیایی میدهد چگونه واکنش یک آزمایش ساده و جالب است که نشان می
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 ها علم شیمی باتری

 :افتدکنید، دو واکنش شیمیایی اتفاق میوقتی لیمو، سیم مسی و میخ را با هم ترکیب می

 یکی بین آب لیمو و میخ )معمولاً از جنس آهن یا روی(، 

 .و دیگری بین آب لیمو و سیم مسی

 .کنندها روی میخ تجمع پیدا میدر اولین واکنش، الکترون

 .شوندها از سیم مسی خارج میدر واکنش دوم، الکترون

الکترون پر می الکترون مینتیجه این است که میخ از  ها دوست ندارند در  شود. الکترونشود و سیم مسی دچار کمبود 

دنبال راهی می به  باشند، پس  اما واکنش جاهای شلوغ  برقرار کنند.  تعادل را  برود و  به سیم مسی  میخ  از  تا  های  گردند 

افتد اگر یک لامپ کوچک را  کنید چه اتفاقی میحالا فکر می  .شوندشیمیایی داخل لیمو مانع این حرکت مستقیم می

گردند. ترین مسیر برای رسیدن به سیم مسی میهای روی میخ به دنبال آسانبین میخ و سیم مسی متصل کنید؟ الکترون

بسته تشکیل دهید، آن به سیم مسی حرکت میوقتی شما یک مدار  باشید:   .کنندها از طریق لامپ از میخ  یاد داشته  به 

الکترون حرکت  همان  الکتریکی  استجریان  سیم  یک  درون  روشن    .ها  لامپ  باشد،  زیاد  کافی  اندازه  به  جریان  اگر 

  .است "مرده"شوند. وقتی این اتفاق بیفتد، باتری  های شیمیایی درون باتری متوقف میاما بعد از مدتی، واکنش   !شودمی

باتری از  و  بعضی  الکترودها  برای ساخت  که  موادی  نوع  کنید.  دور  باید  را  دیگر  بعضی  و  هستند  مجدد  شارژ  قابل  ها 

می استفاده  میالکترولیت  مشخص  میشوند،  باتری  آیا  که  یا خیرکنند  شارژ شود  دوباره  باتری  .تواند  از  البته  که  هایی 

اند و دانشمندان همیشه به دنبال  های امروزی از مواد مختلفی ساخته شدهباتری  !اندخرید از لیمو ساخته نشده فروشگاه می

 تر هستند. تر و وزن سبکهایی با ظرفیت بیشتر، حجم کوچکهای جدید برای ساخت باتریروش

کند؟ چه چیزی ولتاژ یک باتری را تعیین می -۶  

استفاده می الکترولیت  و  الکترودها  برای ساخت  که  دارد  بستگی  موادی  به  باتری  یک  و  ولتاژ  الکترودها  اندازه  شوند. 

ندارند ولتاژ  تأثیری در  الکترولیت  باتری کوچک  .مقدار  باتری )که هر کدام یک  ولتاژ، چند عدد سلول  افزایش  برای 

به هم متصل می به صورت سری  به صورت سری وصل می.کنندهستند( را  باتری را  مثبت  وقتی دو سلول  کنید، قطب 

می متصل  دیگر  باتری  منفی  قطب  به  را  باتری  باقییک  آزاد  سر  دو  قطبکنید.  بزرگمانده،  باتری  جدید  را  های  تر 

ولتی از شش    ۹برای مثال، یک باتری استاندارد  .ولتاژ حاصل شده، جمع ولتاژهای دو باتری خواهد بود.دهندتشکیل می

  -های بیرونی فقط به دو ترمینال متصل هستند  ولتی تشکیل شده است، مطابق شکل زیر. توجه کنید که اتصال  ۱٫5سلول  

 حتی اگر چندین سلول داخلی وجود داشته باشد.   -یکی مثبت و یکی منفی 
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 : روشن کردن یک لامپ با انرژی لیمو ۶پروژه شماره 

 "داخل یک باتری چه چیزی وجود دارد؟"توانید باتری را از بسیاری اشیاء مختلف بسازید؛ برای مثال، در بخش  شما می

به شما نشان دادم که یک باتری لیمویی چگونه ممکن است کار کند. در این پروژه، شما خواهید آموخت که چگونه  

 .یک باتری لیمویی شخصی بسازید و با آن یک لامپ را روشن کنید

 چهار عدد میخ کوچک   –سوکت سوسماری  –ال ای دی  –سیم مسی   –وسایل مورد نیاز : چهار عدد لیمو 

 

 48تصویر

 ها سازی سیم : آماده1مرحله 

متر( ببرید. سپس از هر دو انتهای هر تکه، )حدود  سانتی  ۱5اول، سیم مسی خود را به چهار تکه به طول هر کدام )تقریباً  

 .ها به الکترودهای ما تبدیل خواهند شدمتر( عایق را جدا کنید. این سیمسانتی ۲٫5

 

 4۹تصویر
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 : قرار دادن الکترودها در لیمو۲مرحله 

های کوچک آب داخل آن پاره شوند، اما مراقب باشید  ها غلتانید و کمی فشار دهید تا کیسهاول، یک لیمو را بین دست
پوست لیمو نشکند. سپس از یک سر لیمو با میخ یک سوراخ ایجاد کنید، یک سیم مسی را در همان سوراخ قرار دهید و 

 !این اولین باتری لیمویی شما است .میخ را در سر دیگر لیمو قرار دهید، مطابق شکل

 
 50تصویر

اندازهمولتی روی حالت  را  آن  بردارید،  را  خود  ولتاژمتر  تست   DC گیری  را  خود  لیمویی  باتری  اکنون  و  دهید  قرار 

)قرمز( مولتی.کنید مثبت  میخ متصل کنیدسر  به  منفی )مشکی( را  به سیم مسی و سر  اگر همه چیز درست کار    .متر را 

 ولت نمایش داده خواهد شد. ۱متر شما ولتاژی حدود کند، روی صفحه مولتی

 
 5۱تصویر

 : ساخت چهار باتری لیمویی۳مرحله 

لیموی شما   باتری  اگر  برای روشن کردن یک  ۱حتی  ولتاژ  این  تولید کند،  بیایید چند   LED ولت  نیست. پس  کافی 

آوریم به دست  بیشتری  برق  تا  بسازیم  دیگر  لیمویی  مرحله  !باتری  در  داده شده  توضیح  دیگر    ۲مراحل  لیموهای  با  را 

توانید یک لیمو  اگر چهار عدد لیمو کامل در دسترس ندارید، می  .تکرار کنید؛ هر لیمو به یک باتری تبدیل خواهد شد

 حالا شما باید چهار باتری لیمویی در اختیار داشته باشید.   .را به چهار تکه تقسیم کنید

 
 5۲تصویر
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 : اتصال لیموها به صورت سری۴مرحله 

برای   .ها را به صورت سری به هم متصل کنیدهای لیمویی خود به دست آورید، باید آنبرای اینکه ولتاژ بیشتری از باتری

 .اتصال دو لیمو به صورت سری، طرف مثبت یک لیمو را به طرف منفی لیموی دیگر وصل کنید

 :به یاد داشته باشید

 .( است−دهنده قطب منفی )میخ نشان                                  .دهنده قطب مثبت )+( استسیم مسی نشان

پس اولین لیموی شما با سیم مسی و میخ، یک باتری کامل است. حالا با اتصال مثبت )مس( لیموی اول به منفی )میخ(  

 کند.لیموی دوم و همینطور تا آخر، ولتاژ کلی افزایش پیدا می

 

 53تصویر

لیموها را در یک ردیف قرار دهید به    .برای اتصال چهار لیمو به صورت سری، همان فرآیند قبلی را چند بار دیگر تکرار کنید 

 .گذاری کنید نام   4تا    ۱های  سپس لیموها را از چپ به راست با شماره   .ها به سمت راست باشند های مسی آن طوری که سیم 

 :مراحل اتصال

متصل کنید. سیم را به دور میخ پیچیده و محکم کنید تا اتصال فلز به    ۲را به میخ لیموی شماره    ۱سیم مسی لیموی شماره  

  3سیم مسی لیموی شماره    .متصل کنید  3را به میخ لیموی شماره    ۲سیم مسی لیموی شماره    .فلز برقرار شود و جدا نشوند

  :در پایان، شما یک ردیف از چهار لیمو خواهید داشت که .متصل کنید 4را به میخ لیموی شماره 

سیم مسی لیموی  .( باتری بزرگ لیمویی است−این نقطه، قطب منفی )  -ماند  بدون اتصال باقی می  ۱میخ لیموی شماره  

های  این دو انتهای آزاد، ترمینال.این نقطه، قطب مثبت )+( باتری بزرگ لیمویی است  -نیز بدون اتصال است    4شماره  

 استفاده کنید.  LEDها برای روشن کردن یک توانید از آنباتری چهار لیمویی شما هستند که می

 

 54تصویر
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شود. بنابراین چهار عدد باتری لیمویی  ها با هم جمع میکنید، ولتاژ آنها را به صورت سری به هم وصل میوقتی باتری
متر دارید، حالا ولتاژ را بین دو  اگر مولتی.ولت انرژی داشته باشند  4کنند، در مجموع باید  ولت تولید می  ۱که هر کدام  

ولت   4تا    3٫5ولتاژی حدود  .انتهای این زنجیره لیموها اندازه بگیرید تا مطمئن شوید همه چیز به خوبی متصل شده است
به خوبی کار  .باید مشاهده کنید لیموها  یا یکی از  باشد  اگر عدد کمتری دیدید، ممکن است یکی از اتصالات ضعیف 

 توانید ولتاژ هر لیمو را جداگانه هم تست کنید.می -نکند 

 
 55تصویر

 : تست کردن باتری لیمویی۵مرحله 

لیموها وصل کنیم LED حالا وقت آن است که به  بلندتر!را  لیموی   LED پایه  به سیم مسی )مس(  )قطب مثبت( را 

اگر همه چیز .متصل کنید، مطابق شکل  ۱)قطب منفی( را به میخ لیموی شماره   LED ترپایه کوتاه.وصل کنید  4شماره  

 .باید روشن شود LEDدرست باشد، 

روشن نشد، مطمئن شوید  LED دهند، بنابراین اگر فقط در یک جهت جریان را از خود عبور می ها  LED :نکته 

های لیمویی خود را اید. همچنین ولتاژ کافی از باتری های مربوطه وصل کرده های آن را درست به قطب که پایه 

 .چک کنید 

 
 56تصویر

باتری قویلیموها  خیلی  هیچهای  )مثلًا  نیستند  نمیای  وصل  کامپیوترش  به  را  لیمو  یک  پس کس  شما   LED کند(، 

بعد از اینکه مدار لیمویی خود را کامل کردید، چراغ اتاق را خاموش کنید در  .احتمالاً خیلی تقریباً کم نور خواهد بود

 .را مشاهده کنید LED تاریکی باید بتوانید نور بسیار کم 

 !ها را نخوریدآن -وقتی کار شما با باتری لیمویی تمام شد، لیموها را دور بیندازید  نکته مهم: 

 .اند و دیگر ایمن برای مصرف نیستند اند با آب لیمو واکنش شیمیایی داده مواد فلزی )مثل میخ و سیم مسی( که در لیمو فرو رفته 
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 آموزش پاورپوینت 

 

PowerPoint 
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 ها پرداختیم. ها و آشنایی بیشتر با سربرگدر سال قبل تا حدودی به سر فصل

 اید؟ بزن بریم که قراره امسال مطالب جدیدتری آموزش ببینیم. آماده

 ویرایش تصاویر  -1 درس

این کار   برای  نمایید.  ویرایش  را  بخواهید تصویر  است  ممکن  اضافه کردید  اساید  به  را  نظر  مورد  تصویر  آنکه  از  پس 

های متفاوتی به منظور ویرایش  فعال شود. در این قسمت بخش    Formatتصویر را به حالت انتخاب درآورید تا قسمت 

 تصاویر وجود دارد. 

 

 ۱تصویر 

کنتراست    : Adjustگروه    (1 و  روشنایی  تنظیم  قبیل  از  امکاناتی  شامل  گروه  رنگ  (Corrections)این  تغییر   ،

(Color)  سازی فشرده   ،(Compress)،  افکت هنری  ایجاد  عکس  (Artistic Effects)های  زمینه  پس  حذف   ،

(Remove Background)  دیگر تصویر  با  تصویر  تعویض   ،(Change Picture)     حالت به  تصویر  برگرداندن  و 

 . باشدمی  (Reset)اولیه

جلوهPicture Styleگروه    (۲ اعمال  منظور  به  امکاناتی  شامل  گروه  این  برای  :  حاشیه  کادر  ایجاد  و  مختلف  های 

 . باشدتصاویر می

در صورت وجود چند تصویر، این گروه امکاناتی جهت تنظیم ترتیب قرارگرفتن تصاویر را برای  :  Arrangeگروه   (۳

 .کندکاربران فراهم می

 شود. می (Crop) این گروه شامل شامل امکاناتی مانند تنظیم اندازه و برش دادن تصویر: Sizeگروه  (۴

تصویر  ویرایش  برای  دیگر  میراه  گزینه :  و  کرده  راست  کلیک  آن  روی  را     Format Pictureتوان 

از گزینه استفاده  با  محاورهانتخاب کنید.  کادر  موجود در  توان خصوصیات  می Format Pictures ای  های 

 ظاهری تصویر را تغییر داد. 

1 2 

3 4 
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 (Smart Art)های هوشمند نحوه درج طرح 

 SmartArtیکی از امکانات جذاب این   .شودمی استفاده سلسله مراتب درختی برای نمایش گرافیکی متن بصورت یک

   SmartArtهای مختلف متن در قالببرای نمایش  مختلفی را    Styleتوانهای هوشمند است. مینرم افزار، ایجاد طرح

 های خود از آن استفاده کنید.توانید بسته به نیازدهد. که شما میارائه می

 ها:برای درج این گونه طرح

 کلیک نمایید.  Smart Artبر روی گزینه  Illustrations، گروه  Insertاز قسمت   ➢

 توان برای نمایش چرخه حسابداری، نمودارای سازمانی، نمودار پردازشی و .... استفاده کرد. از این گزینه می ➢

 کلیک کنید. OK را انتخاب نموده و رویSmartArt ی ظاهر شده از سمت چپ نوعدر پنجره ➢

 شود.انتخاب شده در اسلاید جاری ظاهر میSmartArt سپس نوع ➢

  SmartArt در قالب اسلاید، برای درج  Insert a SmartArt Graphicتوانید از ابزارهمچنین شما می  نکته: 

 است.

 

 ۲تصویر

 

 (SmartArt)های هوشمند ویرایش طرح 

توانید  شود گه با  استفاده از آن میظاهر می   Smart Art Toolsپس از انتخاب نمودار موردنظر منوی پنهانی با عنوان  

شدن طرح زیباتر  برای  قسمت  تغییراتی  شامل  منو  این  کنید.  اعمال  نظر  مورد  که  می   Formatو     Designهای  باشد 

های خاصی جهت  گزینه   Designباشد. اما در قسمت  بعد از درج اشکال می   Formatمشابه قسمت   Format گزینه  

 وجود دارد.   Smart Artهای هوشمند یا همان ویرایش طرح
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های بیشتری به طرح هوشمند خود  توانید بخش : با استفاده از این ابزار می Create Graphicاز گروه Add Shapeابزار 

 اضافه کنید. 

ابزار می Create Graphicاز گروه    Add Bullet  ابزار  با استفاده از این  توانید قبل نوشتن متن یک نماد گرافیکی  : 

 درج کنید. 

گروه  Text Pane ابزار میCreate Graphicاز  ابزار  این  از  استفاده  با  بخش :  متن  ویرایش  و  درج  برای  های  توانید 

 مختلف طرح هوشمند استفاده کنید. 

 توانید شکل طرح درج شده را تغییر دهید.: با استفاده از این بخش میLayoutگروه 

 توانید رنگ و سبک طرح درج شده را تغییر دهید. : با استفاده از این گروه میSmartArt Style گروه

: این ابزار برای بازگرداندن طرح هوشمند به حالت  اولیه قبل از اعمال تغییرات   Resetاز گروه     Reset Graphic ابزار

 کاربرد دارد. 

ابزار میReset از گروه  Convertابزار   این  با استفاده از  انتخاب  :  با  به متن و  انتخاب گزینه  با  توانید طرح هوشمند را 

 گزینه به شکل تبدیل کنید.

 (Table)نحوه درج جدول  

های  ها و ستونکنیم و از منوی باز شده با اشاره گر ماوس تعداد سطرکلیک می Table بر روی گزینه   Insertاز منوی  

 های جدول است.کنیم. عدد اول نشان دهنده سطر و عدد دوم نشان دهنده ستونجدول را انتخاب و کلیک می

 جابه جایی جدول  

 های جدول کلیک کرده و آن را به محل مورد نظر درگ کنید.روی لبه

 

 3تصویر 
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 افزودن سطر یا ستون به جدول  

 روی سلول مورد نظر در محلی که قصد افزودن سطر یا ستون به جدول را دارید کلیک کنید. -۱

 کلیک کنید. Ribbon ازسمت راست منوی Layoutیروی زبانه

 Insert های خواهید سطر جدید اضافه کنید یکی از گزینه را پیدا کنید. حال اگر می Rows & Columns گروه 

Above   جاری( یا   )درج در پایین سلولInsert Below    ،درج در بالای سلول جاری( و اگر قصد افزودن ستون را دارید(

 را انتخاب کنید.   )سمت راست سلول جاری(   Insert Right )سمت چپ سلول جاری( یا     Insert Left های  یکی از گزینه 

گزینه     Tableاست. از منوی     Insert Tableهای جدول با استفاده از گزینه  راه دیگر برای ایجاد جدول، تعیین خانه 

Insert table    سطر یا ستون جدید در محل مورد نظر در جدول   شود. شود و پنجره ای مطابق شکل باز می انتخاب می

 .اضافه خواهد شد 

 

 4تصویر 

 

 5تصویر 

 حذف سطر یا ستون از جدول  

 خواهید سطر یا ستونی از آن حذف شود کلیک کنید. روی سلول مورد نظر در محلی که می

 Deleteکلیک کرده سپس برای حذف سطر DeleteرویRows &Columns ودرگروه  Layoutیاز زبانه

 Rowsو برای حذف ستونDelete Columns   را از منوی ظاهر شده انتخاب نمایید. در نتیجه سطر یا ستون مورد نظر

 از جدول حذف خواهد شد.

برای درج   Deleteو Insert هایتوانید با کلیک راست روی سلول مورد نظر به گزینهشما همچنین مینکته:  

 و ستون جدول، دسترسی پیدا کنید. و حذف سطر
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 6تصویر 

 های سطر و ستون نمودارجایی داده جابه 

های سطر و ستون نمودار را با هم عوض کنید. که در ادامه ما مراحل انجام این  گاهی اوقات شما نیاز دارید که جای داده
 فرآیند را ذکر کرده ایم: 

      .شودظاهرمیDesign ینمودار مورد نظر را انتخاب کنید، سپس زبانه -۱

 کلیک کنید. Data در گروه Edit Data روی Design یاز زبانه -۲

 .انتخاب کنیدData را از گروهSwitch Row/Column دوباره روی نمودار مورد نظر کلیک کرده و سپس گزینه -3

 

 

 7تصویر  

 های سطر و ستون عوض خواهد شد.در نهایت جای داده -4

 به جداول Style اعمال 

 .کلیک کنید Ribbon از سمت راست منوی Design  یهای جداول کلیک کرده و سپس روی زبانه روی یکی از سلول 

 های مختلف را مشاهده کنید. تمام حالتStyle کنارلیست Moreبا کلیک روی دکمهTable Styles در گروه

 شود. مورد نظر در جدول اعمال میstyle مورد نظر کلیک کنید، style روی 

 

 8تصویر 

3 

2 
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 به جدول Border افزودن 

 توانیدهای آن واضح و مشخص باشد، همچنین میاضافه کنید تا مرز بین سلولBorder توانید به جدول خود  شما می

 آن را نیز تغییر دهید. style رنگ، ضخامت و

 .انتخاب کنیدborder های مورد نظر را برای افزودنسلول .1

 

 

 ۹تصویر 

 

 .را انتخاب نماییدPen Color وLine Style, Line Weight های گزینهDesign یاز زبانه .2

 را انتخاب نمایید. border  نوعBorders  پس از انتخاب روی منوی کشویی .3

 شود. به جدول مورد نظر اعمال می borderدر نتیجه .4

حذف  رویborder برای  سلول،  ازانتخاب  را  No Border یهگزین  وسپس کرده کلیکBorders پس 

 .انتخاب کنید

 (Chart)درج نمودار  

 Insert شود. برای افزودن نمودار در اسلاید کافی است از قسمت  های عددی از نمودار استفاده می برای نمایش بصری داده 

 کلیک کنید پنجره که باز شد نوع نمودار مورد نیاز خود را انتخاب کنید.  Chart روی آیکون   Illustrationsو در گروه   

  

 

 ۱0تصویر 

3 2 
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 (Charts)ها انواع نمودار  

 

 ۱۱تصویر 

 تمرین:

ی درسی خود )مثلافیزیک(، همانند اشکال بالا به دلخواه نموداری طراحی کنید و آن را در کلاس  ها با استفاده از کتاب

 ی خود ارائه دهید. هابرای همکلاسی

 نحوه درج فرمول و معادله در یک اسلاید در پاورپوینت 

  Insertه مطالب مان نیاز به درج معادله و فرمول در نرم افزار پاورپوینت داریم. برای این کار از قسمت  ئ گاهی برای ارا

   Equation Toolsکلیک کرده و با استفاده از ابزار موجود در سربرگ     Equation، روی گزینه   Symbolگروه  

 کنیم.فرمول مورد نظر را تایپ می

 

 ۱۲تصویر 

 تمرین این فصل: 

 .های دوم جدول طراحی شده بنویسیدهای زیر را در سطرطراحی کنید، فرمول ۲x3جدولی 

W=m.g        ,          𝑘 =
۱
۲
𝑚. 𝑣۲           ,        V= 

𝑑

𝑡
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 ها های اجرایی اسلاید ها، شیوهچگونگی طراحی انیمیشن و متحرک سازی اسلاید  -۲ درس

 هدف این فصل: 

o  یادگیری متحرک سازی اسلایدها 

o ها آشنایی با تنظیمات آن 

های عبور متفاوتی ایجاد کرد.  توان برای گذر از اسلایدی به اسلاید دیگر، انیمیشن یا اصطلاحا حالتدر پاورپوینت می

کند که در هنگام نمایش، یک اسلاید به چه شکلی جای خود را به اسلاید بعدی بدهد. برای های عبور تعیین میحالت

 های عبور را انتخاب کنید.یکی از حالت  Transitions to this slideو گروه  Transitionsاین کار، ابتدا از قسمت 

 

 

 ۱3تصویر 

 (Transitions)ها های عبور اسلایدتنظیمات حالت  

ها و یا درج صدا برای تغییر بین  توانید تنظیماتی از قبیل سرعت، چگونگی حرکت اسلایدبا انتخاب هر حالت عبور می
استفاده کرد. در ادامه     Transitions، از قسمت  Timingها اعمال نمایید. برای این کار از ابزار موجود در گروه  اسلاید

 پردازیم: به توضیح هر بخش از این تنظیمات می

 

 ۱4تصویر 

 دهد.: این ابزار امکان قرار دادن صدا بر روی حالت عبور را می Soundابزار 

 دهد.: به شما امکان تعیین سرعت زمان اجرای حالت عبور را میDurationکادر زمانی 

گزینه Advance Slide ابزار   انتخاب  با   : On Mouse Click می تعریف  برنامه  به  برای  ماوس  کلیک  با  که  کنید 
و تعیین یک زمان مشخص، اسلایدها بطور خودکار به اسلاید بعدی    Afterاسلاید بعد منتقل شوید، اما با انتخاب گزینه  

 شوند.منتقل می

تمامی برای  را  سربرگ  این  کل  تنظیمات  بخواهید  گزینهاسلایداگر  روی  کنید  اعمال  موجود     Apply to Allهای 

 کلیک کنید. 
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 سازی متن در یک اسلاید درج انیمیشن و متحرک 

 ها است. های متحرک و متحرک سازی متن در اسلایدهای زیباتر کردن متن ایجاد انیمیشن یا جلوهیکی از روش

قسمت از  و  کرده  انتخاب  را  موردنظر  محتوای  ابتدا  در  منظور  این  گزینه     Animationsبرای  پایین  به  رو  فلش  روی 

Animations سازی و انیمیشن موردنظر را انتخاب نمایید.کلیک کرده واز لیست باز شده نوع جلوه متحرک 

 

 

 ۱5تصویر  

 ها تنظیمات انیمیشن  

انیمیشن می انتخاب هر  نظر  با  بر روی محتوای مورد  را  انیمیشن  نحوه اجرای  یا  و  تاخیر  قبیل سرعت،  از  تنظیماتی  توان 

 استفاده کرد.   Animations ، از قسمت  Timingتوان از ابزار اعمال کنید. برای این کار می

 

 ۱6تصویر 
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 رمز عبور برای فایل  -1 درس

حساس و    ی هالیفا  تی اند تا از امنشده  لیالزام تبد  کیمتوسط و بزرگ به    یها شرکت  یاکسل برا  ل یعبور فا  یرمزها

ا  نانیمحرمانه اکسل اطم مهم موجود در    یهاداده  توانند یم  رمجازی حفاظت، هکرها و کاربران غ  ن ی حاصل کنند. بدون 

تغ  یهالیفا را  دستکار  ریی اکسل  م  پاک   ی حت   ا یکنند    ی دهند،  که  ز  تواندیکنند  به    ن ی ا  یبرا  ی بزرگ  یهاانیمنجر 

تنها    بیترت  ن یبد  دهند،یبه کاربران مجاز را م  یاکسل با رمز محافظت شده فقط اجازه دسترس  ی هالیفا.ها شود شرکت

است    ن ی اکسل ا  یهالیفا  یاستفاده از رمز برا  یایکنند. مزا  ش ی رایآن را و  ایرا بخوانند    لیفا  توانندیم   دیی افراد مورد تأ

تغ ( محافظت  Worksheetsکار )   یهااز ورقه  کند،یم  یر ی گ( جلوWorkbookدر دفترچه کار )  یتصادف  راتیی که از 

 .سازدیم من یا زی و ساختار دفترچه کار را ن کندیم

 (Excel) رمز عبور در اکسل نیینحوه تع

 :است ریاکسل به شرح ز  لیرمز عبور و محافظت از فا  کی می تنظ  یبرا ریز مراحل

 "لیفا"  منوی کردن باز – ۱ مرحله

آن رمز عبور    یبرا  دیو قصد دار  دیدار "Cube" به نام (Workbook) دفترچه کار اکسل  کی  دی مثال، فرض کن   یبرا

 .دی کن  ن یی تع

 .دیصفحه برو ی( در گوشه سمت چپ بالا لی)فا "File" تب به

 .دی )اطلاعات( را انتخاب کن "Info" نهیباز شده، گز یمنو از

)حفاظت از دفترچه کار( و   Protect Workbook یهانهیرمز عبور شامل انتخاب گز میتنظ   یبرا یادامه، مراحل بعد در

 :دی آنها را هم مشاهده کن  دی توان یوارد کردن رمز خواهد بود که در ادامه م

 رمز عبور  ن تعیی – ۲ مرحله

 .دیکن  دای را پ "Protect Workbook" نهی، گز "Info" بخش  در

 .دی کن  کی با رمز عبور( کل ی)رمزگذار "Encrypt with Password" یرو

 .دی رمز عبور خود را وارد کن  خواهدیکه از شما م   شودیباز م یاپنجره

 .دی کن ک ی کل OK یو رو  دی کن  پیمورد نظر را تا رمز

 ل یفا رهذخی  -3 مرحله

 .اعمال شوند راتیی تا تغ  دی کن  رهی خود را دوباره ذخ لیرمز، فا م ی از تنظ  بعد

 . شودیاز شما رمز عبور خواسته م   د،ی را باز کن  لیهر بار که فا نده،یآ در
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 ۱تصویر

 یک فایل اکسل بنویسید و آن را رمزنگاری کنید . تمرین : 

  

 قدم اول

دوم  قدم   

سوم   قدم  
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 توابع در اکسل  -۲ درس

.  رود ی ها به کار م داده   ی ساده رو   ا ی   ده ی چ ی انجام محاسبات پ   ی دستور خاص است که برا   ک ی (  Functionدر اکسل، تابع ) 

 . د ی نداشته باش   ی طولان   ی ها به نوشتن فرمول   ی از ی فراهم کرده است تا شما ن   فرض ش ی توابع را به صورت پ   ن ی از ا   ی ار ی اکسل بس 

 تابع در اکسل  کی روش نوشتن 

 : شده است  لی تابع در اکسل از سه قسمت تشک هر

 .شوندیعلامت شروع م ن ای  با اکسل در توابع و هافرمول همه  )=( یعلامت مساو •

 AVERAGE ای SUM مثلتابع   نام •

 آنها انجام شود.  ی رو اتی عمل دی خواه یکه م هاییسلول محل( Range) محدوده •

 SUMمثال اول: جمع زدن چند عدد با تابع 

ا   ی برا  کل  تابع    ن یجمع  از  استفاده   SUMاعداد، 

 :م ی کن ی م 

SUM  است  " جمع "  یاسم تابع است که به معن. 

سلول "  در  موجود  هم   A6تا    A  ۱ی هااعداد  با  را 

 ." جمع کن 

 .کند و سپس اینتر را بزن که کل آن را جمع می 

 

 

 
 

 

 ۲تصویر

 از توابع پرکاربرد در اکسل:  گردی  نمونه چند

 مثال کاربرد تابع

AVERAGE  میانگین گرفتن از اعداد =AVERAGE(B1:B10) 

MAX عدد  ن یکردن بزرگتر دای پ =MAX(C1:C10) 

MIN عدد  کوچکترین کردن  دای پ =MIN(D1:D10) 

COUNT  شمارش تعداد اعداد =COUNT(E1:E10) 

IF ی شرط  یری گمیتصم =IF(F1>10, 

“big”,”little” 
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 م؟ یکن یچرا از توابع استفاده م

 .صدها عدد یبه جمع زدن دست ازی : بدون نشتری ب سرعت •

 .کمتر در محاسبات ی: خطاشتری ب دقت •

  ی مال  ،یمنطق  ،ی اعم از آمار  د،ی انواع محاسبات را انجام ده  دی توانی: با استفاده از توابع مختلف، میریپذانعطاف •

 .رهی و غ

 آموزان : محاسبات نمرات دانشنی تمر

 .دیدرس مختلف دار 4آموز در دانش  5از نمرات  ست ی ل کیشما  دی کن فرض

 .دی محاسبه کن "جمع کل " به نام  یدیآموز را در ستون جدجمع نمرات هر دانش  •

 .دی محاسبه کن "ن یانگ ی م "به نام  یدیآموز را در ستون جدنمرات هر دانش  ن یانگی م •

 .دی کن دای آموز( را پ)هر دانش  فینمره در هر رد نینمره و کمتر ن یشتری ب •

 .دیآموز را بشمارهر دانش  ۱5 یدرصد تعداد نمرات بالا •

 قالب بندی در اکسل 

استا  ی دهفرمت  یبرا  ی ادیز  ی هاراه  اکسل دارد  ی دهلیو  فرمت  دیبا  چرا.به جدول  را  استا  یدهجدول خود    یده لیو 

بهتر اطلاعات را فراهم م  ییم؟خوانایکن    ر یی تغ  یعن ی  یده لیکنداستایم  تریاو حرفه  باتریجدول را ز  کندظاهریو درک 

 .گر یها، فونت، اندازه فونت، حاشورها، فرمت اعداد و موارد درنگ رتغیی   مثل -ها  در ظاهر سلول

 :یدهلیاستا یابزارها نی پرکاربردتر

 (Colors) هارنگ •

 (Fonts) هافونت •

 (Borders) حاشورها •

 (Number formats) اعداد فرمت •

 (Grids) شبکه  خطوط •

 :در اکسل وجود دارد  لی به دستورات استا یدسترس یراه برا دو

 (Ribbon) ابزار نوار •

 ها سلول یراست رو کیکل قیاز طر ،یده فرمت یمنو •



 

57 
 

 بون ی در ر  یده لی دستورات استا

 
 3تصویر

پ  یکردن رو  کی با کل   توانینوار را م پا  /کانینماد  به  ا  نیی فلش رو  به    یکار دسترس  نیدر سمت راست گسترش داد. 

 : کندیرا فراهم م یشتری دستورات ب

 
 4تصویر

 ا هدهی، کلیک راست کردن روی سلولدستورات استایل

 

 5تصویر

 اکسل  برداریبندقالب

را    ی بند قالب   دهد ی دستور است که به شما امکان م   ک ی   بردار ی بند قالب 

است که در    ی ابزار عال   ک ی   نی ا   .د یکن  ی کپ  گر ی سلول به سلول د   ک ی از  

 یبرا   توان ی م   بردار ی بند قالب   از   !کند ی م   ی اد ی ز   یی جو وقت شما صرفه 

سلول   ی کپ به  کرد محدوده   ا ی   ی تک   ی ها کردن  استفاده   .ها 

کل   بردار ی بند قالب  رو   ک یبا  ر   ی دکمه   ی کردن  در  در    بون، ی آن  که 

 .شود ی قرار دارد، استفاده م   بورد پ یگروه کل 

 

 

 6تصویر 
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  نی ا  .دی کن   یکپ  گریسلول به سلول د  کیرا از    یبندقالب  دهدیدستور است که به شما امکان م   کی  یبندقالب  یموقلم

عال  کی به    یکپ   یبرا  توانیم  یبندقالب  یموقلم  از  !کندیم  یادیز  ییجواست که در وقت شما صرفه  یابزار  کردن 

کردمحدوده  ایمنفرد    یهاسلول استفاده  کل  ی بندقالب  یموقلم.ها  رو  کی با  گروه   یکردن  در  که  نوار،  در  آن  دکمه 

Clipboard شودیاستفاده م شود،یم افتی . 

 

 7تصویر

 فرمت یزیرنگ آم  Format Painter نحوه استفاده از

محدوده را    ایسلول    کی   دی کن   کی کل  Format Painter دکمه  یرو  دی انتخاب کن   دی کن   یکپ  دی خواهمیرا که    یسلول

با رنگو قالب  م یچند مثال را امتحان کن   دیی ای ب  دی انتخاب کن را  پررنگ )ها  مانند  (، مورب  Boldها و مشخصات فونت 

(Italicو ز )رخطی( دارUnderlineکپ )میکن  ی : 

       

 8تصویر

 .کن  یکپ B1 به  A1 رنگ قرمز را از
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 :به گام گام

 را انتخاب کن A1 سلول •

 کن کی کل Format Painter دکمه یرو •

 را انتخاب کن B1 سلول •

  
(۱ ) (۲ ) 

 
 

(3 ) (4 ) 

 ۹تصویر

 

  B ۱آن را در دیی ای شده و آماده چسباندن است. ب یدهد که قالب کپمینشان  نی. ادی باش A1دور  ن ینقطه چ هیمتوجه حاش

 ! میبچسبان
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 اعداد در اکسل   یها فرمت -۳ درس

ها را برای توابع آماده کنید، تا اکسل متوجه شود با  ها را قابل توضیح کنید دادههای عدد را تغییر دهیم؟دادهچرا فرمت

 :های عددهایی از فرمتمثال. کنیدای کار میچه نوع داده

 عمومی •

 عدد  •

 واحد پول •

 زمان  •

توان با کلیک بر روی منوی کشویی فرمت عدد، که در ریبون و در گروه اعداد قرار دارد، تغییر  های عدد را میفرمت

 .داد

 

 

 ۱0تصویر

 . مثلًا: دیرا دار هامتی از ق یست ی جدول ساده، ل کی در  دی کن  فرضی: پول "Currency" فرمت اعداد به ریی تغمثال : 

 .شونددر حال حاضر این اعداد بدون فرمت خاصی هستند و فقط عدد نمایش داده می
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 ش ینما  ۱,000$  ای  الیر  ۱,000مثل    یباتریتا به صورت ز  می ده   ریی ( تغ ی)پول  Currencyاعداد را به    ن یفرمت ا  :هدف

 داده شوند.

 

 ۱۱تصویر

 :مراحل انجام کار

  .دی هستند را انتخاب کن  متی که شامل اعداد ق   ییهاسلول:  هاانتخاب سلول: ۱مرحله 

 :  Number Format یبه منو  یدسترس: ۲مرحله 

 .دیبرو (Ribbon) ییدر نوار بالا Home به تب •

 . دی کن کیاست، کل یگریهر فرمت د ای " General"که نوشته شده  یادکمه ی ، رو Numberگروه  در •

 : Currencyانتخاب فرمت : 3مرحله 

 .دی را انتخاب کن Accounting ای Currency نهیگز ،شده  باز ستی از ل •

 .کندیم لیتبد یفوراً اعداد شما را به فرمت پول اکسل •

 

 ۱۲تصویر

فرمت  تغییر  گزینه   از  و  کنید  درست  فاکتور  یک  و  کنید  درست  را  محصولات  قیمت  لیست  تمرین  عنوان  به  مثال: 

Currency  .استفاده کنید 
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 ی ارقام اعشار

 .کاهش داد ای ش یافزا توانیرا م یارقام اعشار تعداد

 :دستور وجود دارد دو

 (Increase Decimal) یاعشار ش یافزا •

 (Decrease Decimal) یاعشار کاهش  •

اعشار  نیا  ی رو  ک ی کل  با ارقام  تعداد  انتخاب  ی دستورها،  سلول  منو  نیا.شودیم  اد یز  ا یکم    ی در  کنار  در    ی دستورات 

 فرمت اعداد قرار دارند.  ییبازشو

 

 

 

 ۱3تصویر

 

 در اکسل یمثال: کار با اعداد اعشار

  عدد چهار رقم اعشار دارد. ن یدر حال حاضر ا :دیاسلول وارد کرده  کیرا در  ریعدد ز دی کن فرض

۱۲3.4567 

 .میرقم محدود کن  ۲عدد را به  ن یا ی تعداد ارقام اعشار  :هدف    

 :مراحل انجام کار      

 .دی مثلارا انتخاب کن  عدد یسلول حاو •

 .دیبرو (Ribbon) ییدر نوار بالا Home تب به •

 :دی کن  دای را پ ری، دو دکمه ز Number گروه در •

• Increase Decimal ی اعشار ش ی افزا 

• Decrease Decimal   ی کاهش اعشار 

 رقم برسد.   ۲به  یتا تعداد ارقام اعشار دی کن  کی چند بار کل Decrease Decimalدکمه  یرو •

 

 
 ۱4تصویر

 حال به دو رقم اعشار کاهش پیدا کرد  
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 (Gridlines) شبکه خطوط:   در اکسل  (Grids) شبکه یبند فرمت -۴ درس

 .پنهان کرد توانیخطوط را م   ن یحال، ا ن یا با . شوندیداده م ش ی خطوط شبکه در اکسل نما فرض،ش ی حالت پ در

 م؟ی چرا خطوط شبکه را پنهان کن

 جدول  ییخوانا ش یافزا یبرا •

 تر یاو حرفه باتریز یظاهر جادیا یبرا •

 :روش پنهان کردن خطوط شبکه

 .دی کن کی کل (Ribbon) ییدر نوار بالا View تب یرو •

 .دی کن  دای را پ Gridlines نهیگز •

 (. دی کن  Uncheck) دیکنار آن را بردار کی ت •

 

 ۱5تصویر

 :(Regional Format Settings) یافرمت منطقه  ماتیتنظ

  ی امنطقه  ماتی تنظ .کندیاطلاعات فراهم م   ش یمختلف نما  یهاها و سبکمخصوص به زبان  یده فرمت  ماتی تنظ   اکسل

 :از جمله  گذارند، یم ری مورد تأث  ن یبر چند

 (Calendar date formatting) خیتار فرمت •

 ی اعشار اعداد •

 فرض ش ی پ یپول فرمت •

 (Formula delimiters)  فرمول یهاجداکننده •
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نمادها  ن یا  ن یتر معمول . شوندی تابع استفاده م   ک ی ها در جدا کردن آرگومان   ی هستند که برا  یی فرمول نمادها  ی ها جداکننده 

 : کند ی استفاده م رگول ی از و  ی سی انگل   یا زبان منطقه  م ی عنوان مثال، تنظ  به  .( هستند   ;) , ( و ؛ )    رگول ی و 

 

 :کند ی استفاده م  رگول ی و از نقطه   یآلمان   ی ازبان منطقه   مات ی که تنظ ی در حال

 

 یافرمت منطقه ماتیاز تنظ یمثال

  اند: ( نشان داده شده کا ی )آمر  ی سی زبان انگل   ماتی فرمول با استفاده از تنظ  یها و جداکننده   یعدد اعشار   خ،ی تار  نجا یا   در 

 :  شودیداده م ش ینما ریبه صورت ز ماتیتنظ  ن یدر ا ۱403مهر  ۲0 خیتار •

 
 : شودیصورت نوشته م ن ی به ا "هفت  زی و پنج مم ستیدو"عدد  •

 
ها استفاده  جدا کردن آرگومان  ی) , ( برا  رگولیاز و  د،ی کنیچند سلول را با هم جمع م  یوقت   SUMدر تابع   •

   :شودیم
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 یافرمت منطقه ماتیتنظ رییتغ

 : دیمراجعه کن File ی( در منوOptions) "ها نهیگز"به بخش   ،یافرمت منطقه ماتی تنظ  ریی تغ یبرا

 

 ۱6تصویر

 

 :دی مورد نظر خود را انتخاب کن یازبان منطقه ماتی تنظ  دی توانیکه در آن م  کندیکادر  را باز م  کی نهیگز نیانتخاب ا

 

 

 

 ۱7تصویر
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 :  هاپروژه

 یو اعشار یمحصولات با فرمت پول  یگذارمتقی جدول ساخت: 1 پروژه

 :های شما را وارد کنیدلیستی از محصولات و قیمت .1

 .دی ده ریی ( تغ ی)پول Currency را به فرمت ها متی ق .2

 .دی رقم محدود کن ۲را به  یارقام اعشار تعداد .3

 .شود  یها کپسلول ر یسلول به سا کیتا فرمت   دی استفاده کن  Format Painter از .4

 .دی کن  رفعالی غ View > Gridlines یشبکه را از منو  خطوط .5

 (یامختلف )فرمت منطقه  یهاکار با زبان  یاکسل برا لی فا کی  م تنظی: ۲ پروژه

 ی زیر درست کنید : هایک فایل اکسل با داده .1

 

 

 .بروید File > Options > Advancedبه  .2

 (,) های فرمول از ویرگولتغییر دهید که جداکننده , When calculating this workbookدر قسمت   .3

 .تغییر کند )برای مناطقی مثل آلمان( (;) کالونبه سمی

 ها را به فرمت محلی کشورهای دیگر تبدیل کنید  تاریخ .4

 .تغییر دهید (,) به ویرگول (.) عدد اعشاری را از نقطه .5
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 آموزش فتوشاپ 

 

Photoshop 
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 ای بر فتوشاپ مقدمه  -1درس 

از    یکیگراف  یهایو طراح  ریکار با تصاو  یاست که طراحان و عکاسان برا  ییافزارهانرم  ن یتراز معروف  یک یفتوشاپ  

م استفاده  زندینمایآن  را  آن  نام  احتمالاً  دق  د،یادهی شن   ادی.  م  دی دانینم  قاًی اما  کار  بکندیچگونه  ب  دیی ای .  :  می کن  انی ساده 

 است! ریدادن و خلق تصاو ریی غت یبرا ییافزار جادونرم کیفتوشاپ 

 چرا فتوشاپ؟

تصو  ی گاه است  کن   یریممکن  بس  دی ثبت  برخ  ار ی که  در  اما  است،  ن  ی نواح  ی خوب  بهرنگ  ای  ستیشفاف    ی درستها 

باشد که ما  یزی چ  ریدر تصو  دیشا  ای.  شوندیداده نم  ش ینما مانند    دهید  دی ستی ن  لیوجود داشته   کی  ایدست    کیشود، 

ا  را خراب کرده است.  ریخودرو که ظاهر تصو ا  آوردیامکان را فراهم م  ن یفتوشاپ  نما  ن ی تا    د، یی مشکلات را اصلاح 

!  دیرا از ابتدا بساز  ریتصو  کی  دی توانیم  یحت  .دی را حذف کن   دیکه دوست ندار  ییهابخش   یحت   ای  د،ی ده  ریی ها را تغ رنگ

  .دی کن  جادیخود ا  یشخص   یصفحه  یجذاب برا  یطراح  کی  ای  تیزیکارت و  ،ی غاتی بنر تبل  کی  دی مثال، اگر بخواه   یبرا

صورتش افتاده. با    ینامناسب رو  ی هیسا  کیجذاب است، اما    اریکه بس  دیااز دوست خود گرفته  یریتصو  دی کن  تصور 

م فتوشاپ  از  سا  یراحت به  دی توان یاستفاده  کرده    هیآن  حذف  ببخش  ایرا  بهبود  را  چهره  همچندی رنگ    د ی توانیم  ن ی . 

  .دی به آن ببخش  یا حرفه یاد تا جلوهیی اضافه نما ریبه تصو ییروشنا  ای یمانند تار ییهاافکت

              
 

 ۱تصویر

 :های اصلی فتوشاپویژگی

عکس .1 تغ   :هاویرایش  رنگ  ر،یتصو  یاندازه  رییامکان  برش  اصلاح  با    یها بخش   ییجاجابه  ا یها،  مختلف 

 گوناگون.  یابزارها

گرافیک  . 2 طراح  : طراحی  و   ی از  کارت  تا  گرفته  پوستر  و  بنر  م   ت، ی ز ی لوگو،  را  فتوشاپ    توان ی همه  با 

 نمود.  ی طراح 

 .دیی خلق نما  یبعدسه ریتصو  ای تالی ج ید یاثر هنر کیاز ابتدا  دی توان یم لیدر صورت تما :خلق آثار هنری .3

 تر به نظر برسند.اضافه کرد تا جذاب هیمانند نور و سا  ییهاافکت ریبه تصاو توانیم :های ویژه افکت  .4
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 کنه؟ فتوشاپ چطور کار می

همه فتوشاپ  لا  زی چ در  اشودیم  تیریمد ۱ها هیبا  م  ها هی لا  ن ی .  تصو  دهندیامکان  از  بخش  به  ر یهر  جداگانه  را  صورت 

بدون   دی کن  ش یرایرا و  ه یاست تنها همان لا  یکاف   د،ی ده  ریی را تغ  نهی زم رنگ پس   دی نمونه، اگر بخواه   ی. برادیی نما  ش یرایو

 .شودوارد  یب یها آس بخش  ریآنکه به سا

 .د ی اعمال کرد، بدون آنکه لازم باشد از ابتدا شروع کن   ی راحت به   توان ی را م   یر یی هر تغ  را ی است ز   ی کاربرد  ار ی بس  ی ژگ ی و   ن ی ا 

 تاریخچه فتوشاپ 

نام آن   ۱۹88سال  در  .شد  یطراح  Display توسط جان وارنک و توماس ونوتر با نام ۱۹87در سال  بارن یفتوشاپ نخست

 Photoshop یعن یآن    یرسم   ی نسخه  ن ینخست   .شد  یدار یخر Adobe و توسط شرکت  افت ی  ریی تغ  Photoshop به

  ر،یتصو  ش یرایمانند و یشده بود و امکانات  یطراح  Macintosh عاملستمی س  یمنتشر شد که فقط برا ۱۹۹0در سال  ۱.0

تنظ   ریی تغ و  م  م ی اندازه  ارائه  را  به  از  .داد یرنگ  فتوشاپ  زمان،  ابزارها  جیتدرآن  افزودن  از    یک یبه    د،یجد  یبا 

محبوب  ن یقدرتمندتر امکانات  لیتبد  ریتصو  ش یرایو  یافزارهانرم  ن یترو  لا  یشد.  انتخاب    یابزارها  لترها،یف   ها،هی مانند 

تنظ   شرفتهی پ نسخه  می و  در  گرد  یبعد  یهارنگ  نسخه  امروزه  .دیاضافه  به    Creative Cloud (CC)  یها فتوشاپ 

م  دهی رس امکان  کاربران  به  که  آنلا به  دهدیاست  آخر  ن ی صورت  دسترسنسخه  ن یبه  ابزارها  ی ها  از  و  باشند    ی داشته 

 مند شوند. بهره یابر ی و فضا یهمچون هوش مصنوع   یاشرفتهی پ

 : کی و گراف ی طراح یا ی مهم فتوشاپ در دن یکاربردها 

 حذف عناصر ناخواسته.  ایو کنتراست،   ییروشنا ریی اصلاح رنگ، تغ :هاویرایش عکس .1

گرافیکی .2 برا  :طراحی  و  یطراح  یمناسب  کارت  پوستر،  بنر،  سا  تیزیلوگو،  و    یغاتی تبل  یازهای ن  ریو 

 از صفر. تالی ج ید ی نقاش ای ریتصو  کی یامکان طراح  :ساخت آثار هنری دیجیتال. نگیبرند

شبکه .3 و  وب  اجتماعیمحتوای  برا  ریتصاو  جاد یا :های  پست  ها تی ساوب  یجذاب    ی هاشبکه  یهاو 

 . سبوکی و ف نستاگرامیمانند ا یاجتماع 

 آثار خلاقانه.  ا یمانند کلاژ  دیجد  ریخلق تصاو یچند عکس برا ب یامکان ترک :ترکیب تصاویر .4

 پرتره.    ی ها رنگ پوست در عکس   ر یی تغ   ی حت   ا ی و چروک    ن ی حذف جوش، چ   ی برا  : روَتوش و اصلاح صورت   . 5

هر نوع    ایکرده    ش یرایو  یاصورت حرفهرا به  ریکه هر تصو  آوردیامکان را فراهم م  ن یدر مجموع، فتوشاپ ا

 . دیی نما ی سازادهی را پ  یک ی گراف  یطراح

 
1 Layers 
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 .CS3 ،CS5 ،CS6 مثل  دتر هستن ها قدیمیاین نسخه •

 . ماندندیم یباق  ستمی س  یرو یصورت دائم. بهدیکردیو نصب م یداریخر بارکی دیبودند که با ییافزارهانرم  •

 . شدندیمحسوب م یکاربرد اریتر بود، اما در زمان خود بسساده یامروز یها ها نسبت به نسخهامکانات آن •

  :CC (Creative Cloud) فتوشاپ

 .... وCC 2019 ،CC 2021 ،CC 2024 ،CC2025 مثل های جدیدتر فتوشاپنسخه •

 .داستفاده کنی  آن از دنی اتا بتو دباید اشتراک ماهانه یا سالانه بخری •

، ابزارهای اتوماتیک، فیلترهای جدید و  (AI) تری مثل هوش مصنوعیو ابزارهای پیشرفته  هستندروز  همیشه به •

 .رددا  (Cloud) طراحی ابری

 .شوندها همزمان روی فضای ابری ذخیره و پروژه دحساب استفاده کنی  کاز ی  دنی اتوروی چندتا دستگاه می •

 ی کنیم! بندجمع  کی

CS ی دو تا همیشه داشت  دخریدیکه می ی قدیمیمثل یه برنامه 

CC د دار ای حرفهو کلی ابزار   شود، آپدیت میدکن که آنلاین کار می  است ی مدرننسخه 

 .است بهتر CCقطعاً ، دیا با ابزارهای جدید سروکار داشته باشی  دای کار کنی حرفه هیدبخوا راگ

برا  یوقت  را  م  بارن ینخست  یفتوشاپ  کم  د،یی نمایاجرا  اول  نگاه  در  است  پ  یممکن  و  با    دهی چ ی شلوغ  اما  برسد،  نظر  به 

 تر خواهد شد. آسان ار ی هر بخش، استفاده از آن بس  یفهی شناخت وظ 

 

                                        
 

 

 آشنایی با محیط فتوشاپ 

 بخش اول

 :های اصلی محیط فتوشاپبخش

چپ .  1 سمت  ابزار   (Tools Panel)   نوار 

ابزارها   ن ی ا  شامل  از   ی کاربرد   ی بخش  استفاده  با  است که 

مآن  نما   ی موارد  د ی توانی ها  انتخاب  ده   د، یی را   د،ی برش 

 گر یاقدامات د  ی اری و بس د یی متن وارد نما  د، ی کن  یز ی آم رنگ 

 !ی نقاش  ی ابزار برا جعبه  ک یدرست مانند    د؛ی انجام ده

  

 ۲تصویر                                                                                   
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بالا .  ۲  (Options Bar)   نوار 

نوار در   ن یا   د، یی نما ی ابزار را انتخاب م   ک ی که    ی زمان 

گز  تنظ   ها نه یبالا،  را   مات ی و  ابزار  همان  به  مربوط 

 .دهد ی م  ش ی نما 

 نوع براش  ای قلم    ز ی مثال، سا   ی برا 
 

 3تصویر  

پایین ســمت   – (Layers Panel) ها پنل لایه .  ۳

 راست 

 ــر ا د  ــش، لا   ن ی  ــبخ  ــ  ی ها ه ی ــاهده    ی طراح ــود را مش خ

  د، ی ــکن ی م   جــاد ی ا   ی کــه در طراح ــ  ی . هر عنصر د ی کن ی م 

  د ی ــتوان ی م  . رد ی ــگ ی جداگانــه قــرار م   ی ه ی ــلا   ک ی ــ  ی رو 

 . د یی حذف نما  ا ی  د یی نما   ی مخف   د، ی جا کن ها را جابه آن 

 

 4تصویر  

1رنگ   پنل .  ۴
  

رنگ   ر یی . امکان تغد یی رنگ انتخاب نما   دی توان ی قسمت م   ن یا   از 

 فراهم است.  جا ن ی از هم ز ی مو ن رنگ قلم  ا ی  نه ی زمپس 

 

 

 5تصویر  

۲پنل تاریخچه .  ۵
  

 !د ی نما ی زمان در فتوشاپ عمل م   ن ی ماش   ک ی همانند    خچه ی پنل تار 
م  یاقدام  هر انجام  پروژه  در  ترس   دی ده یکه    م، ی )مثلًا 

تغپاک به  ریی کردن،  ا  کیصورت  رنگ(،  در  پنل    ن ی مرحله 
 .شودیثبت م

است به   ی کاف  د، ی ندار  ت ی و از آن رضا  د ی ا انجام داده  ی کار  چنانچه 
نما   Historyپنل   بازگرد   د یی مراجعه  عقب  به  مرحله  چند    د؛ ی و 

 . " بازگشت به عقب "   ی دکمه   ی مانند فشردن چندباره 
 

 

 

 6تصویر  

 

 
1 Color Panel 
2 History Panel 
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 :نکته مهم 

 شما(.  ماتی مرحله، بسته به تنظ ۲0مثال،  ی)برا  داردیاز مراحل را در حافظه نگه م یفتوشاپ فقط تعداد مشخص •

 .ودش پاک می ، تاریخچهدو دوباره باز کنی  دفایل رو ببندی راگ •

 ۱ها  پنل ویژگی. ۱

تنظ   ن یا • هوشمندانه  عنصر  ماتی پنل،  به  که    یمربوط 

 مثال:  ی. برادهدیم ش ی را نما دیاانتخاب کرده

ی • می  متن   کوقتی  گزینهدکنیانتخاب  پنل  این  هایی  ، 

ن  انش  امثل اندازه فونت، رنگ نوشته و فاصله حروف ر

 .ددهمی

باشی  ۲شکل یا    ماسک  کی  راگ • کرده  ،  دانتخاب 

 .دهدیم  ش یرا نما  آن تنظیمات مربوط به

از    دی توانیم،  دانتخاب شده باش ۳ی تنظیمیلایه  راگ •

سا  ،ییروشنا  جان یهم و  رنگ    ها یژگیو  ریکنتراست، 

      .دی ده ریی را تغ 

 

 7تصویر

 ! گیرینتیجه

و وسط هم بوم    مات،ی بالا تنظ  ها،هیچپ ابزارها، سمت راست لا  سمت:است  تالیج ید  یکارگاه طراح   کیفتوشاپ مانند  

شد و کار با آن    دی با آن آشنا خواه  ج یتدرنظر برسد، اما بهبه  دهی چ ی پ  ی شما قرار دارد. در ابتدا ممکن است کم  ی طراح

 بخش خواهد بود.آسان و لذت اری بس

 

 

 

 

 

 

 

 

 8تصویر

 
1 Properties Panel 
2 Shape 
3 Adjustment Layer 
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 !بزن بریم!هاکار با تصاویر و فایل

 ؟ گونه استچ ۱باز کردن فایل آماده

 

 File > Openاز منوی بالا   . 1

فتوشاپی  . 2 یا  عکس  و  (PSD  ،JPG  ،PNG)  فایل 

 .د رو انتخاب کن  د که قبلًا ذخیره کردی ... 

را   فتوشاپ . 3 می آن  می   د کن باز  کنی   دنی ا تو و  به   د شروع 

 .ویرایش 

 

 

 ۹تصویر  

  نکات مهم

 .د ها و تنظیمات قبلی حفظ شدن ی لایه ، همه دکنی باز می  PSD اگه فایل •

 آن را باز کنید.سریع    د نی ا تو عکس به داخل فتوشاپ هم می   کبا کشیدن ی  •

 ! گونه استچ  ایجاد فایل جدید در فتوشاپ

 

 
 

 ۱0تصویر

 
1 Open File 
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 :، از منوی بالادفایل جدید بسازی کی  هیدخوافتوشاپ می در وقتی 

File > New   یا کلید میانبرCtrl + N 

می   ک ی  باز  اسم    ود ش پنجره  آن که   New Documentبه  دونه   در  ر دونه همه بخش کلی گزینه هست. حالا  باهم   ا ها 

 :کنیم بررسی می 

 (Presets) هاتنظیمپیش :قسمت بالای پنجره  .

 :ی آماده برای کارهای مختلف هست. مثلاً سری گزینهک اینجا ی

• Recent   دهایی که قبلًا ساختی فایل 

• Saved   دهایی که خودت ذخیره کردی تنظیم پیش 

• Photo   سایزهای استاندارد برای عکس 

• Print   مخصوص چاپ، با کیفیت بالا 

• Art & Illustration  مناسب طراحی و نقاشی دیجیتال 

• Web  مناسب طراحی سایت 

• Mobile  سایزهای مخصوص گوشی 

• Film & Video  برای طراحی ویدئو یا یوتیوب و غیره 

 .شودنمایش داده مین ا، بقیه تنظیمات خودش دانتخاب کنی  ا گزینه ر کی است  فقط کافی
 

 
 ۱۱تصویر
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 مشخصات فایل جدید :قسمت وسط . ۲

 ( "کاور اینستا" یا  "طراحی لوگو "واسه فایل جدید بذار )مثلًا   ۱اسم  کی

 :است . واحد هم قابل انتخاب۲عرض و ارتفاع فایل  

 دیجیتال طراحی برای مناسب – 3پیکسل  •

 چاپ  برای – 4اینچ  •

 5متر سانتی •

 6مترمیلی •

  8افقی یا عمودی بودن فایل  7حالت 

 ۹رزولوشن

 

 :کیفیت تصویر 

 برای کارهای دیجیتال  7۲ •

 برای چاپ  300 •

 

 

 ۱۲تصویر 

 10مدرنگ 

 :هایی که قراره استفاده بشن نوع رنگ

 ۱۱برای کارهای دیجیتال )وب، موبایل، اینستا(  •

  ۱۲برای چاپ )مثل کارت ویزیت یا پوستر( •

 ۱3سفید سیاه •

 .باشه، برای بیشتر کارها کافیه ۱4بیت  8معمولاً روی  •

 
1 Name 
2 Width / Height 
3 Pixels 
4 Inches 
5 Centimeters 
6 Millimeters 
7 Orientation 
8 Landscape یا Portrait 
9 Resolution 
10 Color Mode 
11 RGB 
12 CMYK 
13 Grayscale 
14 Bit Depth 
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 1زمینه رنگ پس

 ۲سفید  •

 3مشکی  •

 که توی نوار ابزار انتخاب کردی 4رنگی  •

 استیکر  و لوگو طراحی مخصوص – 5شفاف  •

 

 

 ۱3 تصویر  

 
 ۶تنظیمات پیشرفته . ۳     

 :معمولاً این قسمت نیازی به دستکاری نداره، ولی اگه خواستی بدونی

Color Profile  تنظیمات رنگ دقیق برای چاپگرها یا مانیتورها 

Pixel Aspect Ratio   روی  نسبت پیکسل( هاSquare Pixels    د سازی مگر اینکه فیلم می   د ن ا بم   ید بذار ) 

 

 :های پایین دکمه

 7ساختن فایل جدید •

 8بستن پنجره •

 : Save در زمان  دبعداً ذخیره کنی دنیاتوهایی که میفرمت 

 :دهای مختلف ذخیره کنی فرمت اب دده ، فتوشاپ اجازه میبرای ذخیره شما به پایان رسید وقتی کار

 فرمت توضیح عامیانه 

 PSD ها، مخصوص ویرایش بعدی ی لایهفایل فتوشاپ با همه

 JPEG / JPG های معمولی، سبک، بدون لایهبرای عکس 

 PNG زمینه شفاف کیفیت خوب + پشتیبانی از پس 

 PDF برای چاپ یا ارسال رسمی، مثل کاتالوگ 

 TIFF برای چاپ با کیفیت خیلی بالا 

 GIF مخصوص تصاویر متحرک ساده 

 
1 Background Contents 
2 White 
3 Black 
4 Background Color 
5 Transparent 
6 Advanced Options 
7 Create 
8 Close 
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 فتوشاپ   درها ذخیره کردن فایل

 و فرمت مختلف در دسترس شما قرار دارد: نهیچند گز د،یی نما رهی را در فتوشاپ ذخ  تان یهالیفا دی خواهیم یوقت 

PSD 
  ر یو اطلاعات تصو  ها هیلا  یفرمت، تمام  ن ی. با ادینمایانتخاب م  فرض ش ی صورت پ است که فتوشاپ به  ی همان فرمت   ن یا

فرمت تنها    نی. البته ادیی نما  ش یرایو  ی راحت آن را به  دی توانیم  د، ی و بعداً هر زمان که بخواه  شودیم  رهی صورت کامل ذخ به

 افزار فتوشاپ قابل باز شدن است. با نرم 

 PNG و JPEG های معروف مثلفرمت

  ی تمام  یرو  باًیها تقرفرمت  ن ی . ادیی نما  رهی ذخ  زی ن  PNG  ای  JPEG  ری نظ  یج یرا  یهاخود را با فرمت  ی هالیفا  دی توانیم

نما  هایو گوش   هاستمی س م  ش یقابل  و  بهآن  توانیهستند  را  د  یراحتها  داشته    گرانیبا  توجه  فقط  گذاشت.  اشتراک  به 

ا  دی باش کار دشوارتر    ن یمجدد، ا  ش یرایبه و  ازی و در صورت ن  کنند یحفظ نم  را  هاهی، لاPSDها برخلاف  فرمت  ن یکه 

 خواهد بود.

Save for Web 

ابزار باعث    ن ی . ادی استفاده کن   نهیگز  ن یاز ا  د،یی نما  رهی وبلاگ ذخ  ای  تیاستفاده در سا  یخود را برا  ریتصو  دیگر قصد دارا

 شود.   یبارگذار ترعیتر گردد و در وب سرسبک ریتصو  شودیم

 Save As استفاده از

  ره ی ذخ  یگریهر فرمت د  ای PSDخود را با فرمت  ل یفا دی خواهیاگر م

 : دی را دنبال کن  ریاست مراحل ز یکاف د،یی نما

 .درو بزن File > Save Asاز منوی بالا،  .1

می  کی .2 باز  میودشپنجره  که  جایی  و  فایل  اسم    هیدخوا، 

 .یدانتخاب کن ا ر شودذخیره 

قسمت .3 را  Save As Type از  خود  نظر  مورد  فرمت   ،

 . دیی نما کی کل Saveدکمه  ی رو انیانتخاب کرده و در پا

  
 

 ۱4تصویر  
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 تغییر سایز و مقیاس تصاویر 

تر خود را کوچک   ی از طراح  ی بخش دی خواه ی م ای کوچک است،   ا یبزرگ  اری که بس  دی دار   اری در اخت  یر ی تصو  دیی فرض نما 

 وجود دارد:  ی . دو روش اصلد ی ده  ر یی را تغ ه یلا   ک ی   ا ی  ر ی تصو  ی اندازه   یراحت به   د ی توانی . در فتوشاپ مد یی تر نما بزرگ   ا ی 

 (Image Size) تغییر اندازه کل تصویر .1

 :دیی تر نماکوچک  ایتر را بزرگ  یریتصو لی کل فا دی که بخواه یدر صورت 

 چطوری؟

 
 

 ۱5تصویر

 

 :برو از منوی بالا روی .1

Image > Image Size 

 :نوشته که  شودپنجره باز می کی .2

 

 

 
 

 

 

 ۱6تصویر             
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o ۲ارتفاعو  1عرض 

 .دهیدمتر، اینچ و... تغییر ببه پیکسل، سانتی ااندازه ر دنی اتومی                         

o (300یا  7۲)مثلًا  3کیفیت عکس 

 

 ۱7ریتصو

o   تیکConstrain Proportions   ن یکی هم  آ،  د، وقتی یکی از ابعادو عوض کنی زنیدب  راگ  ار

 نشود.تا عکس کشیده  شدهخودش هماهنگ  

  :نکته 

 .دی قرار ده  300 یرزولوشن را رو د،ی ده  ریی را تغ ریچاپ، اندازه تصو یبرا دی اگر بخواه  •

 .است  کافی 7۲برای کار دیجیتال،  •

 (Transform)  ی یک لایهتغییر مقیاس یا اندازه  .۲

 : دیی روش استفاده نما  ن یاز ا د،یی کوچک نما ایشکل خاص را بزرگ  ای ریمتن، تصو ه،یلا کی دیاگر تنها قصد دار

 چطوری؟

 .دانتخاب کن  ا لایه مورد نظر ر •

 :یدبزن اهای میانبر ر دکمه •

Ctrl + T یا از منوی بالا: 

 Edit > Free Transform  

 :دنی اتوحالا می •

o هیدتغییر بد  اها، سایز ربا کشیدن گوشه. 

o  داشتن  با نگهShift ( ود )تا کشیده یا فشرده نش   شود ، نسبت اندازه حفظ می. 

o 5سازی ، وارونه4هایی مثل چرخشبا کلیک راست روی عکس، گزینه  ،
                                                        .و غیره هم هست 6کج کردن 

 .شود  تا تأیید یدبزن  Enterوقتی تموم شد،  •

 

 ۱8تصویر  

 
1 Width 
2 Height 
3 Resolution 
4 Rotate 
5 Flip 
6 Skew 
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  :نکات مهم

 شود(.  یکسلی پ ری)تصو ابدیآن کاهش   تی فی ممکن است ک  د،یی بزرگ نما ازحدش یرا ب یریاگر تصو •

 استفاده نمود.   توانیبالا را در صورت کوچک شدن، بدون مشکل م تیف یبا ک ییهالیفا •

 . دیی نما هیخود ته ریاز تصو بان ی نسخه پشت کیاندازه،  ریی از تغ  ش یپ شودیم هیهمواره توص •

 نوع تغییر روش توضیح 

 تغییر سایز کل تصویر  Image > Image Size برای تنظیم سایز کل پروژه یا تصویر

برای کوچیک و بزرگ کردن بخش  

 خاصی از طراحی 
Ctrl + T (Free Transform)  تغییر سایز یک لایه 

 

 DPI و (Resolution) تنظیمات وضوح تصویر

  تر ، تصویر باکیفیتدتصویر هست. هر چی وضوح بیشتر باش  دریعنی چقدر جزئیات   ۱وضوح تصویر یا همون رزولوشن

 ود. ش. اما حجم فایل هم بیشتر میاست

 ؟ چیست رزولوشن 

 :ویندگهایی که توی هر اینچ از تصویر جا شدن. بهش میرزولوشن یعنی تعداد پیکسل

DPI = Dots Per Inch = نقطه در هر اینچ 

 :دنویسنیا توی فتوشاپ معمولاً می

Resolution: 72 / 150 / 300 Pixels/Inch 

 :های اصلی تفاوت

  وضوح توضیح ساده کاربرد 

نمایشوب، اینستاگرام، صفحه  DPI ۷۲ سبک، سریع، ولی برای چاپ مناسب نیست  

ایولی نه خیلی حرفه شودمیچاپ  طراحی معمولی با کیفیت قابل قبول  1۵0 DPI 

ای )پوستر، کارت ویزیت(چاپ حرفه  DPI ۳00 کیفیت بالا، حجم بیشتر، مناسب چاپ  

 ؟دهیمچطور رزولوشن رو تغییر 

 :دسازیوقتی فایل جدید می .1

 File > Newبرو به  .1

 .یدوارد کن ار عدد دلخواه  رزولوشن قسمت در  .2

 برای طراحی دیجیتال  7۲برای چاپ،  300مثلًا: 

 

 ۱۹تصویر

 
1 Resolution 
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 :تغییر رزولوشن بعد از ساختن فایل  .۲

 Image > Image Size  برو به .1

پنجره .2 میدر  باز  که  عددشودای   ، 

 .دهیدتغییر   ار رزولوشن 

کن   هید خوا نمی   ر اگ  تغییر  عکس  ، د ابعاد 

 .ید بردار   ار    Resampleتیک

می  اگه  تغییر   هید خواولی  کیفیت  هم  و  ابعاد  هم 

      ید. بذار   ار    Resample، تیک د کن 

 

 ۲0تصویر  

  : نکته مهم 

 !ودش به تنهایی باعث بهتر شدن کیفیت عکس نمی DPI افزایش  •

 .داز خودش بساز ار دجزئیاتی که وجود ندارن اندتوچون فتوشاپ نمی

 .است منطقی DPI ، بالا بردندفقط موقعی که عکس با کیفیت بالا داری •

 اصطلاح معنی ساده

 Resolution وضوح یا کیفیت تصویر بر اساس پیکسل تو هر اینچ 

 DPI مخصوص چاپ  Resolution واحدی برای نشون دادن

 DPI ۷۲ مناسب کارهای دیجیتال و آنلاین

ای و با کیفیت بالا مناسب چاپ حرفه  ۳00 DPI 

 

 

 تمرین:

 از لپ تاپ بگیر   screenshot  ک ی 

 Image Size   از طریق   300dpiرزولوشن رو ببر روی  

 PSD  و   JPEGبا دو فرمت   یدداخل فتوشاپ ذخیره کن   آن را

 

 

 



 

82 
 

 انتخاب های ابزار  -۲ درس

  1ابزارهای انتخاب 
بگ اینکه  برای  ابزار  مدل  چند  می"  وییدفتوشاپ  عکس  از  تیکه  این  که  دارد  "همخوافقط  ابزارهایی  قسمت.  این    در 

 :هیمدتوضیح می

• Marquee Tool 
• Lasso Tool 
• Magic Wand Tool 
• Quick Selection Tool 

1. Marquee Tool 

 (M :کلید میانبر)

  .دای( بکشی انتخاب ساده و مربعی )یا دایره ک ی دنی اتوباهاش می

 :انواعش

• Rectangular Marquee Tool   :  یا مربعی  انتخاب 

 مستطیلی 

• Elliptical Marquee Tool  :ای یا بیضی انتخاب دایره 

• Single Row / Single Column   :  خیلی خط  یه 

 به ضخامت یک پیکسل  ارتفاعکل باریک از کل عرض یا 

 :کاربرد

 .برای بریدن یا انتخاب یه قسمت ساده و صاف از عکس، خیلی خوبه 
 

 ۲۱تصویر

۲. Lasso Tool 

 (L :کلید میانبر) 

  !دکشی می دانتخاب کنی  هیدخوامداد که دور چیزی که می کمثل یید تصور کن  

 :انواعش

• Lasso Tool: دکشی آزادانه با دست دور چیزی می 

• Polygonal Lasso Tool:   انتخاب یه  کردن  کلیک  کلیک  با 
 دسازیچندضلعی می

• Magnetic Lasso Tool: لبه دور  به  میخودش  تصویر    دچسب های 
 مثل آهنربا! 

 :کاربرد

 .موقعی که انتخابت شکل خاصی داره یا خیلی دقیق نیست، عالیه
 

 ۲۱تصویر 

 
1 Selection Tools 
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 ۳- Magic Wand Tool 

 W :کلید میانبر
ی روی  ابزار  این  می  کبا  کلیک  عکس  از  همهدکنی نقطه  فتوشاپ  و  ی  ، 

  .دکن خودش انتخاب می ار دهایی که رنگ مشابه دارن قسمت

 تنظیم  
 :مهم

Tolerance  رنگ چقدر  )مثلًا  یعنی  بگیره  نظر  در  رو  مشابه  یعنی    30های 
 های خیلی نزدیک به هم( رنگ

 :کاربرد

ی موقعی که پس  با  یا سفید(،  آبی  )مثلًا  یه رنگ خاص  انتخاب    کزمینه  کلیک 
  !ودشمی

 ۲۲تصویر  

۴- Quick Selection Tool 

 W ، با کلیدMagic Wand خانوادههم

های  ، بخش د، و هر چی بیشتر بکشی دکشی مو روی عکس میبا این ابزار مثل قلم

  .وندش انتخاب می دقسمت هستن آنبیشتری که شبیه 

 :کاربرد

برای انتخاب سریع چیزهایی مثل آدم، حیوان، لباس و... که مرز مشخص دارن،  

 .هددخیلی خوب جواب می

 

 

 ۲3تصویر  

  :نکات مهم

می بعد   • انتخاب  کنی (Ctrl+X) دببری   را  بخش   آن  د نی ا تو از  کپی   د، 

(Ctrl+C) یا فیلتر بزنی   دد ، رنگ کنی. 

 Select > Modifyی  ، از گزینه دتر کنی دقیق   را  انتخاب  داگه خواستی  •

  .ید استفاده کن    Select and Maskیا  

انتخاب،   Shiftی  دکمه  • به  کردن  اضافه   برای 

Alt    یا Option)   درMac OS )   برای کم کردن از انتخاب استفاده

 .ود شمی 

 

 

 ۲4تصویر                       
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 ابزار  توضیح ساده کاربرد 

 Marquee ایانتخاب مربعی/دایره انتخاب ساده و سریع 

 Lasso کنی دور چیزی با دست انتخاب می انتخاب آزاد و دستی 

 Magic Wand شنهای مشابه انتخاب میبا یه کلیک، رنگ های ساده زمینهپس 

انتخاب دقیق چیزای مشخص مثل 

 هاآدم
 Quick Selection کنه کشه و انتخاب میمو، سریع میمثل قلم

 
 

  نکته مهم: 

 بسته بود Toolsهر وقت قسمت 

  .یداز طریق زیر باز کن  دادرا نشان نمیوابزارها  

 

 

 ۲5تصویر  

 

 زمینه جدیدها و چسباندن روی پس بریدن میوهتمرین: 

 :ابزارها

• Rectangular Marquee Tool 

• Elliptical Marquee Tool 

• Lasso Tool 

• Polygonal Lasso Tool 

• Magnetic Lasso Tool 

• Quick Selection Tool 

• Magic Wand Tool 

• Move Tool 
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 ابزار براش  -۳ درس

 و تنظیمات آن  1ابزار براش 
میانبر یB کلید  نقاشی کنی   آن  با  دنی اتوکه می  اندممو میقلم  کبراش مثل  بزنی دروی تصویر  بزارید، رنگ  یا افکت  .  د، 

 .دتنظیم کنی  امو، اندازه، نرمی، میزان فشار و کلی چیز دیگه رنوع قلم دنی اتومی

 

 Brush Tool های اصلی تنظیماتبخش
ابزار بالا   ک، یدکنی انتخاب می  ار براش وقتی   (Options Bar) نوار 

 :پردازیمها میبه بررسی آن. دکه کلی تنظیم دار  ودش ظاهر می

 

 

 ۲6تصویر 

                                                                                                      

 

 ۲7تصویر

 

 (Brush Preset Picker) انتخاب نوع براش -1

 .شودها باز ی انتخاب براشتا پنجره یداز بالا سمت چپ، روی دایره براش کلیک کن

 : انیدتواینجا می

 دمشخص کنی  ابراش ر ۲اندازه •

 دهید تغییر  ار 3نرمی یا سختی  •

 د های آماده انتخاب کنی از بین براش •

 د های جدید دانلود یا وارد کنی براش •

 :مثلًا

 های محو براش نرم = لبه •

 های تیز براش سخت = لبه •

 
1 Brush Tool 
2 Size 
3 Hardness 
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۲- Size  و  Hardness 

 قلم  ۱اندازه •

 یعنی لبه تیز(  ۱00٪ –یعنی لبه محو   0٪) ۲ها سختی لبه •

۳-Opacity و Flow 

 شفاف(یعنی رنگ نیمه 50٪)مثلًا  3شفافیت کلی قلم  •

 )نرمی حرکت(  4میزان جریان رنگ موقع کشیدن  •

 :تفاوت

 5مثل شفافیت کل رنگ •

 6  ودشحرکت و نقاشی پیوسته دیده می  درتأثیر بیشتر  •

۴- Pen Pressure  (تبلت گرافیکی داری راگ ) 

 .دکه فشار دست روی اندازه یا شفافیت تأثیر بذار دتنظیم کنی  دنی اتو، میدکنی با قلم نوری کار می راگ

 

۵-Brush Settings Panel (ایتنظیمات حرفه ) 

 :از منوی بالا برو به

Window > Brush Settings 

 :تونیتوی این پنل می

  7پخش تصادفی براش  •

 زاویه و چرخش براش  •

 تغییر سایز خودکار با فشار قلم  •

 ...خطی وایجاد الگوهای خاص مثل برگ، دود، خط •

  !ستالعادههای خاص فوقاین بخش برای طراحی دیجیتال و افکت

 ۲8تصویر  

 

 
1 Size 
2 Hardness 
3 Opacity 
4 Flow 
5 Opacity 
6 Flow 
7 Scattering 
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 اضافه کردن براش جدید -۶

 . یدکن  کلیک روی آیکون   Brush Preset از بخش  .1

 .یدبزن ار    Import Brushesگزینه  .2

 .یدوارد کن ا ر abr.فایل براش با فرمت  .3

 ...اینترنت کلی براش آماده رایگان هست مثل: قلم مو برای دود، باران، مو، آبرنگ و در

 

 
 

 ۲۹تصویر          

 

  – (Eraser Tool) کن ابزار پاک

 
 

 30تصویر        

1. Eraser Tool ) کن عادیپاک ) 

 .دکن ، ولی به جای کشیدن رنگ، تصویر رو پاک میدکن مثل براش عمل می ▪

  3و شدت  ۲، شفافیت ۱قابل تنظیم با سایز، نرم ▪

 
1 Hardness 
2 Opacity 
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۲. Background Eraser Tool ) زمینهکن پسپاک ) 

 های رنگی یا یکنواخت زمینهمخصوص حذف پس  ▪

 دکنو پاک می دکن با حرکت موس، رنگ زیرش رو شناسایی می ▪

 

۳. Magic Eraser Tool ) کن جادوییپاک ) 

 دکن رنگ رو حذف میبا یه کلیک، تمام نواحی هم ▪

 رنگ(های ساده )مثل سفید یا تکزمینهمناسب برای حذف سریع پس  ▪

  :نکته مهم 

 .شودبه لایه معمولی تبدیل  Background برای پاک کردن واقعی )شفاف شدن(، باید لایه

 (Text Tool) ابزار متنی

 
 3۱تصویر

 

 : T کلید میانبر

. مثلًا نوشتن عنوان، اسم، آدرس سایت،  د، هر متنی که خواستی بنویسی روی عکس یا فایل طراحی  دنی اتوبا این ابزار می

 ...کپشن و

 :دو نوع نوشتن داریم

1. Point Text ) ایمتن نقطه ) 

 د کنی و شروع به نوشتن می دکنی کلیک می

 های کوتاه )مثل تیتر یا عنوان( مناسب برای متن  ▪

۲. Paragraph Text )متن پاراگرافی) 

 د نویسی سازی( و بعد میکادر می ک)ی دکنی کلیک و درَگ می

 های طولانی و چند خطی مناسب برای متن  ▪

 
 

 3۲تصویر

 

 
3 Flow 
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  ۱تنظیمات مهم در نوار بالا 

 انتخاب نوع قلم  ۲فونت •

 اندازه متن  ۳سایز •

 رنگ نوشته   4رنگ •

 5حالت ضخیم یا مورب  •

 چینچین، وسط، راست6چینچپ •

 دار( )مثلًا خمیده یا موج 7افکت دادن به متن •

 
 33تصویر 

  :ترایتنظیمات حرفه

 Character پنل

 Window > Character :از مسیر

 :روی دتری داشته باشی کنترل کامل  دنی اتومی

  8فاصله بین حروف  •

  ۹فاصله بین خطوط •

 ۱0کشیدگی عرض یا ارتفاع حروف •

 ۱۱بالا یا پایین بودن متن نسبت به خط اصلی  •

 Paragraph پنل 

 Window > Paragraph :از مسیر

 :مخصوص تنظیمات پاراگرافی مثل

 ها فاصله بین پاراگراف •

 تنظیم چینش خطوط  •

 (Indent) تورفتگی •
 

 34تصویر  

 
1 Options Bar 
2 Font 
3 Size 
4 Color 
5 Bold / Italic 
6 Alignment 
7 Warp Text 
8 Tracking 
9 Leading 
10 Scale 
11 Baseline 



 

90 
 

  :هانکته

 ود ش ساخته می ی جدالایههر متن روی یه   •

 یدروی متن کلیک کن Text برای ویرایش متن، با ابزار •

خواستی  • در  را متن    د اگه  ثابت  شکل  )قابل    دریو بیا  به 

 ( دویرایش نباش

 > Rasterize Type کنید. کلیکراست  متن  روی لایه 

 

 35تصویر 

 (Pen Tool) ابزار قلم

 P :کلید میانبر

یا    ددقیق دوربری کنی   اچیزی ر  کی  هید. مخصوصاً وقتی بخوادمتری بکشی هایی با دقت میلیخط و شکل  دنی اتوبا قلم می
 .دمسیر صاف و خمیده بسازی کی

  :Pen Tool کاربردهای اصلی

 ( مثل مدل، محصول یا هر جسمی)ها برش دقیق دور سوژه .1

 های خاص و منحنیطراحی شکل .2

 عنوان خط راهنما یا متن روی مسیر ایجاد مسیر برای استفاده به .3

 ای از یه بخش خاص ساخت ماسک یا انتخاب حرفه .4
 

 36تصویر  

 :نحوه استفاده ساده

 :کشیدن خط صاف

 ذاری می نقطه یه  ،کلیک  •

 نقطه  دو این  بین  صاف خط ، یه جای دیگه کلیک  •

 :کشیدن خط خمیده 

 د سازمی منحنی خط ،وندش می ظاهر کنترلی هایدسته ،(یدکلیک + درگ )موس رو بکش •

 :بستن مسیر

 ب انتخا  یا شکل یک به  تبدیل  و ودشمی بسته مسیر ،یدی اول کلیک کنروی نقطه •
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 :تنظیمات و ابزارهای وابسته

 ابزار توضیح ساده 

 Pen Tool کشیدن مسیر جدید

 Freeform Pen Tool کشیدن مسیر آزاد با دست )مثل مداد( 

 Add Anchor Point Tool اضافه کردن نقطه وسط مسیر 

های مسیر حذف یکی از نقطه  Delete Anchor Point Tool 

 Convert Point Tool تبدیل نقطه صاف به منحنی یا برعکس
 

 : نکات مهم

با • که  می   Pathsپنل    در  دکشی می Pen مسیرهایی   < Windowاز    وندشذخیره 

Paths 

 د تبدیل کنی  ۲کیا ماس ۱به انتخاب  امسیر ر  آن دنی اتومی •

  3یدیا خط دورش بزار درنگ کنی   ار آن داخل دنی اتو، میشود  وقتی مسیر بسته •

   Pen Tool  با (Fill / Stroke) رنگ کردن داخل مسیر یا گذاشتن خط دور

 :دنی اتو)یعنی نقطه آخر رو به نقطه اول وصل کردی(، حالا می دیه مسیر رو کشیدی Pen Toolوقتی با 

  ۴رنگ کردن داخل مسیر .1

 .کنه که داخل اون شکلی که ساختی، یک رنگ پر بشه کاری می

 چطور؟

  :از منوی بالا برو به .1

Layer > New Fill Layer > Solid 

Color 

 یدبزن OK و یداسم انتخاب کن  کی .2

ر .3 دلخواه  کن   ا رنگ    صورت به  مسیر  ، یدانتخاب 

 میاد  در رنگی لایه کی

 :یا

 

 37تصویر  

 

 
1 Selection 
2 Mask 
3 Stroke / Fill 
4 Fill 
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 :هست   Pathsاگه مسیرت فعلًا توی پنل 

 روی مسیر  یدکلیک کن راست Paths داخل پنل •

 ید رو بزن Fill Pathگزینه  •

 ید.رنگ مورد نظر رو انتخاب کن •

 

 38تصویر  

  1کشیدن خط دور مسیر .۲

 .اندم، ولی وسطش خالی میدکشییعنی فقط دور مسیر خط می

 چطور؟

 یدکلیک کنروی مسیر راست Pathsداخل پنل   .1

 یدرو بزن Stroke Pathگزینه  .2

 ید انتخاب کن  ایکی ر Pencil یا Brush از لیست ابزار مثل .3

4. OK   ود شمی دکشی خط  انتخابی، ابزار تنظیمات همون  با مسیر →بزن 

 .دکشمثلًا اگه براشت قرمز و ضخیمه، خط قرمز دور شکل می

 :Stroke و Fill تفاوت

کنه؟کار میچی  گزینه  

کنه داخل شکل رو رنگ می  Fill 

ندازه فقط دور شکل رو خط می  Stroke 

 از نوار بالا  دتبدیل کنی   Shapeبه  ار آنبعد از کشیدن مسیر،  دنی اتو می :اینکته حرفه 

  

 3۹تصویر

Convert to Shape  و بعد خیلی راحت از پنل بالا رنگ Fill و Stroke درو تغییر بدی. 

 طراحی یک کارت تبریک سادهتمرین: 

 :ابزارها

• Brush Tool 

• Eraser Tool 

• Blur Tool 

• Smudge Tool 

• Sharpen Tool 

• Horizontal Type Tool (Text Tool) 

 
1 Stroke 
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 ها در فتوشاپ  مفهوم لایه  -۴ درس

 یعنی چی؟  ۱لایه

لا فتوشاپ،  ورق  هاهیدر  پلاست  یهامانند  هستند    یکیشفاف 

م بهآن  یرو  دی توانیکه  طراح ها  جداگانه  . دیی نما  یصورت 

رو  یزمان  هاهیلا  ن یا م  یکه  قرار    یینها  یجهینت   رند،ی گیهم 

 .دهندیم ل ی شما را تشک ریتصو

کن  ساخت    دی فرض  حال  رودی هست  یکاردست  کی در  بر   ی . 

آب  کی نوشته    کیسپس    د، ی بچسبان  ر یتصو  کی  ، یورق 

ادامه    دی سیبنو نما  کیو در  اگر  دیی برچسب درخشان اضافه   .

اثر را خراب    ستی ن  یازین   د،ی ده  ریی را تغ   یزی چ   دی بخواه  کل 

 .دیی نما ش یرایو ای دی فقط همان بخش را بردار د؛ی کن 

هر چیزی که روی تصویر  .  است  فتوشاپ هم دقیقاً همینطور 
 .د گیر لایه جداگانه قرار می  در یک هست،  

 

 40تصویر  

 

 ؟ دها انقدر مهم و مفید هستنچرا لایه

 :کنترل کامل روی طراحی .1

به  یهر بخش از طراح   د ی توانیم به آن افکت اضافه    ا ی  دی حذف کن  د، ی ده  ریی تغ  د،یی جا نماصورت جداگانه جابهرا 

 .نندی بب بی ها آسبخش  ریبدون آنکه سا د،یی نما

 :ایگذاری حرفهافکت  .2

 . دیی و ... اعمال نما یبعدنور، درخشش، حالت سه ه، یمانند سا ییهاافکت دی توان یم هیهر لا یبر رو

 :تنظیم رنگ و فیلتر جدا برای هر بخش .3

 بماند. ی باق یمتن رنگ  که یدر حال  دیی نما دی و سف اهی را س ریتنها تصو  دی توان یمثال، م عنوانبه

 :هاگذاری و ترکیب لایهماسک .4

لا از  استفاده  تصو  یبخش  دی توان یم   هاهیبا  پنهان    ریاز  به  د،یی نما  ب ی ترک  ایرا  بخش  آن  آنکه  واقعبدون    ی صورت 

 حذف شود. 

 

 
1 Layer 
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 نوع لایه توضیح 

تصویر یا نقاشی معمولی که پیکسلی، مثلًا عکس یا طراحی با  

 براش
 (Pixel Layer) لایه پیکسلی

لایه جدا    ک، خودش یدچیزی بنویسی Text وقتی با ابزار

 د کن درست می
 (Text Layer) لایه متنی

 (Shape Layer) لایه شکلی ود شبا ابزارهای رسم )مثل مستطیل، دایره و...( ایجاد می

مخصوص تغییر رنگ، نور، کنتراست و... بدون خراب کردن  

 تصویر اصلی 
 (Adjustment Layer) لایه تنظیمات

ای که تغییرات و فیلترها رو به صورت غیر نوع لایه حرفه کی

 دکن مخرب ذخیره می
 (Smart Object) لایه اسمارت

کردن واقعی استفاده  برای پنهان کردن بخشی از لایه بدون پاک 

 ود شمی
 (Layer Mask) لایه ماسک

 

 : هاچند اصطلاح خیلی مهم در مورد لایه

می  :1شفافیت • دیده    آن  دکن مشخص  چقدر  .  شودلایه 

می  ۱00% دیده  کاملًا  مخفی   %0،  ودش یعنی  کاملًا    یعنی 

 .است

• Fill   :شبیه Opacity   هست، ولی بیشتر روی محتوا اثر

 .های لایهو نه افکت گذاردمی

• Blend Mode   :با لایه ترکیب لایه  پایین نحوه  تر  های 

می  ار حالت  دکن مشخص  ،  Multiply  ،Overlayمثلًا 

Screen   و... 

 
 

 

• Lock     :  تغییرات از  جلوگیری  برای  لایه  کردن  قفل 

 ناخواسته 

موقتاً    الایه ر  دنی اتو با کلیک روش، می  :۲ آیکون چشم •

 .دمخفی کنی 

 4۱تصویر 

  

 
1 Opacity 
2 Visibility 
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 :مثال واقعی کی 

 :دکنی پوستر درست می کی دفرض کن داری

 زمینه )یه رنگ یا عکس(لایه پس  .1

 لایه عکس بازیگر  .2

 لایه متن عنوان فیلم  .3

 لایه نور و افکت درخشش .4

 لایه لوگوی فیلم  .5

. فقط  د، نیازی نیست کل پوستر رو خراب کنی دجا کنی یا عکس بازیگر رو جابه  دتغییر بدی  افقط متن ر  هیدحالا اگه بخوا

 .هیددتغییر می اهمون لایه خاص ر

 :نکته تصویری )تخیلی(

 :دی تصور کن  گونهن یا  د،یی در ذهن خود تجسم نما هاهی از لا ریتصو کی دی اگر بخواه 

شده است. حال از بالا که    می ترس   یاز طراح  یبخش  شه،ی هر ش  ی اند. بر روشده  دهی هم چ   یشفاف رو  یشهی ش  یسرکی

جداگانه قرار دارد و    یشهی ش  کی  ی. اما در واقع، هر بخش رودیی نمایمشاهده م  جاکیرا    یطراح   ی همه  د،ی کن ینگاه م

 .دی کن نیگزیاج  ای دیی جا نماجابه  د،یرا بردار شهی آن ش دی توانیم

 ...و Text, Shape, Adjustment ها در فتوشاپانواع لایه

چ هر  فتوشاپ،  طراح  یزی در  به  م  یکه  اضافه  م  یهیلا  کیدر    د،یی نمایخود  قرار  اردی گیجداگانه  انواع   هاهی لا  ن ی. 

 خاص خود را دارا هستند. یژگیدارند که هر کدام و یمختلف

 :کنیم نوع مهم رو بررسی می 3ما اینجا 

  ۱لایه متنی .1

 .دکنلایه متنی درست می ک، فتوشاپ یدکنی شروع به نوشتن می  Type Tool (T)وقتی با ابزار  

 :هاویژگی

 . دی نکرده باش Rasterizeآن را  که یتا زمان ماندیم یباق شیرایمتن قابل و •

  میتنظ  Characterپنل    ایو... را از نوار بالا    Boldحروف، حالت    نی فونت، اندازه، رنگ، فاصله ب  دی توانیم •

 . دیی نما

 . دیی اضافه نما Blending Options ینهیگز قیاز طر Stroke ایدرخشش  ه،یمانند سا ییهابه آن افکت دی توانیم

  کسلیمتن به پ  د، یی را انتخاب نما  Rasterize Type  ینهیکرده و گز  کی کلراست  هی لا  ن ی ا  ی اگر رو  :نکته 

 .دیی نما ش یرایو ر،یتصو کیآن را مانند  دی توانیفقط م ست؛ی ن ش ی رایقابل و گریو د شودیم لیتبد

 

 
1 Text Layer 
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  ۱لایه شکلی .۲

 .  گردد ی م   جاد ی ا   ی شکل   ی ه ی لا   ک ی   د، یی نما ی م   م ی شکل ترس   ک ی خط و...    ، ی چندضلع   ره، ی دا   ل، ی رسم مانند مستط   ی با ابزارها   که ی زمان 
 :هاویژگی

 ود شو کوچیک کردن خراب نمی با بزرگ هاآن ، یعنی کیفیتدهستن   ۲برداری  •

 هیدرو از نوار بالایی تغییر بد  4و رنگ دور 3رنگ داخل   دنی اتومی •

 های گرافیکی خیلی مناسب طراحی لوگو، آیکون، یا المان •

  5ابزارهای ساخت 

• Rectangle Tool 

• Ellipse Tool 

• Polygon Tool 

• Line Tool 

• Custom Shape Toolاشکال آماده مثل فلش، قلب و... 

  6لایه تنظیمات .۳

 :ها ویژگی .  شوند ی بخش خاص استفاده م   ک ی فقط    ا ی   ر ی و ... در کل تصو   یی رنگ، نور، کنتراست، روشنا   ر یی تغ   ی برا   ها ه ی لا   ن ی ا 

 .کنندیوارد نم یبیآس یاصل ریمعنا که به تصو ن یه اب، دهستن   ۷غیرمخرب  •

 . دیی حذف نما  ایداده  ریی ها را تغآن ماتی در هر زمان تنظ  دی توانیم •

.  دیی اعمال نما ریخاص از تصو  یبخش  ی افکت را فقط بر رو  دی توانیم ی عن ی ← باشندیماسک م ی صورت خودکار دارابه
 :های معروفAdjustment Layer انواع

 نوع کاربرد 

 Brightness/Contrast تنظیم روشنایی و کنتراست 

 Levels تنظیم نور و سایه با دقت بیشتر 

تر نور با منحنی تنظیم دقیق  Curves 

ها تغییر رنگ و شدت رنگ  Hue/Saturation 

 Color Balance بالانس رنگی )سرد / گرم کردن تصویر( 

 Black & White سیاه و سفید کردن عکس

 Gradient Map اعمال گرادینت روی عکس

 Selective Color تغییر رنگ دقیق برای هر بخش رنگی )مثلًا فقط قرمزها(

 
1 Shape Layer 
2 Vector 
3 Fill 
4 Stroke 
5 Shape 
6 Adjustment Layer 
7 Non-destructive 
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  :اینکته حرفه 

 .گذارندیاز خود اثر م ترن ییپا یهاهیلا  یبر رو هاهیلا

تا به    دیی نما  کی کل  هیآن دو لا  ن یو ب  دیرا نگه دار  Alt  دیبگذارند، کل   ری خاص تأث   یهیلا  کی  یفقط بر رو  دی بخواه   اگر

 (.Clipping Maskشود )  پی آن کل

  :ردی گ یمورد استفاده قرار م هاهیلا  نیاز ا یبی فتوشاپ، ترک  یاحرفه یدر هر پروژه :نکته پایانی 

 :مثلاً 

 عکس زمینه )لایه پیکسلی(  •

  ۱متن عنوان  •

  ۲های گرافیکی شکل •

  3تنظیم رنگ تصویر •

 .پذیر برای بعداً، هم قابل ویرایش و انعطافهستطوری هم کار منظم و تمیز  این 
 

 

 4۲تصویر 

 فتوشاپ  در هاآن کردن قفلها و تغییر ترتیب لایه

 ها مهمه؟اول از همه: چرا ترتیب لایه

 .شوندیم دهی چ ها از بالا به پایین در فتوشاپ، لایه

 .ودشو دیده می  دگیرهای زیرش قرار مییعنی هرچی لایه بالاتر باشه، روی لایه

 :مثال ساده

 .متن هست  کی ۱فرض کن لایه  •

 .است مربع آبی که کل صفحه رو پر کرده کی ۲لایه  •

 . ودش، متن دیده نمیداگه لایه مربع روی متن باش •

 

 
1 Text Layer 
2 Shape Layer 
3 Adjustment Layer 
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 ها رو تغییر بدیم؟ چطور ترتیب لایه 

 :خیلی راحت

 :با موس 1روش 

 سمت راست صفحه  Layers برو به پنل .1

 دار و نگه یدکلیک کن   شودجابجا  هیدخواای که میروی لایه .2

 یدبکش به بالا یا پایین و ولش کن  .3

 
 :با کیبورد ۲روش 

 برای پایین آوردن    [+ Ctrlهایکمهد ، انتخاب لایه •

• Ctrl + [  برای بالا بردن 

 

  1هاقفل کردن لایه

آن   شیرایو  ا ی  ییجاامکان جابه  د،یی نمایرا قفل م  هی لا  کی  که یزمان

 وجود نخواهد داشت.  

 !دکاری نکنیاشتباهی خرابکه  دکن این خیلی کمک می

  :چند نوع قفل داریم

پنل که  Layers در  لایه  روی  قفل هست.  آیکون  ردیف  یه  بالا   ،

 :شوندها فعال میاین گزینه، دکلیک کنی 
 

 

 43تصویر  

 

 نوع قفل  کاربرد

 Lock All بکنی  ددنی اتو، هیچ کاری نمیودشکل لایه قفل می

روی شفافیت   دنی اتو)مثلًا نمی  وندشهای شفاف قفل میفقط قسمت

   (دچیزی بکشی 

Lock Transparent 

Pixels 

 Lock Image Pixels .دیا پاک کنی  دچیزی بکش  دنی اتونمی ردیگ

می قفل  موقعیت  میودشفقط  بدی  دنی اتو،  تغییر  رو  ولی   دمحتوا 

 د.کنی   ینی اتوجاش نمیجابه

Lock Position   

 

 

 
1 Layer Lock 
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  ۱ها ماسک لایه

 :مثال خیلی ساده کی 

)مثلًا فقط صورت آدم  شودعکس دیده ب آنقسمت از  کفقط ی هیدخوا و می دعکس داری کی یدفرض کن

 .داخل عکس(

ها  قسمت  آن،  دکنی استفاده می  ماسک لایه، از  دها رو حذف کنی کن صورت بقیه قسمتجای اینکه با پاکبه

 .دکنی می موقتی مخفیفقط  ار

 

 چطور ماسک لایه بسازیم؟

 یدانتخاب کن الایه ر کی .1

پنل .2 پایین  دایره  Layers از  آیکون  روی 

   یدتوی مستطیل کلیک کن 

شه = این  مربع سفید کنار لایه ظاهر می  کی .3

 ماسک لایه ن اهم

 ۲ابزار براش حالا که ماسک فعال شده، با  

 .  روی تصویر یدرنگ بزن
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 :انیدولی مهمه بد

 رنگ براش نتیجه روی ماسک

 (Black) سیاه  (کاملاً شفاف)  ودشبخش مخفی می آن

 (White) سفید (کامل قابل مشاهده ) ودشبخش دیده می آن

)تار/محو(  ودششفاف می بخش نیمه  آن  (Gray) خاکستری 

 

 

 

 

 

 
1 Layer Mask 
2 Brush Tool 



 

100 
 

  :های خیلی مهمنکته 

 .دیی نما جادی نرم و محو ا یمرزها دی توانیم ،یو رنگ مشک ۱با براش نرم •

 . دی مجدداً آن بخش را بازگردان  دی با رنگ سف  د،یاگر اشتباه کرد •

نم  زی چچی ه • م  شود،یحذف  پنهان  غبه  ش یرایو  ن یبنابرا  گردد؛یفقط    رمخرب ی صورت 

 . ردی گیانجام م

 :ایتکنیک حرفه  کی

  دارد یشده را نگه مفتوشاپ فقط همان قسمت انتخاب  د،یی و سپس ماسک اضافه نما  دی داشته باش   ۲انتخاب  کیاگر  

 .دی نمایم یها را مخفبخش  ریو سا

   حذف شود.  یصورت واقعبدون آنکه به د،ی را جدا کن ریاز تصو یبخش  دی توانیم یراحتبه یعن ی

 

 :کاربردهای واقعی ماسک در طراحی

 ایصورت حرفهزمینه بهحذف پس  •

 ترکیب دو تصویر )مثل دوتا منظره کنار هم(  •

 تار کردن بخشی از تصویر  •

 نمایش فقط قسمتی از یک افکت •

 ساخت ترنزیشن یا فید )محوشدن تدریجی( •

 ۳ها تنظیمات لایه

 ۴شفافیت -1

 .دشفافیت لایه رو کم یا زیاد کنی  دنی اتوبا این گزینه می

 ودش لایه کامل دیده می  → ۱00% •

 ودش لایه کاملًا نامرئی می  → 0% •

  Opacityمقدار    ستیداده شود، کاف  ش یتر نمارنگکم  دی خواه یو م  دیدار  اری متن در اخت  کیمثال، اگر  عنوانبه

 .دی را کاهش ده 

 قرار دارد.  "Opacity"با عنوان  دریاسلا  کی ، Layersپنل   یمکان: در بالا

  

 
1 Soft Brush 
2 Selection 
3 Opacity و Blending Modes 
4 Opacity 
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 1های ترکیبحالت  -۲

  ر ی تأث  .شود  بی خود ترک  ن یریز  یهاهیشما چگونه با لا  یهیلا  کندیم  ن یی تع   نهیگز  ن یا

 .خواهد کرد ریی ها تغحالت نیو ... با ا یرگی رنگ، نور، ت 

به  ییکشو  یمنو  کی ،  Opacityکنار    قاًی : دقمکان پقرار دارد که    فرضش یصورت 

  شده است. م ی تنظ   Normal یرو

 :چند حالت پرکاربرد

 ۲حالت عادی، بدون ترکیب خاص •

 3تیره کردن )برای سایه عالیه(  •

 4روشن کردن )برای نور و افکت درخشان(  •

 5کنه هم تیره کنتراست قوی، هم روشن می •

• Soft Light مثل Overlay ترولی ملایم 

 ( کنه )نه نور و جزئیاتلایه رو اعمال می 6فقط رنگ •

 

 45تصویر  

 

 :. مثلًاد ای بده های خیلی خلاقانه نتیجه   د ن ا تومی  Opacity + Blending Modeترکیب   : نکته  

 !ودش، نور طبیعی می٪70روی  درو بزاری Opacity و Screenرو حالت  دنور خورشید رو بذاری کی •

 در فتوشاپ  7هابندی لایهگروه 

 بندی یعنی چی؟ گروه 

 .کننده خواهد شد شلوغ و سردرگم  ار ی بس  ی کار  ی شود، فضا   اد یشما ز  ی هاه ی که تعداد لا  ی هنگام

Layer Group    تا:   د ی را داخل آن قرار ده ه یچند لا  د ی توان ی است که م   هاه ی در پنل لا  " پوشه"  ک ی مانند 

 د تر باشمرتب پروژه  •

  دییکار نما هاهیتر با لاآسان دی بتوان •

  دیی نما   ی گذارافکت   ای   ی جا، مخف جابه  کجا یصورت  ها را به همه آن  د ی بتوان

 
1 Blending Modes 
2 Normal 
3 Multiply 
4 Screen 
5 Overlay 
6 Color 
7 Layer Groups 
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 گروه کنیم؟ اها رچطوری لایه

 :1روش 

 . یدانتخاب کن  Shiftیا  Ctrlبا  اچند تا لایه ر .1

 .یدبزن  ار  Ctrl + Gی میانبر دکمه .2

 .رند ی گی در آن قرار م   ها ه یخواهد شد و لا  جاد یا   د ی گروه جد   ک ی 
 :۲روش  

 Create)  د یی نما   ک ی کل   پوشه ، روی آیکون  Layers از پایین پنل 

a new group) 

 ود شیه گروه خالی ساخته می .1

   دیی و درون آن رها نما دهی خود را کش  یهاهیلا.۲

 ها انجام داد؟با گروه   توان ی م  یی چه کارها 

 

 
 46تصویر 

 

 قابلیت توضیح 

  جایی جابه    جا کن کل گروه رو با هم جابه 

  مخفی/نمایش  های داخل گروه رو مخفی یا نمایان کن با یه کلیک، همه لایه 

    قفل  کل گروه رو قفل کن تا دیگه نتونی کاری باهاش بکنی

    تغییر نام  (" هامتن " یا   " هدر سایت "روی اسم گروه دابل کلیک کن و اسم جدید بذار )مثلًا: 

    افکت دادن  تونی به کل گروه افکت یا ماسک بدی )مثلًا سایه یا رنگ خاص( می 
 

 : ایحرفه می 

 !دزیرگروه بسازی دنی اتوها هم میگروه در ▪

 ...، و " عکس "، یه گروه برای " متن محصول" گروه برای   در آن یک ، بعد  " محصول " گروه کلی برای    ک مثلًا ی 

های داخلش اثر  تنظیم روی همه لایه  آن، و  دتغییر بدی   اگروه ر Blending Mode یا Opacity دنی اتومی ▪

 .دارد

 های جدا تمرین: طراحی پوستر با لایه

 ایجاد سند جدید •

 (Background) زمینهلایه پس  •

 لایه عکس •

 لایه متن •

 ها تنظیم ترتیب لایه •

 ها بندی لایهگروه  •
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 اصلاح و روتوش تصاویر  -۵ درس

معنا به  تصو  یزکاری تم  یروتوش  ظاهر  بهبود  ا  ریو  صاف  ن یاست.  جوش،  حذف  شامل  پوست،    یسازاقدامات 

 .گرددیم ریمزاحم از تصو یای حذف اش یو حت وچروکن ی بردن چ  ن یاز ب ،یاضاف  یهاهیسا یسازپاک

 بندی ابزارهای روتوش در فتوشاپ دسته

 ۱د ابزارهای ترمیم خودکار و هوشمن  .1

 1. Spot Healing Brush Tool 

 J :میانبر

کاف  رو  ست یتنها  کل  ایلکه    یبر    د؛ یی نما  کی جوش 

به جاابزار  را  اطراف  بافت  هوشمند    نیگزی صورت 

 خواهد کرد.

 

 ...برای اصلاح سریع و راحت پوست، لباس، دیوار و

 

 

 47تصویر 

 :ها حالت

• Content-Aware   :بهترین گزینه(  دکنهوشمندانه بافت اطراف رو آنالیز می( 

• Create Texture  :د کن بافت مصنوعی درست می 

• Proximity Match :د کن برداری میفقط از اطراف نمونه 

 

 

 48تصویر

 :گامبه نحوه استفاده گام

 کردن ابزار فعال. 1

 .دیی نما کی زخم کلچسب  هیشب  کن یآ یابزار موجود در سمت چپ، روز جعبها •

طر  ای • ده  J  انبری م  دی کل   د،ی کل صفحه  ق یاز  فشار  زدی را  در  ابزار  چند  است  ممکن  باشند؛    ری.  داشته  قرار  آن 

 .دیی را انتخاب نما Spot Healing نهیو گز دیرا نگه دار ک ی کل ستیکاف

 
1 Healing Tools 
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 انتخاب اندازه براش . ۲

o  با عنوان  یی هانهیبالا، گز ماتی در نوار تنظSize  وHardness :وجود دارند 

o دیی نما میلکه، آن را تنظ ای: براساس اندازه جوش ۱اندازه . 

o حاصل گردد تریعی طب یا جهنتی تا باشد ٪30تا   0 ن ی مقدار آن ب شود یم  شنهادی : پ۲لبه  یسخت. 

بر رو   کی با کل   دی توانیم کل  ایبوم    یراست  از  استفاده  به  د،ی کل][ در صفحه  ی دهای با  براش را   عیصورت سراندازه 

 . دیی نما می تنظ 

 :از نوار تنظیمات بالا (Type) انتخاب حالت .3

 حالت توضیح کاربردی 

می  تجزیه  رو  اطراف  بافت  باهوشانه  فتوشاپ  گزینه.  هماهنگ   د کن بهترین  هم  با  و 

 .های طبیعی مثل چهره . مناسب برای عکس د ساز می 
Content-Aware 

می  مصنوعی  و  جدید  این د سازبافت  از  نداره،  خاصی  بافت  اطراف  محیط  وقتی   .

 .د استفاده کن 
Create Texture 

. کنترل کمی داره ولی گاهی د کن های اطراف استفاده می ترین پیکسل فقط از نزدیک 

 .د ده سریع جواب می 
Proximity Match 

 

 .دمگر اینکه حالت خاصی مد نظرت باش دنابم یدبذار ان راهست. هم Content-Awareفرضش معمولا پیش 

 

 Sample All Layers تنظیم گزینه.4

 .ید)برای ویرایش غیرمخرب(، این گزینه رو حتماً فعال کن دکنی روی یک لایه جدید خالی کار میاگه  •

بالا روشن کن   ار Sample All Layersدار  آیکن تیک • نوار  نه  دتا از کل تصویر نمونه بگیر  یددر   ،

 .لایه آنفقط 

 یدحالا روی لکه کلیک کن .5

 .دکن می ترمیم  ار بافت خودشبار کلیک کن روی لکه یا جوش  کفقط ی •

 تر()برای نواحی بزرگ دنی اتوهم می داگه لازمه، بکشی  •

 ید برای دقت بیشتر، از زوم استفاده کن .۶

 .یدنمایی کنبزرگ(   Mac OSدر  + Cmd ) یا  + Ctrlبا  •

 تر درمیاد و طبیعی ودردقت کار بالا می •

 
1 Size 
2 Hardness 
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۲. Healing Brush Tool 

  J :میانبر

 یداز لیست ابزارها انتخاب کن

 د هست ولی باید خودت مشخص کنی  Spot Healing مثل 

 ید.برداری کن از کجا نمونه 

می دقیق  بیشتری  کنترل  که  جاهایی  برای   .هیدخواتره، 

کلیکبرداری نمونه   :    +ALT   ناحیه روی  قلم  با  بعدش 

 .ید معیوب بکش

 

 

 4۹تصویر  

 : گامبه نحوه استفاده گام

 انتخاب ابزار .1

 .یدانتخاب کن  ار Healing Brush Toolابزار سمت چپ، از جعبه •

 .ید، این یکی رو بگیرHealing و از لیست ابزارهای یدبزن ار Jی یا دکمه •

 

  ۱تنظیم قلم. ۲

 :دداری ا ها ربالای فتوشاپ، توی نوار تنظیمات، این گزینه

 تنظیم  توضیح 

ی معیوب انتخاب کناندازه قلم. متناسب با ناحیه  Size 

(30٪تا  0٪تر بهتره )نرمی یا سختی لبه براش. برای پوست معمولاً نرم  Hardness 

فرض خوبه( فاصله بین هر نقطه براش )معمولاً همون پیش   Spacing 

های خاص کاربرد داره، معمولاً نیاز نیست تغییر بدیبرای براش  Angle & Roundness 

 

 اختیاری Sample All Layers روشن کردن  .۳

ی • روی  می  کاگه  کار  خالی  جدید  تیک    دکنی لایه  تصویر(،  اصل  حفظ  برای  بهتره   Sample All)که 

Layers  یدرو بالا بزن. 

 .یدبرداری کنی فعلی( نمونهاز کل تصویر )نه فقط لایه دنابراش بتو ودشاین گزینه باعث می •

 
1 Brush Settings 
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 برداری از بافت سالم نمونه  .۴

 .یدنگه دار ا)در مک( ر   Option)در ویندوز( یا   Altی دکمه •

 .یدروی یه ناحیه سالم کلیک کن •

 بردار  Alt حالا دستت رو از •

 .یدجای دیگه کپی و ترکیب کن   ار دست تا بافت سالمی که انتخاب کردیحالا ابزار براش آماده

 روی ناحیه معیوب بکش  .۵

 .یدحالا با موس یا قلم نوری روی جوش، خراش یا لکه بکش •

 .، طوری که کاملًا طبیعی به نظر بیاددکن فتوشاپ بافت سالم رو با بافت خراب ترکیب می •

 تکرار برای نواحی مختلف  .۶

 ید ( بزن Alt) کلیک + ، دوباره دبرداری رو عوض کنی هر وقت خواستی منبع نمونه •

 .تر دربیادکه طبیعی دای جدا انتخاب کنی برای هر بخش متفاوت، نمونه دنی اتومی •

۳. Patch Tool 

 Healing Tools  در گروه

  ا ناحیه ر  آن، بعد  دکنی انتخاب می  اناحیه خراب ر  کی

ی  دکشی می سالم  کروی    ا ر  بافت  خودش   قسمت 

 د. کن می جایگزین 

روی   خطوط  یا  چشم  زیر  مثل  بزرگ  نواحی  برای 

 .صورت عالیه

 .دهم داشته باش Content-Aware حالت اندتومی

 
 

 50تصویر  

 
 :کاربرداصلی 

 :ترمیم نواحی بزرگ خراب مثل

 تیرگی زیر چشم  •

 های زیاد چین و چروک •

 ترک روی دیوار یا لباس  •

 کردن اشیای مزاحم از تصویرپاک •

با ر  است  این Spot Healing فرقش  ناحیه خراب  اول  می  اکه  مییدکن انتخاب  ماوس  با  بعد  روی یک    دکشی ، 

 .کندجایگزین میبه جای خراب  اناحیه سالم. خودش بافت سالم ر 
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 Patch Tool تنظیمات مهم

 Patch: Source / Destinationدر نوار بالا

 اینجا دوتا حالت هست 

 :دبینی می اها ر، این گزینهدوقتی ابزار فعال باش 

 حالت عملکرد 

 آن بعد با کشیدن، بافت سالم رو جایگزین     →خرابه  د کنی ای که انتخاب می ناحیه 

 .د کنی می 
Source ( فرضپیش ) 

ی سالم رو روی با کشیدن، اون ناحیه    →ی سالمه  د کن ای که انتخاب می ناحیه 

 ید. کن قسمت خراب کپی می 
Destination 

 

 چون ، ید روبذار Source اغلب وقتا حالت 

   

 5۱تصویر

 

 .دکن تر کار میتره و هوشمندانهراحت

۴. Content-Aware Move Tool 

 Healing Tools ن گروهاهم

سپس آن را   د، ی کن ی را انتخاب م   ری از تصو   یبخش   ای   ی ش  ک ی 

طور خودکار به   ی قبل  ی . جا د یی نما ی منتقل م  ی گر ی به محل د

م  پر  اطراف  بافت  از  استفاده  برا  . گردد ی با   یمناسب 

 ها.آن   یو حذف جا  ر ی در تصو   اء ی اش  ا یافراد    یی جابجا 

 

 

 5۲تصویر  

 
صورت خودکار پر شود؛  ها بهآن  یکه محل قبل   یابه گونه  رود،یکار مبه  ریدر تصو  اء ی اش  ییجابجا  یابزار برا  ن یا

 در آن مکان قرار نداشته است.  گاه چی ه  یآن ش  ییگو کهیطور

 دهد؟یرخ م  یچه اتفاق   شود،یانتخاب و حذف م یئ یش  Content-Aware Move Tool با یقت و

 . دینمایپر م یعی صورت طبرا به  یو محل قبل کندیم ل ی صورت خودکار بافت اطراف را تحلبه فتوشاپ
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 (Clone Tools) ابزارهای کپی و تکرار بافت. ۲

۵. Red Eye Tool 

 ود. شدار ایجاد می های فلش برای حذف قرمزی چشم که در عکس 

 

 53تصویر  

 

۶. Clone Stamp Tool 

 S میانبرکلید 

  د، ی ــکن ی م   ی بردار نمونــه   ALT+    ک ی را با کل  ر ی سالم از تصو  ی ا ه ی ابتدا ناح 

 . د یی نما ی م   ی گذار ی جا  ی گر ی همان بافت را در محل د   قاًی سپس دق 
 و قابل کنترل است.  قی دق  اری ابزار بس  ن یا

 

 54تصویر  

 :کاربرد اصلی

 :مناسب برای.گری و الصاق آن به بخش د ریاز تصو یاز بخش قی دق  یبرداریکپ یبرا یابزار

 حذف اشیای ناخواسته  •

 های قدیمیترمیم عکس  •

 شده تصویر های خراب یا حذفبازسازی قسمت •

 پر کردن نواحی خالی با الگوهای موجود  •

 :قدمبهنحوه استفاده قدم

 انتخاب ابزار  .۱

 .یدبزن ار S دی کل  ای یدرو انتخاب کن  Clone Stamp Toolاز نوار ابزار سمت چپ، 

  ۱براش ماتی تنظ .۲

 :دی کن م ی ابزار رو تنظ  ن یا  یموقلم دی ناتو ینوار بالا م  در

 
 55تصویر

 
1 Brush 
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 گزینه توضیح 

 Size (دخوای کپی کنی ای که میاندازه قلم برای کپی )بسته به اندازه ناحیه

 Hardness ها )نرم برای پوست، سخت برای خطوط صاف(میزان سختی یا نرمی لبه

 Opacity ( ٪50)مثلًا  دهای نرم بهتره کمتر باششفافیت، برای ترمیم

 Flow شدت پاشش، برای کنترل بیشتر روی ظاهر نهایی 

نه )  دبرداری هنگام درگ کردن، همراه دستت حرکت کن که نمونه  دکن مشخص می در  یا 

 ( ادامه توضیح خواهیم داد
Aligned 

 

 (Source) برداریی نمونه انتخاب ناحیه .۳

 سد )در مک( رو نگه دار Option)در ویندوز( یا  Altی دکمه

 )مثلًا یه تکه سالم از دیوار یا پوست( یدکلیک کن دنمونه بگیری آن  از هیدخواای که میروی ناحیه

 .دبچسبونی  دیگه جای ار  ناحیه آن تا  ایآماده حالا

 (Destination) روی ناحیه هدف کشیدن.4

 .یدبکش  شودترمیم   هیدخوا با موس یا قلم نوری روی قسمتی که می حالا

 .دریز پیکسل روی بخش جدید میبهپیکسل ا ر دگرفتی  Source فتوشاپ دقیقا همون چیزی که از

 Clone Stamp Tool ایتنظیمات حرفه

▪ Aligned 

  

 56 تصویر

 

 وضعیت عملکرد

دار انجام میشه )مثلًا مثل کشیدن الگو(برداری به صورت دنبالهنمونه  روشن 

کنه )برای تکرار الگوها عالیه( زدی کپی می Alt همیشه از همون نقطه اولی که   خاموش  

 

▪ Sample 

 

 :برداری کنهکنه ابزار از کجا نمونه مشخص می

 

57تصویر  



 

110 
 

 گزینه توضیح 

 Current Layer ای که الان روش هستی فقط از همون لایه

 Current & Below ترهای پایین از همین لایه و لایه

 All Layers  ی خالی مفیده(های تصویر )برای کار روی لایهاز کل لایه

 

▪ Clone Source Panel 

 :دهتری میایفعال میشه. امکانات حرفه Window > Clone Sourceاز منوی 

 

58تصویر  

 
5۹تصویر  

 چرخش نمونه قبل از چسباندن •

 معکوس کردن افقی / عمودی  •

 تعیین مختصات دقیق  •

 :اینکات حرفه

 د ها طبیعی باشن تا لبه یداز براش نرم برای پوست استفاده کن

 دکه رنگ و نور شبیه باش یدترین بخش سالم نمونه بگیرهمیشه از نزدیک

 .یدکار کن Opacity برای جلوگیری از خطای چشم، با سایزهای مختلف براش و تنظیم

 برای دقت بیشتر ( (+ Cmd یا + Ctrl) )یدزوم کن 

 . یداستفاده کن  History Panelیا از   Ctrl + Z :اگه اشتباه شد
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 تفاوت 

 ابزار  تفاوت 

 Clone Stamp ها کپی کامل و دقیق پیکسل

 Healing Brush ترکیب هوشمند پیکسل نمونه با بافت اطراف 

 

 :تمرین

  تصویر با لکه یا شیء مزاحم بیار کی

Clone Stamp رو بردار  

Alt +کلیک روی ناحیه سالم  

  شیدروی بخش خراب بک

 .ودتر ش تر تکرار کن تا طبیعیپایین  Opacity با

 

 

۷. Pattern Stamp Tool 

 
 

60تصویر  

 Clone Stamp زیر مجموعه

 .ددهو باهاش تصویر رو پوشش می دکن استفاده می ۱از الگوهای آماده فتوشاپ  ▪

 بیشتر برای کارهای هنری و گرافیکی  ▪

 :کاربرد اصلی

 د .مو روی تصویر بزنیمثل مهر یا قلم  اشده راز پیش تعریف  ۲ی الگوها ده که این ابزار بهت اجازه می

 :مناسب برای

 ی تکرارشوندهزمینهایجاد بافت یا پس  •

 های هنری )مثلًا پُر کردن یک شکل با پارچه یا پوست حیوان(طراحی •

 
1 Pattern 
2 Pattern 
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 ها هایی از عکس با استفاده از بافتبازسازی قسمت •

 :نحوه استفاده 

 انتخاب ابزار . ۱

  انتخاب یک الگو   . ۲

 

 

 6۱تصویر 

 :۱در نوار بالای فتوشاپ 
 . ید)الگوی فعلی( یک الگو انتخاب کن  الگواز بخش  ▪

 . ددنده کنار لیست، الگوهای بیشتر رو بارگذاری کنی از لیست موجود، یا از آیکن چرخ دنی اتومی ▪

 . دبسازی را الگوی دلخواه خود دنی اتوحتی می ▪

 ۲تنظیمات براش  .3

 :یدتنظیم کن اقبل از کشیدن، براش خود ر

 

6۲تصویر  

 گزینه توضیح 

 Size مو اندازه قلم

 Hardness ی نرم یا سخت لبه

 Opacity میزان شفافیت 

 Flow شدت پاشش رنگ 

 Mode برای ترکیب بهتر با زمینه و...(   Multiply ،Overlay )مثل حالت ترکیب

 
1 Options Bar 
2 Brush 
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 کشیدن روی تصویر .۴

 .دروی لایه بزنی   اشده ردرگ، بافت انتخاب و با کلیک دنی اتومی حالا

 .ودشبه صورت تکراری و هماهنگ روی تصویر ظاهر می الگو

 Options Bar تنظیمات پیشرفته در 
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 گزینه عملکرد

کنه حتی اگه دستت رو برداری. اگه اگر فعال باشه، پترن به صورت پیوسته ادامه پیدا می 

 .خاموش باشه، هر بار از ابتدا شروع میشه 
Aligned 

کنه. شبیه نقاشی میشه، نه دقیق. خیلی برای پترن رو به صورت هنری و نامنظم اجرا می 

 .های فانتزی خوبهجلوه 
Impressionist 

 
 اختصاصی )ساخت الگو دلخواه خودت( الگو ساخت

 :دکنی  الگو تبدیل به  اهر بافت یا شکلی ر  دنی اتومی

 :مراحل

 Marquee Tool مثلًا با یدای از تصویر رو انتخاب کنناحیه .1

 :از منوی بالا  .2

Edit > Define Pattern 
  انتخاب کنیداسم براش  کی .3

  .داستفاده کنی آن از دنی اتوو می دگیرقرار می Pattern Stamp Tool توی لیست الگوحالا این 
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 :تمرین

 یه لایه جدید بساز .1

2. Pattern Stamp Tool  رو بردار 

 دلخواه انتخاب کن )مثلًا چوب یا آجر( یک الگو .3

 ید مناسب روی تصویر بکش  Opacity با سایز و .4

 یدبذار Overlay به حالت Blending Mode با الایه ر .5

 کردن، پخش کردن یا تیز کردنابزارهای نرم . ۳

۸. Blur Tool 

  : کاربرد اصلی 

هایی از تصویر استفاده برای محو کردن )تار کردن( قسمت    Blur Toolابزار 

 شود.. این محو کردن باعث میشه جزئیات اون قسمت کمتر دیده  شود می 
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 :مناسب برای

 زمینه کردن پس مات •

 ها کردن پوست یا لبهنرم  •

 ای خاص حذف تمرکز از ناحیه •

 ( دادن به تصویر های هنری )مثل عمقافزودن جلوه •
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 :قدمبهنحوه استفاده قدم

 انتخاب ابزار  .۱

  ید از جعبه ابزار سمت چپ  روی قطره آب کلیک کن 

 .یدرو انتخاب کن   Blur Toolو 

 (Brush)  موانتخاب قلم .۲

  اتنظیمات براش ر  دنی اتو می فتوشاپ  ۱در نوار بالای 

 :هیدانجام بد
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 گزینه توضیح 

 Size خوای تار کنی(اندازه قلم )بسته به اینکه چقدر ناحیه بزرگی رو می

 Hardness لبه نرم یا سخت؛ برای پوست بهتره نرم باشه

 Spacing فاصله بین هر ضربه قلم؛ معمولاً روی مقدار پایین تنظیم باشه 

 Angle / Roundness های خاص( زاویه و فرم براش )مناسب برای براش

 

۳ .Strength  قدرت محو کردن 

 (: ٪ ۱00  تا   ٪ ۱0  ن ی )مثلًا ب   ید کن   ن یی رو تع Strengthدر نوار بالا، مقدار 
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 نتیجه  مقدار

) کم ٪۱0  - ٪30  محو کردن ملایم  (

) متوسط ٪40  - ٪60  محو مشخص  (

) زیاد ٪70  - ٪۱00  محو شدید و فوری  (
 

  :اینکات حرفه

وارد   ی ب ی آس   یاصل   ری تا به تصو  (Ctrl + J) د یی استفاده نما   شده ی کپ   یه یلا   ک ی   یابزار را رو   شهی هم 

 .نشود 

 Lasso انتخاب مانند   یرا با ابزارها   هی بخش خاص تار شود، ابتدا آن ناح  کی تنها    د ی دار   لی تما   اگر 

 
1 Options Bar 
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Tool  سپس   د،یی انتخاب نما Blur Tool  د ی کار ببر را به. 

 .د ینما   جاد یا   یبهتر   یجه ی نت   تواند ی م Clone Stamp مانند   گر ی د   یبا ابزارها  Blur Tool ب ی ترک

  ی ترمناسب  ینهیگز  Filter  یدر منو  Gaussian Blurاستفاده از    د،یی را تار نما  یبزرگ  یهیناح  دی بخواه   چنانچه

 خواهد بود.

 :تمرین پیشنهادی

 ید یک عکس پرتره باز کن .1

 (Ctrl + J) از لایه عکس، کپی بگیر .2

3. Blur Tool رو بردار، با Strength  ۲0حدود٪ 

 ها و پیشانی بکش برای نرم شدن پوستروی گونه .4

 تری بساز لایه کپی، ظاهر طبیعی Opacity کردنبا کم .5

۹. Sharpen Tool 

   :کاربرد اصلی
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 . رودیکار م به ریاز تصو ی خاص ی در نواح اتی وضوح جزئ ش یافزا ایکردن  زتری ت  یبرا Sharpen Toolابزار 
 :مناسب برای

 ها، موها، یا اجزای صورت تر کردن چشمواضح •

 ها )مثل پارچه، چوب، سنگ( کردن بافتبرجسته •

 افزایش کنتراست جزئیات بدون افکت سراسری  •

 :قدمبهنحوه استفاده قدم

 انتخاب ابزار  .1

 (Brush) انتخاب براش  .۲

 :تنظیمات براش رو مشخص کن  (Options Bar) در نوار بالا

 گزینه کاربرد 

 Size اندازه قلم )بسته به جزئیات ریز یا درشت( 
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 Hardness میزان سختی لبه براش )برای وضوح بهتر معمولاً مقدار بالا بزار( 

 Spacing فاصله بین ضربات براش 

 قدرت تیز کردن Strength تنظیم .3

 

10. Smudge Tool 

ها، محو کردن خط برای ترکیب رنگ ید  کشمی  اها ر انگار داری با انگشتت رنگ 

 وچروکلبخند یا چین 

 

 6۹تصویر  

 شروع به کار 

 :یدمو روی نواحی مورد نظر بکشحالا با قلم

 ها چشم •

 ابروها •

 ی اجسام لبه •

 بافت پارچه یا چوب  •

 .دکن هر بار کشیدن روی یک ناحیه، اون بخش رو تیزتر می

 :نکته 

 .ها هست(رو ببینی )در بعضی نسخه Protect Detailی در نوار بالا ممکنه تیک گزینه

 د کن : از خراب شدن بافت اصلی محافظت میدوقتی فعال باش

 .شود، ولی ممکنه جزئیات بیش از حد تغییر کنه یا نویز ایجاد می شود: تیز کردن شدیدتر انجام دوقتی خاموش باش

 تربرای نتایج طبیعی دبهتره همیشه روشن باش

 :تمرین پیشنهادی

 ای رو باز کن عکس پرتره  . 1

 (Ctrl + J) لایه جدید بساز  . 2

 رو انتخاب کن  Sharpen ابزار  . 3

 ٪30حدود   Strength با  . 4

 ها و ابروها بکش فقط روی چشم  . 5

 ، لایه رو خاموش/روشن کن تا تفاوت رو ببینیدر آخر  . 6
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 ابزارهای نور و رنگ برای اصلاح چهره .۴

 

11. Dodge Tool 

  :کاربرد اصلی

Dodge Tool  است   ها روشن کردن نواحی خاص از عکس ابزار برای    ک ی ،

. یعنی فقط هر جایی رو که با موس روش شود   بدون اینکه کل تصویر روشن 

 ود.شتر می ن ناحیه روشن ا ، هم دبکشی 
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 :مناسب برای

 ها توی پرترهها یا دندونروشن کردن چشم •

 های خاص )مثلًا روی مو یا لباس( هایلایت دادن به قسمت •

 اضافه کردن جلوه نور )مثلًا نور آفتاب روی صورت یا زمین(  •

 کارای هنری و نورپردازی دستی  •

 :تنظیمات مهم در نوار بالا

 

 گزینه کاربرد 

 Brush دکنیاندازه و شکل قلم رو مشخص می 

 Range ها( تنه، روشنایی ها، نیم )سایه دخوای روشن کنیای که می محدوده

 Exposure ( ٪۱00تا  0بین  -شدت اثر ابزار )چقدر روشن کنه 

 Protect Tones ها و نور طبیعی )حتماً تیک بزن(جلوگیری از خراب شدن رنگ

 

 :  Rangeتوضیح

 Range معنی کاربرد 

 Shadows هاسایه  کنه های تیره رو روشن میفقط قسمت

 Midtones نواحی معمولی ها مناسب برای اکثر موقعیت

 Highlights نواحی روشن  کنه های از قبل روشن رو بیشتر روشن میفقط قسمت
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 7۱تصویر

 

  :اینکات حرفه

 

 7۲تصویر

 

 .(Ctrl + J) دیی کار نما شدهیکپ  یهی لا کی یحتماً بر رو

 .نگردد یتا رنگ پوست دچار سوختگ  دیی را فعال نما Protect Tones ینهیگز

 با شدت بالا.  بارهکیصورت نه به د،یی با شدت کم اعمال نما بارن یبهتر، چند یجهی کسب نت برای

 :اشتباه رایج

  نیسوخته به نظر برسد )به ا  ای  یع ی رطب ی غ  ریممکن است موجب شود تصو  Dodge Toolاز حد از    ش یب  یاستفاده

 و فاقد بافت شوند(. دی از حد سف  ش یب ینواح  یمعنا که برخ

 :تمرین پیشنهادی

 .دیی پرتره در فتوشاپ باز نما ریک تصوی .1

 (Ctrl + J) یدکپی کن   الایه ر .2

 Exposure ۱5٪ ،Range: Midtones، یدرو بگیر Dodge ابزار .3

 .یدها، پیشونی یا مو آروم بکشها، چشمروی گونه .4

 . یدو تفاوت رو ببین  یدروشن کن / حالا لایه رو خاموش .5

 

1۲. Burn Tool 
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 73تصویر

 

   :کاربرد اصلی

Burn Tool  م  ریاز تصو  یخاص   یهانمودن بخش   تررهی ت  یبرا برعکس    قاًی ابزار دق  ن ی. اردی گ یمورد استفاده قرار 

Dodge Tool  دهدیم  شیرا افزا هایرگی ت  ای هاهیکه نور اضافه کند، شدت ساآن یجا. بهدینمایعمل م 

 :مناسب برای

  های تصویر برای جلب توجه به مرکزتیره کردن گوشه •

 تیره کردن خطوط صورت برای عمق دادن یا فرم دادن چهره  •

 ها با سایه سازی عضلات یا چین برجسته •

 های هنری های دراماتیک در عکس ایجاد افکت •

 :  Rangeتوضیح

 

 74تصویر

 Range معنی  کاربرد 

 Shadows کنه تر میها رو تیرهفقط سایه های با سایه زیادعالی برای عکس 

 Midtones نواحی معمولی  بهترین گزینه برای اکثر تصاویر

 Highlights کنه های روشن رو تیره میبخش  گرفته برای اصلاح نواحی بیش از حد نور
 

 :مثال واقعی

 :دصورتش فرم بگیر هیدخوا و می دعکس پرتره داری کی یدفرض کن

 (Ctrl + J) یدکپی کن   الایه رو .1

 ید رو بردار Burn ابزار .2

 یدها، دور فک و اطراف موها کمی بکش، زیر گونهدهای بینی روی کناره .3

 ، بدون استفاده از آرایش یا فیلتر دگیرمی فرم و حجماینطوری صورت  .4

 :تمرین پیشنهادی

 یه عکس پرتره باز کن .1

 (Ctrl + J) لایه کپی بگیر .2

 Burn → Exposure: ۱5٪ ابزار .3
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 .یدهای بینی، زیر گونه، حاشیه موها بکش روی کناره .4

 .یدها و پیشونی بکشروی گونه → Dodge حالا ابزار .5

   .ه استتر کردایچطور نور و سایه، تصویر رو حرفه یدببین .6

 

1۳. Sponge Tool 

   :کاربرد اصلی
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بخواه  تصو  یبخش   دی اگر  پررنگ  ریاز  )شادابرا  )ماترنگکم  ایتر(  تر  نماتر  بس  ن ی ا  د،ی ده   ش یتر(    دی مف  اری ابزار 

 خواهد بود.

 (Saturation) افزایش یا کاهش اشباع رنگ

 ای که کمرنگ شدهتر کردن پوست یا بازگرداندن رنگ به ناحیهمناسب برای طبیعی

 

 :مناسب برای

 توی عکس پرتره  تر کردن رنگ لب، چشم یا لباسزنده  •

 برای تمرکز روی سوژه  زمینهرنگ کردن پسکم •

 سفیدومثل تبدیل یه بخش به سیاه های هنری افکت  •

 هایی که رنگشون زیادی جیغ یا کمه تعمیر عکس •

  : ای نکات حرفه 

 د تا نسخه اصلی آسیب نبین  یدکار کن  شده ی کپیلایهروی  •

 یدانتخابش کن Selection Tool، اول با دبخش خاصی فقط تغییر کن  هیدخوا اگه می •

می • هنری،  افکت  سیاهبخش   د نی اتو برای  کامل  رو  عکس  از  کنی هایی   دسفید 

(Desaturate ۱00٪) 

 :تمرین پیشنهادی

 یدعکس رنگی باز کنک ی .1

 (Ctrl + J) یدلایه کپی کن .2
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 Sponge Tool → Saturate ابزار .3

 ید روی لباس یا گل یا هر چیز رنگی بکش .4

ولی بقیه رنگی    دسفید کنی فقط یه بخش رو سیاه  دنی اتوو ببین چطور می  یدهم امتحان کن Desaturate بعد، با .5

 !بماند

 

 ابزارها و فیلترهای هوشمند  .۵

 

1۴. Content-Aware Fill 
Edit > Fill > Content-Aware 

 

 د سازاز اطراف می  ا، بعد فتوشاپ خودش بافت مناسب ریدانتخاب کن اناحیه ر کی

 زمینه های بزرگ از پس خیلی قدرتمند برای حذف جسم

 

 :نحوه استفاده 

 ید رو انتخاب کن   ودحذف ش  هیدخوا چیزی که میLasso مثل ابزار انتخاببا  .1

 :برو به منوی .2
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 شود پنجره باز می کی .3

 .ید بزن  Apply / OK، بعد روی دهیدانجام  اتنظیمات دلخواه ر  .4

 .دکن فتوشاپ خودش جای خالی رو هوشمندانه پر می .5
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1۵. Liquify 

Filter > Liquify 

 

صورت   برای  یا  بدن  اجزای  فرم  کردن ،  تغییر  صاف 

اندام ،  لباس  کردن  بزرگ  و  های افکت ،  ها کوچک 

 .دار فانتزی یا خنده 

و   د نی ا تو می   بینی  لبخند،  بدن،   رو  …شکل چهره، فرم 

 دبدی   تغییر 
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  اصلی  عکس  روی تا دبزنی  OK باید تغییرات  اعمال  از بعد ؛دکن می عمل مستقل صورتبه  Liquify  :نکته 

 .ود ش اعمال
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 : Liquify داخل ابزارهای ترینمهم 

1. Forward Warp Tool )W( 
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 اجسام  فرم تغییر یا کشیدن برای مناسب قلم جهت به هددمی هل  رو ها پیکسل باهاش

 لباس  به دادن فرم فک، خط کشیدن  بینی، کردن باریک: کاربرد
 

  

 ۲. Pucker Tool )S( 

   و  بینی  دهان،  چشم،  کردن  ترکوچک  براید  کشمی  قلم  مرکز  سمت  به  رو  هاپیکسل

... 

  ها فرم کردنجمع: کاربرد

  

 ۳. Bloat Tool )B( 

 د.دهمی فشار بیرون به رو ها پیکسل ،Pucker برعکس 

 ماهیچه  لب، چشم،  مثل اجزاء کردن بزرگ برای

 گونه  کردن  برجسته چشم، کردن بزرگ: کاربرد

 
 

 

 ۴. Push Left Tool )O( 

  (موس   حرکت  با)   ده می  هل  افقی   یا  عمودی  رو   هاپیکسل 

 ها فرم   کردن صاف   یا   کشیدن   برای 

 بدن  یا   لباس   هایخط  کردن   هموار:  کاربرد 

 

  

 ۵. Freeze Mask Tool )F( 

 کنیمی   ماسک  رو  کنن   تغییر خوای نمی   که  جاهایی 

 مونن می   امان  در   ابزارها  بقیه   تغییرات از   نواحی   اون 

 صورت  روی  کار   هنگام گوش   یا   چشم   تغییر از   جلوگیری :  کاربرد 

 

 
 .دکنن کردن چشم استفاده میها ازش برای اصلاح فرم بینی، لاغرکردن صورت، یا بزرگایحرفه

 

1۶. Face-Aware Liquify 

 

 iquify   تر هوشمند  نسخه 
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 7۹تصویر

 گذارد.میو اسلایدر برای هرکدوم  ددهفتوشاپ خودش چشم، بینی، دهان، فک رو تشخیص می
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 :Face-Aware هایویژگی

 :ددهای برای هر بخش صورت بهت می، فتوشاپ اسلایدرهای جداگانهشودوقتی یه چهره تشخیص داده  

 

 :(Eyes) چشم ▪

• Eye Size  : بزرگ یا کوچک کردن چشم 

• Eye Height  : ارتفاع چشم 

• Eye Width  : عرض چشم 

• Eye Tilt   : زاویه چشم 

• Distance  :فاصله بین دو چشم 

 :(Nose) بینی ▪

• Nose Height  : کوتاه یا بلند کردن بینی 

• Nose Width  : باریک یا پهن کردن بینی 

 :(Mouth) دهان ▪

• Smile  :کم یا زیاد کردن لبخند 

• Upper Lip / Lower Lip   : اندازه لب

 بالا و پایین

• Mouth Width  :پهنای دهان 

• Mouth Height  : )بلندی دهان )باز/بسته 

 :(Face Shape) صورت ▪

• Forehead   : ارتفاع پیشانی 

• Chin Height  : ارتفاع چانه 

• Jawline  : پهنای خط فک 

• Face Width  : عرض کلی صورت 
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 :چطور بهش دسترسی پیدا کنیم 

 ی باز کن  ا تصویر ر .1

 Filter > Liquify  :از منو برو به .2

پنجره .3 بخش  Liquify یدر  می  ار Face-Aware Liquify، در سمت راست،  ای  )اگه چهره  دکنیپیدا 

 ( ددهطور خودکار تشخیصش می، فتوشاپ بهدتوی عکس باش
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1۷. Camera Raw Filter 

Filter > Camera Raw Filter 

 

 8۱تصویر

 ...دسترسی کامل به تنظیمات نور، رنگ، وضوح، کنتراست، بافت و

 برای روتوش طبیعی، صاف کردن پوست، تنظیم رنگ پوست خیلی عالیه 

 :کاربرد اصلی

 تنظیم رنگ و نور عکس •

 ها ها و هایلایتاصلاح نوردهی، کنتراست، سایه •

 JPG یا حتی RAW هایتر فایلویرایش دقیق •

 ...شارپ کردن عکس، حذف نویز، تنظیم رنگ پوست و •

 :چطور بهش دسترسی پیدا کنیم

 ید رو انتخاب کن Smart Object یا یک لایه .1

 Filter > Camera Raw Filterاز منوی بالا برو به .2

 ای شه با کلی تنظیمات حرفهیک پنجره کامل باز می .3

 
 8۲تصویر
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 :ها و تنظیماتترین بخشمهم

 
 83تصویر  

1. Basic ) ترین تنظیماتایپایه  )  

Exposure: روشنایی کلی تصویر 

Contrast:  کنتراست یا تضاد رنگی 

Highlights:  های خیلی روشنکنترل بخش  

Shadows: ها کنترل سایه  

Whites / Blacks:  تنظیم شدت سفید و مشکی 

Texture / Clarity: ها افزایش وضوح بافت  

Vibrance / Saturation:  )افزایش رنگ )طبیعی یا اشباع 

 

 ۲. Curve )منحنی نور) 

 تنظیم دقیق روشنایی و کنتراست با استفاده از منحنی

 های سینماییخیلی کاربردی برای ساخت افکت 

 

 
84تصویر   

 3. Detail )جزئیات) 

 

Sharpening:  بودن شارپ  و  وضوح   افزایش 

oise Reduction:  کاهش نویز 

 ( های تار یا عکس  برای   ISO  بالا) 

 

  85تصویر 
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 ۴. Color Mixer )میکس رنگ) 

 کاری کل عکسهای خاص بدون دستتغییر رنگ

 ...مناسب برای اصلاح رنگ پوست، آسمان، لباس و

 

 
 86تصویر 

 ۵. Optics 

 Chromatic) ی نوراصلاح لنز، کاهش اعوجاج، حذف هاله

Aberration)  

 

 

87تصویر    

۶. Geometry 

 

  کردن خطوط کج )خیلی مفید برای عکس معماری(تنظیم پرسپکتیو، صاف

 

 

 

 88تصویر                                                                                                                                         

 

۷. Effects 
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 Grain یا (Vignette) وینیت های ساده مثل افکت

 برای ایجاد حس کلاسیک یا سینمایی

 

 
 8۹تصویر 

۸. Calibration 

 ها برای فاین تیون کردن ظاهر عکستغییر کالیبراسیون رنگ

 د کنن ای از این بخش استفاده میهای حرفهبیشتر عکاس

 
 ۹0تصویر 

 ابزارهای جانبی  .۶

1۸. History Brush Tool 

 
 ۹۱تصویر        

 

 .دنی ابه حالت قبل برگرد ابخش از تصویر ر کی دنی اتومی با آن

  :کاربرد

 !با قلمHistory Panel از داخل ندن بخشی از تصویر به یه حالت قبلیابرگرد

 :مثال ساده 

 History باها( رنگی باشه  خوای فقط یه بخشش )مثلًا گلفرض کن کل عکس رو سیاه و سفید کردی، ولی می

Brush  گردونیاون قسمت رو به حالت رنگی اولیه برمی. 

 :نحوه استفاده 

 مرحله(   آن )با کلیک روی مربع کوچیک کنار    ید عنوان مرجع انتخاب کن به   ا حالت قبلی ر   ک ی  History Panelاز   . 1

 بردار ار History Brush ابزار .2

 .دگرد، به اون حالت قبلی برمید روی هر قسمتی که با قلم بکشی  .3
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 :تنظیمات

 د تنظیم کنی  ار  Flow و Hardness ،Opacityسایز،  دنی اتو از نوار بالا می •

 روی تصویر  "کنهنقاشی می"، ولی حالت قبلی رو  دکن عمل می Brush Tool دقیقاً مثل •

 .ماندو بقیه ب دبخش از روتوش رو پاک کنی  کثلًا فقط یم

1۹. Mixer Brush Tool 

 
 

 ۹۲تصویر

 :کاربرد اصلی

 ها نقاشی طبیعی و ترکیب رنگ •

 های واقعی مثل آبرنگ، رنگ روغنسازی اثر نقاشیشبیه •

 ها( ای با ظاهری طبیعی )مثلًا ترکیب رنگ پوست یا سایهروتوش حرفه •

 :دسترسی

 .یدنگه دار ار  Brush Toolدر نوار ابزار، ابزار  •

 مو با قطره رنگه()آیکونش شبیه قلم یدانتخاب کن ا ر  Mixer Brush Toolاز منوی بازشونده،  •

 . دتا برس بهش برسی  Shift+B و سپس  B :میانبر •

 

 ۹3تصویر

  :تنظیمات مهم

• Load Brush : دکن مو در هر بار نقاشی با خودش حمل میمیزان رنگی که قلم . 

• Mix : یعنی کامل مخلوط( ۱یعنی رنگ تازه کاملًا جدا،  0شدن رنگ روی بوم )مقدار مخلوط 

• Flow : سرعت جریان رنگ روی بوم 

• Wet :  بودن رنگ )تأثیر روی نحوه پخش رنگ روی بوم( "تر" میزان 

• Load Brush Every Stroke : گیره یا نه با هر بار کشیدن رنگ تازه می 

• Clean Brush : مو پاک کردن رنگ داخل قلم 

 :نحوه استفاده 

 مو رو بردار قلم .1

 یدانتخاب کن  ارنگ مورد نظرت ر .2

 ود ششن و اثر طبیعی ایجاد میها با هم ترکیب می؛ رنگیدشروع به نقاشی کن  .3

 ید بزن ار Clean Brushمو، گزینه برای پاک کردن رنگ قلم .4
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 :کاربردهای عملی

 نقاشی دیجیتال با افکت طبیعی  •

 های ملایم و طبیعی روتوش پوست با ترکیب رنگ •

 های آبرنگ و رنگ روغنطراحی و نقاشی افکت •

 ها ها و هایلایتایجاد انتقال رنگ نرم و طبیعی بین سایه •

 های میانبر جدول دکمه

 به دردت میخوره!! 
 (Shortcut) میانبر ابزار یا عملکرد توضیح ساده و عامیانه 

 M ای مستطیلی یا دایره Marquee Tool انتخاب ناحیه به شکل مستطیل یا دایره

 Lasso Tool L صورت آزاد و دستی انتخاب ناحیه به

 Quick Selection / Magic انتخاب هوشمند یا خودکار نواحی مشابه

Wand 
W 

 Crop Tool C برش عکس یا کادر 

 Eyedropper Tool I گرفتن رنگ از یه نقطه از تصویر 

 Brush Tool B آمیزی مو برای طراحی یا رنگقلم

 Eraser Tool E کنپاک

کپی گرفتن از یه بخش و چسبوندن به جای  

 دیگه 
Clone Stamp Tool S 

 ,Healing Tools (Spot Healing ابزارهای روتوش و ترمیم 

Patch...) 
J 

 Gradient Tool / Paint Bucket G ابزار گرادیانت یا سطل رنگ

 Text Tool T نوشتن متن

 Pen Tool P طراحی دقیق مسیر و شکل

 Free Transform Ctrl + T تغییر اندازه، چرخش، یا تغییر شکل لایه 

 Deselect Ctrl + D لغو انتخاب 

 Duplicate Layer Ctrl + J کپی گرفتن از لایه انتخاب شده

 Undo / Redo Ctrl + Z یه مرحله برگشت یا جلو رفتن

 [ و  ] افزایش یا کاهش سایز براش موکوچیک و بزرگ کردن قلم

 Save Ctrl + S ذخیره پروژه 

 New File Ctrl + N ایجاد فایل جدید 

 Open File Ctrl + O باز کردن فایل
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 جانبی  Adobe افزارهایارتباط فتوشاپ با نرم

1. Adobe Illustrator 

 

طراحیبرنامه • برای  برداریای  آیکون،   (Vector) های  لوگو،  مثل 

 های گرافیکی های هندسی و طراحیشکل

کنی   ار Illustrator (.ai) هایفایل  دنی اتومی • فتوشاپ  تو    د وارد  و 

 دیا افکت بذاری دفتوشاپ روشون رنگ بزنی 

  دکنی  Illustrator تونی از فتوشاپ تصاویرت رو وارد برعکس، می •

 دهای برداریبرای طراحی

می • باعث  برنامه  دو  این  طرحهمکاری  زیبا  شه  هم  و  دقیق  هم  هات 

 ، با امکان ویرایش آسان دباشن 

 

۲. Adobe Lightroom 

 

حرفهبرنامه • ویرایش  و  مدیریت  برای  تخصصی  عکس ای  ها،  ای 

 مخصوص عکاسان 

می • اجازه  ر عکس   ددهبهت  خراب   اها  )بدون  غیرمخرب  و  سریع 

 د کردن فایل اصلی( ویرایش کنی 

به فتوشاپ    دنی اتورو می Lightroom های ویرایش شده درعکس  •

ویرایش   دبفرستی  حرفهبرای  دقیقایهای  و  یا تر  روتوش  )مثل  تر 

 تغییرات خاص( 
 

 برگردونی برای مدیریت بهتر آرشیو  Lightroom تونی دوباره عکس رو بهبعد از ویرایش در فتوشاپ، میت

 های جدید(ابزارهای جدید فتوشاپ )نسخه

1. Neural Filters 

o فیلترهای هوش مصنوعی برای روتوش خودکار، تغییر حالت چهره، تغییر سن، حالت لبخند و... 

o هیدبد دنی اتو خیلی سریع و با کیفیت بالا تغییرات خلاقانه می. 

2. Sky Replacement 

o کردن سخت بدون نیاز به ماسک یدراحتی آسمان عکس رو عوض کنبه 

o ودشآسمان جدید با نور و رنگ محیط هماهنگ می. 

3. Object Selection Tool   بهبود یافته 

o تر اشیا با کمک هوش مصنوعی انتخاب هوشمندتر و دقیق 
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o دها رو جدا کنی سوژه دنی اتو تر میراحت. 

4. Pattern Preview 

o  نمایش و طراحی الگوهای تکرارشونده در لحظه پیش 

o است گراند و بافت خیلی عالیبرای طراحی پارچه، بک. 

5. Live Shapes 

o ها و زوایاتغییر سریع و آسان اشکال برداری با کنترل بیشتر روی گوشه 

o مناسب طراحی دقیق و سریع. 

6. Content-Aware Fill Workspace  بهبود یافته 

o  های حذف شدهمحیطی جدا برای پرکردن هوشمندانه بخش 

o برداری و نتایج بهتربا کنترل بیشتر روی نمونه. 

تر و های جدید فتوشاپ بیشتر روی هوش مصنوعی، سهولت کار و ویرایش هوشمند تمرکز دارند تا کار تو سریعنسخه

 .شودتر  خلاقانه

 افزارهای جایگزین فتوشاپ روی موبایل نرم

1. Adobe Photoshop Express 
o  نسخه سبک و ساده فتوشاپ مخصوص موبایل 

o  امکانات ویرایش عکس مثل برش، فیلتر، اصلاح نور و رنگ، حذف لکه 

o ای برنامهرایگان با قابلیت خرید درون 

 
 

2. Adobe Photoshop Mix 

o ای و ترکیب تصاویربرای ویرایش لایه 

o ها و مونتاژ عکسقابلیت جدا کردن سوژه 

o  تمرکز روی ویرایش ترکیبی و سریع 

  

3. Snapseed  توسط گوگل 

o ای ویرایش عکساپ قوی و رایگان با امکانات حرفه 

o ابزارهای دقیق مثل تنظیم نور، کنتراست، فیلترهای مختلف، و ابزار Healing 

 ها برای حذف لکه
 

4. PicsArt 

o های جذاب امکانات ویرایش عکس، طراحی گرافیکی، افکت 

o مو، و استیکرهای متنوع ها، قلمقابلیت کار با لایه 

o گذاری آثار فضای اجتماعی برای به اشتراک  
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5. Lightroom Mobile 

o ای رنگ و نور مخصوص عکاسان ویرایش حرفه 

o سینک با نسخه دسکتاپ Lightroom 

o می که  کسانی  عکس مناسب  بالا  خواهند  دقت  با  رو  ها 

 ویرایش کنن

 

6. Pixlr 

o ویرایش سریع و ساده با فیلترها، ابزارهای روتوش و ترکیب تصویر 

o مناسب برای کسانی که دنبال ویرایش سریع و کاربردی هستند . 

 

 بندی جمع

  ی اند. هرچند ممکن است برخ شده  ی طراح  لیبر بستر موبا  ریآسان و قابل حمل تصاو  ع،یسر  شیرایو  یافزارها برانرم  ن یا

  ار ی بس  ست، ی ن  انه یبه را  یکه دسترس   یمواقع   ای  ی ارحرفهی کاربران غ   یفتوشاپ را نداشته باشند، اما برا  شرفتهی پ  ی هاتی قابل

 و مؤثر هستند.  یکاربرد

 

 های نهایی فتوشاپ تمرینات عملی و پروژه 

 ها و ابزارهای مختلفراحی یک پوستر با استفاده از لایهط .1

 )مثلًا معرفی یه کنسرت یا جشن(  یدموضوع ساده انتخاب کن کی •

 یدبرای نوشتن عنوان و توضیحات استفاده کن Textاز ابزار  •

 ید جذاب کن  اگراند ربک Filterو  Brush  ،Shapeبا ابزارهای  •

 یدبرای تغییر رنگ و نور استفاده کن Adjustment Layersاز  •

 بماندو اسم بزار تا پروژه تمیز و قابل ویرایش  یدمرتب کن اها رحتماً لایه •

 ساخت کلاژ تصویر و ترکیب تصاویر مختلف .۲

 یدچندتا عکس با موضوع مشابه )طبیعت، شهر، پرتره و...( جمع کن  •

 ید رو جدا کن  هیدخواهایی که میقسمت Layer Maskو  Selectionبا ابزار  •

 یدهای جالب بسازترکیب Opacityو   Blending Modesو با  یدکنار هم بچین اتصاویر ر •

 د استفاده کن تا همه تصاویر رنگ و نور هماهنگ داشته باشن  Adjustment Layersاز  •

 . شودتا عمق بیشتری ایجاد   دها اضافه کنی به لایه Strokeیا  Drop Shadowکمی   دنی اتومی •
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 طراحی لوگو برای یک برند فرضی  .۳

 )مثلًا برند لباس یا کافه( یدموضوع و نام برند رو فرضی انتخاب کن  •

 ید های ساده درست کن شکل Shape Toolبا ابزار  •

 ید و فونت مناسب انتخاب کن یداضافه کن  Text Toolمتن لوگو رو با  •

 د های سفارشی طراحی کنی شکل دنی اتومی Path Toolبا  •

 دیادماندنی باشلوگو ساده، قابل خواندن و به یدسعی کن  •

 ید های مناسب براش انتخاب کن رنگ Gradientو  Color Pickerدر نهایت با ابزارهای   •

 هاسایتطراحی بنرهای تبلیغاتی برای وب .۴

 پیکسل( ۲50×300یا  ۹0×7۲8)مثلًا   یداندازه بنر رو مشخص کن  •

 یداز تصاویر جذاب و مرتبط استفاده کن •

 یدمتن تبلیغاتی کوتاه و گیراتر بنویس •

 یدبرای زیباتر شدن استفاده کن Strokeو  Shadow ،Glowمثل  Layer Stylesاز  •

 )مثلًا “همین حالا بخر!”(  دواضح داشته باش Call to Action دکمه یا •

 شود و سریع بارگذاری  دتا حجمش کم باش یدبنر رو بهینه کن  •

 :هاهای مهم برای همه پروژهنکته 

 ید و مرتب کن یداستفاده کن ها لایهحتماً از  •

 دبعدا ویرایش کنی دنی اتا بتو PSD با فرمت یدذخیره کن  اها ر پروژه  •

 گذاریبرای اشتراک یدذخیره کن  PNG یا JPG با فرمت افایل نهایی ر •

 د تا تجربه بیشتری کسب کنی   یدخلاق باش و از ابزارهای مختلف استفاده کن  •
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 جادوی پایتون 

 

Python 
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پایه مباحث  با  شما  هفتم،  پایه  برنامهدر  مانندای  شرطی عملگرها، متغیرها، نویسی   if-else و   if-elif ساختارهای 

آشنا شدید. همچنین، یاد گرفتید چگونه اطلاعات را از کاربر دریافت کنید و نتایج را روی   for مانند های تکرارحلقه و

 .صفحه نمایش دهید

 ساختارهای داده -1 درس

  !نویسیجادوگران دنیای برنامه

را مثل یک جادوگر در یک ساختار فشرده و  ها، صدها، یا حتی هزاران دادهده اید که بتوانیدآیا تا به حال آرزو کرده

دهند! بیایید با هم  دقیقاً همان ابزارهای جادویی هستند که به شما این قدرت را می ساختارهای داده هوشمند ذخیره کنید؟

 :انگیز بیندازیمنگاهی جذاب و کاربردی به این دنیای شگفت

 

 ۱تصویر

 

  ! جعبه جادویی چندکشویی (List) ـ لیست . 1

 !های دیگرتوانید داخل آن هرچیزی بگذارید: اعداد، کلمات، حتی جعبهدارید که می جعبه چوبی تصور کنید یک

 :هاویژگی

 .ها مهم است )مثل صف فیلم سینما(آیتم ترتیب •

 .توانید چیزی اضافه، کم یا عوض کنید(است )می قابل تغییر •

 .داردمختلف را با هم نگه می چندین نوع داده •

 مثال: 

 

 ۲تصویر
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 3تصویر

 ! گاوصندوق امن (Tuple) ـ تاپل .۲

 !توانید آن را تغییر دهیدکه وقتی چیزی داخلش گذاشتید، دیگر نمی فولادی محفظه یک

 :هاویژگی

 .مثل اطلاعات هویتی افراد ثابت و ایمن  •

 .هااز لیست برای دسترسی به داده ترسریع  •

 !دفترچه مخفی  - (Dictionary) دیکشنری . ۳

 !کندذخیره می کلید خاص که هر اطلاعاتی را با یک رمزگذاری شده دفترچه یک

 :هاویژگی

 .خانه با کلید، نه شماره  !برهم زدنیافتن اطلاعات در یک چشم •

 .های پیچیدهبرای داده منظم و بهینه •

  مثال:

 

 4تصویر

  !یکتایِ رنگی جعبه  (Set)ـ  مجموعه .۴

 !کندمی خودکار حذف ها رادارد و تکراریرا نگه می فردمنحصربه که فقط چیزهای جعبه خاص یک

 :هاویژگی

 .فردهای منحصربهآوری ایمیلمثل جمع های تکراریحذف خودکار داده •

 .اجتماع، اشتراک، تفاوت عملیات ریاضی •

 مثال: 

 

 5تصویر
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 های اضافه کردن آیتم به لیست روش  -۲ درس

 :مثال ساده یک لیست 

 

 6تصویر

 ! جدیدی به این لیست اضافه کنیم  هایآیتمیم هخوا حالا می

 افزودن به انتهای لیست  ()appendاستفاده از  .1

 .استفاده کنید ()append اگر بخواهید یک آیتم به انتهای لیست اضافه کنید، از 

 

 : خروجی

 

 

 7تصویر

 .کندفقط یک آیتم در هر بار اضافه می ()append ::نکته 

 برای افزودن آیتم در یک موقعیت خاص   ()insertاستفاده از  .2

 .دهدشده قرار میمقدار جدیدی را در اندیس مشخص   insert(index, value)متد 

 

 

 8تصویر
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 .کندآیتم جدید را در هر موقعیتی که تعیین کنیم اضافه می :ویژگی

 برای افزودن چند آیتم از یک لیست دیگر  ()extendاستفاده از  .3

 کند.یک لیست دیگر را به انتهای لیست اصلی اضافه می ()extendمتد        

 

 ۹تصویر

 .کندصورت یکجا اضافه میچندین مقدار را به :ویژگی

 ها برای ترکیب لیست + استفاده از عملگر  .4

 .تواند دو لیست را با هم ترکیب کند و یک لیست جدید بسازدمی  +عملگر 

 

 ۱0تصویر

 

 برای افزودن چند آیتم به لیست اصلی  =+استفاده از  .5

 کند.کند و چندین مقدار را به انتهای لیست اضافه میعمل می  ()extendعملگر += نیز مانند 

 

 ۱۱تصویر
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 استفاده از * برای تکرار لیست و افزودن مقادیر مشابه  .6

 توانیم از * استفاده کنیم. اگر بخواهیم یک مقدار را چندین بار به لیست اضافه کنیم، می

 

 ۱۲تصویر

 هابرای افزودن آیتم list comprehensionاستفاده از  .7

 وجور برای ایجاد و افزودن مقادیر به لیست است. ( روشی جمعList Comprehensionلیست کامپرهنشن )

 

 ۱3تصویر

های مختلف مقایسه روش  
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 : کار در کلاس

 نتیجه کد  زیر چه خواهد بود؟

 

 پاسخ :  

 

 

 .استفاده کنید "fruits" به لیست  "orange" برای اضافه کردن "append" از متد

 

 پاسخ :

 

 تمرین:

اضافه کند. سپس لیست را   friendsها را به لیست دوستش را دریافت کند و آن 3ای بنویسید که از کاربر نام برنامه

 نمایش دهد.  
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 آموزش حذف آیتم از لیست در پایتون -۳ درس

هایشان را اضافه، حذف یا جایگزین کرد. در این  توان آیتمهستند، یعنی می (mutable) ها در پایتون قابل تغییرلیست

 !کنندهها را از لیست حذف کنیم اما به روشی جذاب و سرگرمگیریم چگونه آیتمدرس، یاد می

  "پشتی مدرسهپاکسازی کوله"

خواهید وسایل اضافی را از داخل آن حذف کنید تا فقط چیزهای مهم  اید و می پشتی خود را باز کرده»تصور کنید کوله

 های غیرضروری را از یک لیست حذف کنیم! توانیم آیتمبمانند. در پایتون هم می

 بیایید یاد بگیریم چطور این کار را انجام دهیم!  

 های حذف آیتم از لیست در پایتون روش

 در پایتون، چندین روش مختلف برای حذف آیتم از لیست وجود دارد: 

 شدهحذف مقدار مشخص – ()removeاستفاده از  .1

 کند. شده را از لیست حذف میاین متد اولین مقدار مشخص

 

 ۱4تصویر 

 :ویژگی

 کندشده را حذف میفقط اولین مقدار یافت ➢

 دهد. ( میValueErrorاگر مقدار وجود نداشته باشد، خطا ) ➢

 

 

 حذف با استفاده از اندیس – ()popاستفاده از   .2

 گرداند.شده را برمی( حذف کرده و مقدار حذفindexاین متد یک آیتم را بر اساس اندیس )
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 ۱5تصویر

 :ویژگی

 .گرداندشده را برمیمقدار حذف ➢

 .دهدمی (IndexError) اگر اندیس معتبر نباشد، خطا ➢

 شود. بدون مقدار باشد، آخرین آیتم حذف می ()popاگر  ➢

 حذف یک یا چند آیتم با استفاده از اندیس – del استفاده از  .3

 شود. ها یا حتی کل لیست استفاده میاین روش برای حذف یک آیتم خاص، یک بازه از آیتم

 

 ۱6تصویر

 هاحذف همه آیتم – ()clearاستفاده از  .4

 کند.این متد لیست را کاملًا خالی می

 

 

 ۱7تصویر
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 های مختلف حذف آیتم از لیستمقایسه روش

 

 بازی جذاب برای تمرین 

 "!پاکسازی اتاق"

اتاق شما خیلی شلوغ شده است و باید وسایل اضافی را حذف کنید! یک لیست از وسایل اتاق خود داشته باشید و به  

 .ها را حذف کنیدهای بالا آنکمک روش

 :مثال کد اولیه 

 

 ۱8تصویر

 

پیام   نبود،  لیست  در  آیتمی  اگر  که  دهید  تغییر  را طوری  نیست!"برنامه  اتاق  در  وسیله  داده شود  "این  قابلیت    .نمایش 

 را نیز اضافه کنید.   delو  popحذف با 

شده را حذف کند تا فقط  یک برنامه بنویسید که لیستی از وظایف روزانه داشته باشد. کاربر بتواند کارهای انجام :پروژه 

 مانده نمایش داده شوند. کارهای باقی
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 در پایتون!    if ... elseهای  شرط  -۴ درس

روید، ولی اگر کم باشد،  اید که وقتی امتیاز شما بالا باشد، به مرحله بعد میهای ویدیویی دیدهآیا تا به حال در بازی
 شود؟بازی تمام می

 دهیم! انجام می if ... elseنویسی با این دقیقاً همان چیزی است که در برنامه
if ... else گیری کنیمدهد تصمیمبه ما اجازه می: 

   "( کار دیگری را انجام بده!else( یک شرط برقرار بود، یک کار را انجام بده، وگرنه )ifاگر )"
  if چیست؟ 

if در پایتون یک شرط را بررسی می ( کند و اگر درست باشدTrueکد داخل آن اجرا می ،)شود. 

 

 
 

 ۱۹تصویر

else چیست؟ 

 .شود اجرا می elseباشد، کد داخل  (False) غلط  ifاگر شرط 

 

 ۲0تصویر

 :کندهای منطقی معمول در ریاضیات پشتیبانی میپایتون از شرط

 a==bمساوی :  •

 a!=bنامساوی :  •

 a<bکمتر از :  •

 a<= bبیشتر یا مساوی :  •

 a>bبزرگتر از :  •

 a>=bبزرگتر یا مساوی :  •

ها هستند.  و حلقه  "ifدستورات شرطی  "ها در  ترین آنهای مختلفی استفاده شوند که رایجتوانند به روشها میاین شرط

 شود. نوشته می ifبا استفاده از کلیدواژه  "if"دستور شرطی 
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 مثال: 

 
 ۲۱تصویر

نام به  متغیر  از دو  مثال،  این  از دستور شرطی  استفاده می  bو    aهای  در  آیا    ifکنیم که بخشی  بررسی شود  تا    bهستند 

  33بزرگتر از  ۲00دانیم که است، می ۲00برابر با  bو مقدار  33برابر با  aاست یا خیر. با توجه به اینکه مقدار  aبزرگتر از 

 شود. ( روی صفحه چاپ می"است  aبزرگتر از  b")یا  "b is greater than a"است؛ بنابراین، عبارت 

نویسی دیگر برای تعریف حوزه کد های برنامهپایتون به جای استفاده از علائمی مانند آکولادها )که در بسیاری از زبان

کنند که کدام بخش  ها تعیین میشوند(، به تورفتگی )فضای خالی در ابتدای خط( متکی است. این تورفتگیاستفاده می

 .از کد درون یک بلوک یا حوزه قرار دارد

برای مشخص کردن شروع و پایان یک بلوک کد استفاده   {}، از آکولادها  C هایی مانند جاوا یا به عنوان مثال، در زبان

الزامی است و در صورت عدم رعایت آن، کد می پایتون، تورفتگی صحیح )مثلًا چند فاصله یا یک تب(  اما در  شود، 

 .اجرا نخواهد شد یا با خطا مواجه خواهد شد
 :  هددکد به ما خطا می دن به تورفتگی نباش ابه طور مثال اگر ما کد زیر را بنویسم و حواسم

 
 ۲۲تصویر

  . نید های قبلی درست نبودند، آنگاه این شرط را امتحان کاگر شرط  : در پایتون روشی است برای بیان اینکه  elif کلیدواژه 

 
 ۲3تصویر

بررسی کنیم. این کلیدواژه مشابه    ifهای اضافی را پس از یک دستور  دهد تا شرطبه ما امکان می  elifبه عبارت دیگر،  

else if  برنامهدر برخی زبان استفاده میهای  شود که بخواهیم چندین سناریوی مختلف را  نویسی دیگر است و زمانی 

 بررسی کنیم.
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 (Short Hand If) دستور شرطی کوتاه -۵ درس

 بنویسید.  ifتوانید آن را در همان خط دستور اگر فقط یک دستور برای اجرا داشته باشید، می

 

 ۲4تصویر

 If...Else  دستور شرطی کوتاه 

 توانید همه آن را در همان خط بنویسید:، میelseو یکی برای  ifاگر فقط یک دستور برای اجرا داشته باشید، یکی برای 

 .را در همان خط بنویسید else توانید چند دستورا همچنین میشم

 

 ۲5تصویر

 :دستور شرطی یک خطی با سه شرط •

 

 ۲6تصویر

 :شودیک عملگر منطقی است و برای ترکیب دستورات شرطی استفاده می and کلمه کلیدی •

 
 

 ۲7تصویر



 

150 
 

 :شود یک عملگر منطقی است و برای ترکیب دستورات شرطی استفاده می or کلمه کلیدی •

 

 ۲8تصویر

 :شودیک عملگر منطقی است و برای برعکس کردن نتیجه دستور شرطی استفاده می not کلمه کلیدی •

 

 ۲۹تصویر

  قرار دهید، این کار با نام دستورات شرطی تو در تو ifرا درون دیگر دستورات  ifتوانید دستورات شما می •

(nested if statementsشناخته می ) .شود 

 

 30تصویر

 pass دستور •

استفاده    passبدون محتوا داشته باشید، از دستور    ifتوانند خالی باشند، اما اگر به هر دلیلی یک دستور  نمی  ifدستورات  

 کنید تا از بروز خطا جلوگیری شود.

 

 3۱تصویر
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 الگوسازی ساختاری در پایتون  -۶ درس

عملیات   matchدستور   انجام  شرطبرای  اساس  بر  مختلف  مختلف  های  های 

بسیاری از دستورات    .شوداستفاده می توانید از دستور  ، میif..elseبه جای نوشتن 

match    دستور کنید.  اجرا    matchاستفاده  برای  را  کد  بلوک  چندین  از  یکی 

 کند.انتخاب می

 نحوه کار: 

دستور • در  شده  نوشته  عبارت  ارزیابی   match ابتدا  و  محاسبه  بار  یک 

 .شودمی

 .شودمقایسه می case هایپس از بدست آمدن مقدار آن، این مقدار با هر یک از مقادیر موجود در بخش  •

 case ها تطابق داشته باشد ، بلوک کد مربوط به آنcase با یکی از match در صورتی که مقدار عبارت •

 .شوداجرا می

 است( اجرا خواهد شد. else)که معادل   caseاگر هیچ تطابقی وجود نداشته باشد،  •

 چاپ کنیم:   7تا  ۱خواهیم نام روز هفته را بر اساس یک عدد بین مثال : فرض کنید می

 

 3۲تصویر

 

 

match expression: 

  case x: 

    code block 

  case y: 

    code block 

  case z: 

    code block 

 

Syntax  

 

https://www.w3schools.com/python/python_server.asp
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 (Default Case) فرضمقدار پیش

ها با عبارت ورودی تطبیق  case یک از مقادیر مشخص شده دراگر بخواهید یک بلوک کد زمانی اجرا شود که هیچ

باشد، می بخش نداشته  از آخرین  کنید :_ case توانید  پیش   .استفاده  مقدار  عنوان  به  بخش  میاین  و  فرض عمل  کند 

 کند.کار می  ifدر دستورات  elseدقیقاً مثل 

 ترکیب مقادیر 

( استفاده کنید تا چند مقدار را در یک  or( به عنوان عملگر یا )|)  "لوله "توانید از کاراکتر  ، میcaseدر هنگام ارزیابی  

 حالت بررسی کنید: 

 

 33تصویر

 : (Guards)   های حفاظتیبه عنوان شرط if دستورات

 را نیز اضافه کنید تا یک بررسی شرطی اضافی انجام دهید: if، یک دستور caseتوانید در هنگام ارزیابی  می

 

 

 34تصویر
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 در پایتون  whileهای حلقه  -۷ درس
 :پایتون دو دستور حلقه اصلی دارد

 while هایحلقه •

 forهای حلقه •

ای از دستورات را تکرار کنیم، به شرطی که یک شرط خاص )شرط حلقه(  توانیم مجموعهمی while با استفاده از حلقه

 .برقرار باشد

 مثال: 

 

 

 35تصویر

توانیم حلقه را متوقف کنیم، حتی اگر  می break با استفاده از دستور   حالا اگه بخواهیم جلوی ادامه حلقه را بگیریم، 

 :هنوز برقرار باشد while شرط

 
 

 36تصویر
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 توانیم تکرار فعلی از حلقه را متوقف کنیم و به تکرار بعدی برویم:می  continueبا استفاده از دستور 

 

 37تصویر

 :توانیم یک بلوک کد را یک بار اجرا کنیم، زمانی که شرط حلقه دیگر برقرار نباشدمی  elseبا استفاده از دستور 

 

 38تصویر
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 در پایتون  for هایحلقه  -۸ درس

،  (tuple) ، تاپل(list) تواند یک لیستشود که میاستفاده می (sequence) برای پیمایش روی یک دنباله forحلقه  

مجموعه(dictionary) دیکشنری  ، (set) رشته دستور  .باشد (string) یا یک  شبیه  کمتر  حلقه  سایر   for این  در 

های  کند همانگونه که در برخی از زبانعمل می (iterator) نویسی است و بیشتر مثل یک روش ایتریتورهای برنامهزبان

توانیم یک مجموعه از دستورات را برای هر آیتم از یک لیست، تاپل،  می  forبا استفاده از حلقه  .شودشیءگرا دیده می

 مجموعه و غیره اجرا کنیم.

 

 3۹تصویر

اندیس  for حلقه متغیر  یک  که  ندارد  کنیدنیازی  تنظیم  شروع  از  قبل  را  زبان  .گذاری  بعضی  برخلاف  های  یعنی 

( رو تعریف و مدیریت کنی، در پایتون این کار به صورت  = i  0باید خودت شمارنده )مثل  forنویسی که در حلقه  برنامه

توانیم حلقه را قبل  می breakخودکار و داخلی انجام میشه و نیازی نیست دستی متغیر اندیس بسازی. با استفاده از دستور  

 ها پیمایش شوند، متوقف کنیم: از اینکه تمام آیتم

 

 40تصویر

 توانیم تکرار فعلی از حلقه را متوقف کنیم و به تکرار بعدی برویم:می  continueبا استفاده از دستور 

 

 4۱تصویر
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 range  تابع

یک   ()rangeتابع   .استفاده کنیم ()range توانیم از تابعبرای اجرای یک مجموعه دستورات به تعداد مشخصی بار، می
کند و تا  شود، هر بار یک واحد افزایش پیدا میشروع می  0فرض از عدد  گرداند که به صورت پیش سری اعداد را برمی

 یابد.عدد مشخص شده قبل از رسیدن به آن ادامه می

 

 4۲تصویر

پیش به ()range تابع مقدار  طور  از  اما میشروع می  0فرض  با اضافه کردن  کند،  مقدار شروع را مشخص کنید  توانید 
 نیست(. 6)اما شامل عدد  6تا  ۲یعنی مقادیر از range(2,6)مثلًا  :یک پارامتر

 

 43تصویر

پیش به ()range تابع میطور  ایجاد  واحد  یک  افزایش  با  را  اعداد  دنباله  میفرض  اما  )گام  کند،  افزایش  مقدار  توانید 
شروع شوند و هر    ۲یعنی مقادیر از    range(2,30,3) مثلاً  :حرکت( را با اضافه کردن یک پارامتر سوم مشخص کنید

کند که زمانی اجرا  یک بلوک کد را مشخص می  forدر حلقه    else.کلمه کلیدی  30واحد اضافه شود، تا قبل از    3بار  
 شود که حلقه به پایان برسد.می

 

 44تصویر

شود  حلقه داخلی یک بار کامل اجرا می .یعنی یک حلقه درون یک حلقه دیگر (Nested Loop) یک حلقه تو در تو
 برای هر تکرار از حلقه خارجی. 

 

 45تصویر
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 توابع در پایتون -۹  درس

های  توانید ورودیشما می  .شوند که فراخوانی شوندهایی از کد هستند که فقط زمانی اجرا میدر پایتون، توابع قسمت

  defدر پایتون، یک تابع با استفاده از کلمه کلیدی   گرداند.مختلفی به یک تابع بدهید و آن تابع یک خروجی را بر می

 شود: تعریف می

 

 46تصویر

توانید هر زمان که نیاز داشتید، با نام آن تابع  دهد یک بلوک از کد را تعریف کنید که میاین ساختار به شما امکان می

 :برای فراخوانی یک تابع، از نام تابع دنبال شده توسط پرانتز استفاده کنید .فراخوانی کنید

 

 47تصویر

 

ها بعد از نام تابع و درون پرانتز مشخص  آرگومان.داد (arguments) ها توان به توابع به عنوان آرگومانطلاعات را میا

مثال زیر یک   .ها را با کاما از هم جدا کنیدتوانید هر تعداد آرگومان که بخواهید اضافه کنید، فقط آنشوند. شما میمی

( آرگومان  با یک  می fnameتابع  نشان  می(  فراخوانی  تابع  وقتی  )دهد.  اول  نام  یک  داده first nameشود،  آن  به   )

 شود: شود که درون تابع برای چاپ نام کامل استفاده میمی

 

 48تصویر
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 پارامتر یا آرگومان؟ 

استفاده می "(argument) آرگومان"و   "(parameter) پارامتر"عبارات   معنا  به یک  به  اغلب  شوند: اطلاعاتی که 

 .شوندیک تابع داده می

 :اما از دید یک تابع

 .شودپارامتر متغیری است که درون پرانتز در هنگام تعریف تابع نوشته می

 شود. آرگومان مقداری است که هنگام فراخوانی تابع به آن ارسال می

 ها: تعداد آرگومان

  ۲این به این معناست که اگر تابع شما    .ها فراخوانی شودفرض، یک تابع باید با تعداد صحیحی از آرگومانبه طور پیش 

 آرگومان به آن بدهید نه بیشتر و نه کمتر.  ۲آرگومان انتظار دارد، شما هم باید دقیقاً 

 

 4۹تصویر

  های دلخواهآرگومان

تابع شما داده میاگر تعداد آرگومان به  پارامتر در تعریف تابع  شوند را نمیهایی که  نام  دانید، یک ستاره ) * ( قبل از 

درستی دسترسی  ها را دریافت کند و بتواند به عناصر آن بهشود تابع یک تاپل از آرگوماناین روش باعث می.اضافه کنید

 داشته باشد: 

 

 50تصویر
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می • آرگومانشما  بدهید.توانید  تابع  به  )کلید=مقدار(  سینتکس  از  استفاده  با  را  ترتیب    ها  ترتیب،  این  به 

 .داند هر مقدار مربوط به کدام پارامتر استها دیگر مهم نیست ، چون پایتون میآرگومان

 

 5۱تصویر

استفاده   return ای( را به جای خود بازگرداند، از دستوربرای اینکه یک تابع بتواند یک مقدار )یا هر نوع داده •

 تواند نتیجه یک محاسبه، یک متغیر، یک لیست، یک عدد، یک رشته و غیره باشد.این مقدار می .کنیممی

 

 5۲تصویر

 

 ( چیست؟ Lambdaتابع لَمبدا)

  دارد   تواند هر تعداد آرگومان داشته باشد، اما فقط یک عبارتاین تابع می .است  نامتابع لَمبدا یک تابع کوچک و بی

 و ساختار کلی آن به صورت :  

 

 مثال :

 

 53تصویر
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تر و بدون نام )در حالت عادی( است. پس زمانی که نیاز  تفاوت لَمبدا این است که کوتاه    :لَمبدا در مقایسه با تابع عادی

 مصرف داریم، لَمبدا کاربرد دارد. باربه یک تابع کوچک و یک

 :کاربردهای رایج لَمبدا

 روزرسانی همه عناصر یک لیست : به  ()mapاستفاده با  •

 

 54تصویر

 : فیلتر کردن عناصری که شرط مشخصی را دارند ()filterاستفاده با  •

 

 55تصویر

 : مرتب کردن لیست بر اساس یک قانون خاص  ()list.sortیا  ()sortedسازی با مرتب •

 

 56تصویر

 .استفاده در توابع دیگر به عنوان آرگومان : زمانی که یک تابع دیگر به یک تابع کوچک نیاز دارد •

 

 57تصویر
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 یک مثال کامل و کاربردی :  

 :خواهیمآموزان داریم که شامل نام و معدل هر کدام است. میفرض کنید یک لیست از دانش 

 .دارند را فیلتر کنیم ۱8آموزانی که معدل بالای فقط دانش  •

 .آموزان را به حروف بزرگ تغییر دهیماسم دانش  •

 لیست را براساس معدل مرتب کنیم.  •

 

 

 58تصویر
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 های آینده تکنولوژی
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 هوش مصنوعی

 

 

 

 

 

 های کوانتومیمحاسبات و رایانه 

 تشخیص چهره و بینایی رایانه ای ماشین لرنینگ

 هاهای صوتی و چت بات رابط  اینترنت اشیاء 

 هاپیماهای بدون سرنشین  بیگ  دیتا

 فناوری نانو و علم مواد بلاگچین 

 های هوشمندلباس  گرافن 

 امنیت سایبری سیمبرق بی 

 وسایل نقلیه خودران رایانش ابری

 های پوشیدنیگجت  واقعیت مجازی

 ایهمچوشی هسته  6Gو    5Gاینترنت  

 کشاورزی مدرن و هوشمند دوقلوهای دیجیتالی

 های دیجیتالعامل سیستم  همکاری انسان و ربات

 ژنومیک و جهش ژنتیکی موجودات زنده   بعدی، چهاربعدی و ساخت مواد طبیعی چاپ سه 

 

 های نوینتکنولوژی  -1 درس

  زی ن ندهی ما هستند و در آ یحالا در حال دگرگون ساختن زندگ   ن یکه هم ا ی روز دن ی هایاز فناور ی ابا مجموعه میخواهیم

تا    کندیهوشمند عمل م  تالیجیمغز د  کیکه همچون    ی ! از هوش مصنوعمیقرار است جهان را متحول کنند، آشنا شو

سه توانا  یبعدچاپ  حت  ییکه  و  خانه  دا  یساخت  را  آسان  یزندگ  هایفناور  ن یا   رد،غذا  جذابرا  پاتر،  و   دارتریتر 

اسازندیم ن  هایفناور  ن ی.  ابزار  راهکارها  ستند،ی صرفاً  بزرگ   یبرا  ین ینو  ی بلکه  مشکلات    ن، یزم  ش یگرما  ری نظ  یحل 

 یو چه کاربرد  ستندی چ  هایفناور  ن یا  دی اب یتنها دراست که نه  ن ی. هدف ادهندیما قرار م  اری در اخت  هایماری ب   ای  یگرسنگ

انگ بلکه  ن  یروز  دیتا شا  دی کن  دای پ  زهی دارند،  ا  یا دهیا  زی خود شما    ی. پس کمربندهادی ها خلق کنحوزه  ن ینوآورانه در 

 ! میقرار دار یفناور  یندهیبه آ زی انگ جانیه  یسفر یچرا که در آستانه د،یخود را ببند
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 : (AI)  یمصنوع هوش

 

 

 

 

 

 

 
 

م   تال ی جیهوشمند د مغز فوق   ک ی همچون    ی هوش مصنوع  انجام دهد که   یی و کارها   اموزد ی ب  شد، ی اند ی ب   تواند ی است که  را 

انسان   تر ش ی پ  به تنها  بودند.  انجام آن  به  قادر  زمان ها  مثال،  نتفل  ی عنوان  باز   ا ی   شود، ی م   شنهاد ی پ  ی لم ی ف  کس ی که در   ی ها ی در 

م   یوتر ی کامپ  مبارزه  باهوش  دشمنان  مصنوع  ن یا   د،ی کن ی با  فعال  ی هوش  حال  در  که  در حوزه   ت ی است   ،ی پزشک  ی است. 

باسکن   ل ی با تحل  تواند ی م  ی هوش مصنوع تشخ  ترع ی را سر   ها ی مار ی ها،  پزشکان   AIخودران،    ی دهد. در خودروها   ص ی از 

تا   کند ی ز کمک می ها )مانند من!( نبات در چت   ی که در کجا گردش کند. حت   رد ی گ ی م  م ی و تصم  کندی را مشاهده م   ر ی مس 

ها، الگوها را از داده   یی از حجم بالا   ی ر ی گبا بهره   ی . هوش مصنوعم یی تان را برطرف نما و مسائل   م ی با شما گفتگو کن   م ی بتوان

 ، ی علم   ی ده ی چی زمان گرفته تا حل مسائل پ  ت ی ر ی روزمره، از مد  ی . در زندگبخشد ی کرده و عملکرد خود را بهبود م  یی شناسا 

 قدرتمند است.   ی ها انه ی فراوان و را   یها داده   ازمند ی ن   اکاربرد دارد. تنه 

   :نگرش آینده

ما حضور داشته باشد.   ی زندگ  ی هاجنبه   یهوشمند در تمامفوق   ار ی دست   کی قرار است همچون    یهوش مصنوع   نده،یدر آ 

بلکه احساسات شما را   دهند، ی خانه را انجام م  ت ی ر ی مد   ا ی   ی همچون رانندگ  ی ا تنها امور روزمره که نه   ییها ربات   د ی تصور کن 

 ش ی را پ   های ماری ب  ،ی پزشک  یدر حوزه   تواندی م  ی! هوش مصنوع کنند ی دوست با شما گفتگو م   ک ی و مانند    کنندی درک م 

شناسا  بروز  شهرها   ییاز  در  تراف  ی کند،  انرژ   ک ی هوشمند  مصرف  به  ی و  حت   نه ی را  و  جهان   ی سازد  مسائل  مانند   ی در حل 

 ن ینو   ییاهکارها ر  ، یم ی اقل   ی الگوها   ل ی با تحل  AIنمونه، ممکن است    ی . برا د ی نقش نما   ی فایکمبود غذا ا   ا ی  ن ی زم   ش ی گرما 

شود و آموزش را   لی آموز تبد هر دانش   ی برا   یشخص   ی به معلم   تواند ی آموزش، م   ی کاهش کربن ارائه دهد. در حوزه   ی برا 

با سبک   تنظ   ی ر ی ادگی متناسب  موس   ی در عرصه   ی کند. حت   م ی او  و  آثار خلاقانه   ز ی ن   ی ق ی هنر  است  نما   ی ا قادر  ا د ی خلق   نی. 

مس  ی فناور  م   ت ی خلاق   یی و شکوفا   ی وربهره   ش ی افزا  ر ی در  به   یاما ضرور   کند، ی حرکت  کار    صورت است که  به  عادلانه 

از کنترل خارج نگردد و    ی حفظ گردد. چالش بزرگ آن است که هوش مصنوع   زی افراد ن  یخصوص   میگرفته شود و حر

 .ردی و مسئول قرار گ ستهیافراد شا اری در اخت 
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 : (ML) نگیلرن نیماش

 

 

 

 

 

 

ها  خودشان از داده  دهدیامکان م  هاانهیاست که به را  یجذاب از هوش مصنوع   ی( بخشنیماش  یری ادگی)  نگیلرن  ن ی ماش

متوجه    نستاگرامی که ا  یمثال، زمان  یانجام دهند. برا  یها دستور دهد چه کاربه آن  قی طور دقبه  یبدون آنکه کس  اموزند،ی ب

پست  شودیم نوع  چه  هستعلاقه  ییهابه  سل  ییهاآهنگ  یفایاسپات   یوقت   اید،  ی مند    ن ی ا  دهد،یم  شنهادی پ  تانقهیمطابق 

و    هایماری ب  ی ن یبش یپ  یبرا  ی تقلب، در پزشک  یی شناسا  یبرا  ی است. در بانکدار  ت ی است که در حال فعال  نی ماش   یری ادگی

  کند، یم  لی گسترده را تحل   یهاداده  ن یماش   یری ادگی.  شودیها از آن استفاده مطوفان  ینیبش یپ  یبرا  ی در هواشناس  یحت

شناسا را  پ  دینمایم  ییالگوها  م  یقی دق   یهاین یبش یو  ن  یانهی. در هر زمدهد یارائه  مف   ازی که  اطلاعات  استخراج  از    دی به 

 باشد، کاربرد دارد. می حج   یهاداده

 نگرش آینده :  

  م، یعظ   یهاداده  انی که از م  یستمی س  دی کند. تصور کن  جادی ها اداده  لی در تحل   یانقلاب  تواندیم  ندهیدر آ  ن یماش  یری ادگی

حت  ی اطلاعات که  کند  ن  یکشف  آن  زی دانشمندان  ن به  بهانددهی شیندی ها  مثال،  !    یی داروها  تواندیم  MLعنوان 

ها  بحران  یها براتا دولت  د ینما  ینی بش یرا پ  ی اجتماع  یفتارهار  ایکند    د ی هر فرد تول  DNAبر اساس    شدهیسازیشخص

باشند. در حوزه   ییقابل سکونت را شناسا  اراتی کرده و س   لی ها را تحلتلسکوپ  یهاداده  تواندیم  ،یفضانورد  یآماده 

  ی ری ادگیاست    ن ممک  ی. حت دهدیم  شنهادی پ  ینینو  یهایو استراتژ   بخشدیرا بهبود م  کنانی کند. در ورزش، عملکرد باز

الگوها   نی ماش انسان  ی ادهی چ ی پ  یبتواند  اقتصاد  ای  یمانند احساسات  پ  ینوسانات  ادینما  ین یبش یرا  قرار است    یفناور  ن ی. 

صورت بدون تعصب و  ها بهحاصل شود که داده  نانی است اطم  یسازد، اما ضرور  ترقی دق  عیرا در تمام صنا  یری گمیتصم

 .رندی گیم  راربالا مورد استفاده ق تی با امن 
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 :(IoT) اینترنت اشیاء

 

 

 

 

 

 

 

ها با دستگاه   ن ی ! ا نترنت ی تان تا خودرو و ساعت هوشمندتان، به ا و لامپ خانه   خچال یاز    ز، ی چاتصال همه   ی عن ی   اء ی اش  نترنت ی ا 

برقرار م  گر ی کد ی  تمام شده و   ر ی دهد که ش  ص ی تشخ  تواند ی م  خچالتان ی. مثلًا  سازند ی تر مرا آسان   یو زندگ   کنند ی ارتباط 

دهد،  به  سفارش  را  آن  خودکار  رسخانه   یها لامپ   ا ی صورت  هنگام  شهرها،    دنی تان  در  شوند.  روشن   یبرا   IoTشما 

 یحسگرها   ز ی ن  ی . در کشاورز رد ی گی پارک مورد استفاده قرار م  ی جا   افتن ی   ی حت   ا ی   ی در انرژ   یی جو صرفه   ک، ی تراف  ت ی ر ی مد 

IoT  م  ن یی تع  توانند ی م ن   زان ی کنند که خاک چه  ا   از ی آب  موجب   کند ی م   ی آور مع ج   ی اد ی ز   ی ها داده   ی فناور   ن یدارد.  و 

 ک، ی ساخته خواهند شد که تراف  IoTکاملًا هوشمند با کمک    یشهرها   نده،یدر آ آینده:  هوشمندتر گردد.   زی چ همه   شودی م 

صورت و به   رندی در بدن ما قرار گ   IoT  یممکن است حسگرها   ی. حت کنند ی م  تی ر ی صورت خودکار مد را به   ی زباله و انرژ

 .د ی عمل آ به   یر ی لوگها توسط هکرها ج دستگاه   ن یاز نفوذ ا   د ی کنند، اما با  ش ی را پا   مانی سلامت   تی ساعته وضع  ۲4

  نگرش آینده:

  ی صورت خودکار با هم تعامل دارند! شهرها متصل است و به  گریکدیبه    زی چکه همه  ییای دن  یعن ی  اء ی اش   نترنتیا  یندهیآ

صورت  تان به. مثلًا خانهکنندیم  تیریمد  نهی ها را به زباله  یو حت   یانرژ  ک،ی ها تراف در آن  IoT  یکه حسگرها  یهوشمند

  IoT  یحسگرها  ،ی! در پزشکدینمایها را پرداخت مقبض  یو حت  کندیم  میرا تنظ  خچالی  یخودکار دما، نور و موجود

  تواندیم  IoT  ،یکرده و به پزشک هشدار دهند. در کشاورز  ش یپا  یاصورت لحظهسلامت شما را به  توانندیدر بدن م

منابع کمتر، غذا  ق ی را دق   یو کودده   یاری آب با  تا  ا  دی تول   ی شتری ب  ی کند  زن  یفناور   نی شود.  تر،  را آسان  ی دگقرار است 

ممکن    یشود. حت   یری گردد تا از نفوذ هکرها جلوگ  ن ی ها تضمدستگاه  ن ی ا  تی سبزتر و کارآمدتر سازد، اما لازم است امن 

 به کار گرفته شود!  یخ یمر یهاگاهیپا تیریمد یبرا زی در فضا ن IoTاست 
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  :تای د گ یب

 

 

 

 

 

 

 

 

 

گرفته تا    تریی و تو  نستاگرامیا  یهااز پست  شود،یم  دی که هر روز در جهان تول  یاز اطلاعات  یم ی حجم عظ  یعنی  تاید  گی ب

ا  یوجوهاجست  ایساعت هوشمندتان    یهاداده ابزارها داده  ن ی گوگل.  با  و    شوندیم   لی خاص تحل  یها  نکات جالب  تا 

مثلًا چه چ از آن  یدی مف  استخراج گردد؛  م   کی  ده،مد ش  یزی ها  باشد    تواندیشرکت چگونه    ی حت   ایبهتر فروش داشته 

م   یماری ب  کی گسترش  بابدییچگونه  کسب  تا ید  گی .  م به  کمک  به    یبهتر  یهامی تصم   کند یوکارها  و  کنند  اتخاذ 

  ا ت  شودیم  لیتحل  کنانیباز   یهاعنوان نمونه، در ورزش، داده. بهندیکشف نما  یدیجد  یالگوها   کندیدانشمندان کمک م

بهبود  عملکرد آن پ  تاید  گی بآینده:  .ابدیها    ارات ی کشف س  یحت   ای  ن ی منابع زم  تیریها، مدبحران  ینی ب ش ی قرار است در 

 . می ها باش داده تی و امن یخصوص  میمراقب حفظ حر دیکند. تنها با فا یا ینقش بزرگ  دیجد

 نگرش آینده:

م   یزی اطلاعات خواهد بود که هر چ   یمعدن طلا   کی همچون    ندهیدر آ  تاید  گی ب با تحل سازدیرا ممکن    یهاداده  لی . 

رفتار    یحت  اینمود    تیریرا بهتر مد   ی می اقل  رات یی کرد، تغ   ینیبش یپ  وعی از ش   ش یرا پ  ری گهمه  یهایماری ب  توانیم  م، ی عظ

کنند که    دی تول   یزی دهند چه چ  صیتشخ  توانندیها م شرکت  ثال،م  یدرک کرد. برا  یشتری کنندگان را با دقت ب مصرف

موفق  حوزه  یفروش  در  باشد.  ب  یداشته  تحلتلسکوپ  یهاداده  تواندیم  تای د  گی فضا،  را  ح   لیها  به کشف  و    ات ی کند 

قرار است   ی فناور  ن یبرنده کمک کند. ا یهایاستراتژ یدر طراح انی به مرب تواندیم زی . در ورزش ندیکمک نما ینی فرازم

حاصل شود    نانی افراد حفظ گردد و اطم  یخصوص  میحر  دیسازد، اما با  ترعیو سر  ترقی را دق  یانهیدر هر زم  یری گمیتصم

 .رندی گیصورت عادلانه مورد استفاده قرار م ها بهکه داده
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 : نیبلاکچ

 

 

 

 

 

 

 

حسابدار   ک ی مانند    ن ی بلاکچ  غ   تال ی ج ی د   ی دفتر  همه   رقابل ی و  که  است  به   ز ی چ هک  م را  ثبت  شفاف  .  کند ی صورت 

)مثلاً    ن ی تأم   ره ی هوشمند، زنج   ی در قراردادها   تواند ی اما م   شود، ی شناخته م   ن ی کو ت ی مانند ب   تال ی ج ی د   ی در ارزها   شتر ی ب 

همه    ان ی م   ن ی ها در بلاکچ . از آنجا که داده رد یقرار گ   فاده مورد است   ن ی آنلا   ی ر یگ ی رأ   ی حت   ا ی منشأ غذا(    ی بررس   ی برا 

وجود    ت ی اعتماد و شفاف   جاد ی به ا   از ی که ن   ی ا نه ی امن است. در هر زم   ار ی و امکان تقلب وجود ندارد، بس   شوند ی م   ع ی توز 

 .دارد، کاربرد دارد 

تقلب را    زانی و م  دینما  تیتقو  تیهو  تیریمد  یحت  ایآموزش    ، یرا در بانکدار  تالیجیاعتماد د  تواندیم  نیبلاکچ  :ندهیآ

 سازگارتر باشد. ستیز  طی تا با مح  ابدیآن کاهش  یمصرف انرژ دیکاهش دهد، اما با

 نگرش آینده:

نتواند در   کسچی که در آن ه  ی جهان دی ارتقا دهد. تصور کن نینو یرا به سطح  تال ی ج یاعتماد د تواندیم نده یدر آ ن یبلاکچ

  رهی زنج   تواندیم  ن یصورت خودکار اجرا شوند! بلاکچها بهبه واسطه  ازی قراردادها بدون ن  ایتقلب کند    ن یآنلا   یری گیرأ

ا  ن یتأم مثلًا   تیریاست. در مد  کی واقعاً ارگان  ییحاصل شود غذا  نانیفراهم آورد که اطم  راامکان    ن یرا شفاف سازد، 

  توان یرا م  یل ی در آموزش، مدارک تحص  ی. حت دیها را منحصر به خود فرد نمابه داده  یدسترس   تواندیم  تال،یجی د  تیهو

ا  ی سازمن یا  ن یبا بلاکچ دن  یقرار است کلاهبردار   یفناور  ن ی کرد.  اعتماد را در  و    شیافزا  تالی ج ید  ی ای را کاهش دهد 

 تر باشد. مناسب ستیز ط یمح یتا برا ابدیآن کاهش  یبالا یمصرف انرژ دیدهد، اما با
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  :گرافن

 

 

 

 

 

 

 

 

 رتر یپذتر، انعطافالعاده نازک، سبک و مقاوم است که از کربن ساخته شده است. از فولاد مستحکمفوق  ی اگرافن ماده

بس برق  انتقال  در  باتر  اری و  در  است.  حت  هایگوش  یلمس  یهاش ینماصفحه  شارژ،عیسر  یهایکارآمد    زات ی تجه   یو 

مثال،    یتر سازد. براتر و مقاومها را سبکدستگاه  تواندیم   افن . گرشودیبه کار گرفته م  ی ستیز  یمانند حسگرها  یپزشک

 .گردندیضدآب و مقاوم با استفاده از گرافن ممکن م یهالباس ای شوندیشارژ م  هیکه در چند ثان  ییهایباتر

آ  تواندیم  گرافن :ندهیآ باتر  یهایگوش  ندهیدر  و حت فوق  یهایتاشو،  امکان  ییفضا   یهاسازه  یکارآمد  سازد.   ریپذرا 

 تر شود.تر و در دسترسآن ارزان دی تول  دیتنها با

 نگرش آینده:

  یی تاشو  یهایگوش  شوند،یشارژ م  ه ی که در چند ثان  ییها یرا متحول سازد. باتر  یفناور  یای دن  تواندیم  ندهی گرافن در آ

خواهند    ریپذبا گرافن امکان  یهمگ  کنند،یم  تی که درون بدن فعال  یپزشک  یحسگرها  ایکه مانند کاغذ سبک هستند،  

ا م   ن یشد.  انرژ  جادیا  ی کارآمد  ادهالعفوق  یدی خورش  ی هاپنل  تواندیماده  که  ارزان  یکند  را  فضا،  پاک  در  تر سازند. 

م برا  یی هاسازه  تواندیگرافن  مقاوم  و  حت  دی تول   ماهای فضاپ  یسبک  لباس  یکند.  است  گرافن    یهوشمند  یهاممکن  با 

به بتوانند دما را  تنظ ساخته شوند که  اندینما  می صورت خودکار  تر و مقاوم  تر،بکها را سقرار است دستگاه  یفناور  ن ی. 

 همگان قابل استفاده باشد. یتر گردد تا براآن ارزان دیکند، اما لازم است تول دارتریپا
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  :م یسی ب  برق

 

 

 

 

 

 

 

 

 

 

 

از امواج    یری گ. با بهرهیامروز  یهایگوش   می س یب  یبدون استفاده از کابل، مانند شارژرها  یانتقال انرژ  یعن ی  می سیبرق ب

خانگ  یحت   ا ی  یبرق  یخودروها  ،یگوش  توان یم  ،ی سی مغناط  یهادانی م  ای ا  یلوازم  کرد.  شارژ  را    یزندگ  یفناور  ن یرا 

  شود، یکوچک استفاده م   اسی کابل نخواهد بود. در حال حاضر در مق   یجوو به جست  یاز ی ن  گرید  رایز  سازد،یتر مآسان

 .کند دای پ یترتوسعه گسترده تواندیم ندهیاما در آ

ب   ییشهرها  دی کن  تصور :ندهیآ برق  آن  است، خودروهاهمه  میسیکه در  دسترس  ح  یبرق  ی جا در  حرکت شارژ    ن یدر 

سلامت    یامواج برا  ن یحاصل شود که ا   نان ی اطم   دی. تنها باکنندیم  افت یدر  یاز راه دور انرژ  ماها ی فضاپ  یحت  ای  شوندیم

 .ستندی ن بارانیانسان ز

 نگرش آینده:

  یو گوش   د ی رو ی راه م   ابان یدر خ   د یما حذف کند! تصور کن  ی از زندگ   ی کل ها را به کابل   تواند ی م   نده ی در آ   م یس ی برق ب 

ن   ی برق   ی خودروها   ا ی   شود، ی صورت خودکار شارژ م شما به    ی فناور   نی . ا شوند ی در جاده شارژ م   ستگاه، ی به ا   از یبدون 

. در فضا، برق ردیبه برق ندارند، مورد استفاده قرار گ   ی که دسترس  فتاده مناطق دورا   ی حت  ای ها، ادارات  در خانه   تواند ی م 

ماهواره   یانرژ   تواند ی م   م یس ی ب  به  نما   یی فضا   ی ها گاه ی پا  ا ی ها  را  ب دی منتقل  برق  تر و را آسان  ی قرار است زندگ   م یس ی . 

 دارند.  یی بالا   ی انرژ   ی و بازده   ستند یمضر ن   ی سلامت  ی حاصل شود که امواج آن برا   نان یاطم  د ی کند، اما با  رتر یپذ انعطاف 
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 : یابر انش یرا

 

 

را اجرا    ن یسنگ   یهاکرد، برنامه  رهی با آن داده ذخ  توانیاست که م   نترنتیدر ا  کری پغول  یانهیرا  کیمانند    یابر  انش یرا

ن  یک یگراف  ی هایباز  ی حت   اینمود   بدون  را  ازی را  برا  یانهیبه  کرد.  تجربه  درا  یقدرتمند  گوگل    ای  کس ینتفل  و،یمثال، 

را  ن یآنلا   یهایباز م  یابر   انش یاز  ابرندیبهره  م   یفناور  ن ی.  اجازه  همه  ابزارها   دهدیبه  دسترس  یبه  داشته    یقدرتمند 

 .باشد متی قافزار گرانبه سخت ازیکه نباشند، بدون آن

و تنها   شوندیتر م ها سبکابر اجرا خواهد شد، دستگاه قیاز طر ییویدیو یها یاز آموزش تا باز زی چ همه نده،یآ در:ندهیآ

 گردد. ن یها تضمداده تی امن دیخواهد بود. تنها با  ازی پرسرعت ن نترنتیبه ا

 نگرش آینده:

  د، ی کن   ه ی ته   متی قتاپ گراننخواهد بود لپ  یازی ن  گری! ددیرا به ابر منتقل نما  زی چ قرار است همه  ندهیدر آ  یابر  انش یرا

  د ی. تصور کن شوندیانجام م  یابر  یها توسط سرورهاداده  یساز رهی ذخ  یو حت   دهی چی پ  یافزارهانرم  ن،ی سنگ   یهایباز  رایز

 ی ابر  انش یآموزش، را  ی. در حوزهدیی را اجرا نما  یک ی گراف  ی هایباز  ای  یعلم  ی هایسازهی شب  دی ساده بتوان  ی گوش  کیبا  

ا  تی فی با ک  یمجاز  یهاکلاس  تواندیم ارائه دهد.  ارزانقرار است دستگاه  یفناور  ن یبالا را در سراسر جهان  تر و ها را 

 . ستها محافظت از داده  یبرا یقو ت ی پرسرعت و امن  نترنتیا ازمندی تر سازد، اما نسبک
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 : (VR)  واقعیت مجازی 

             

 

 

 

 

 

 

 

م  تالیج ید  ییای دن  یمجاز  تی واقع با    کندیخلق  م  کیکه  آن غوطه  توانیهدست  مکان  در  آن  در  واقعاً  انگار  ور شد، 

معروف   یهاموزه  دی توانیم  ای  دی هست  ییجنگ فضا  کیوسط    دی کنیحس م VR یهایمثال، در باز   ی! برادیحضور دار

 VR .ردی گ یمورد استفاده قرار م ن یتمر یبرا زی ن  یمهندس ای ی. در آموزش پزشکدی کن  دی بازد یصورت مجاز جهان را به

 .سازدیم تریرا واقع یریادگیو  زتری انگ جانیرا ه یزندگ

حس    یروز  دی. شادینما  تریرا واقع  ی مجاز  یسفرها  یحت  ای  ی درس، جلسات کار  یهاقرار است کلاس  VR   ه:ندیآ

 .تر شوندصرفهبهها مقرونهدست دیافزوده شود، اما با  یفناور ن یبه ا زی لامسه و بو ن

 نگرش آینده:

که انگار در    ی درس   ی ها کلاس   د ی بودن را به اوج برساند. تصور کن   ی قرار است حس واقع   ی مجاز   ت ی واقع   نده، ی در آ 

م   خ ی مر   ی اره ی س   ی رو   ا ی   ی خ ی تار   ی موزه   ک ی  کار شوند ی برگزار  هر    ی مجاز   ی سفرها   ا ی ها  کنسرت   ، ی ! جلسات  به 

از عمل کمک    ش ی پ   ن ی تمر   ی به جراحان برا   تواند ی م   VR  ، ی خواهد بود. در پزشک   ر ی پذ امکان   VRنقطه از جهان با  

  ز یمزه ن   ا ی حس لامسه، بو    ی ممکن است روز   ی . حت رد یمورد استفاده قرار گ   ا ی درمان فوب   ی برا   ی درمان در روان   ا ی کند  

تر و  ها ارزان هدست   د ی و کار را دگرگون سازد، اما با   ی سرگرم   ، ی ر ی ادگ ی قرار است    ی فناور   ن ی اضافه شود. ا   VRبه  

 . وند تر ش راحت 
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 : ۶G و ۵G  اینترنت

 

 

 

 

 

 

 

 

 

 

 

 

 هی را در چند ثان  4K  لم ی ف   توانی که م   ی ا گونه را کاهش داده است؛ به   ر ی تأخ  زان ی شده و م  تر ع ی چند برابر سر    5G  با   نترنت، ی ا 

را فوراً   م ی عظ   یها داده   تواند ی خواهد بود و م  تر ع ی هم سر   ن یاز ا   یکه هنوز در حال توسعه است، حت   6G  دانلود کرد. نسل 

 .است   ی از راه دور ضرور  ی ها ی جراح ی حت  ا ی خودران   یهوشمند، خودروها   یها شهر ی برا   یفناور  ن یمنتقل کند. ا 

از هولوگرام   تواند ی م   6G:  نده ی آ  استفاده  ماهواره   ی حت   ا ی کاملًا متصل    ی شهرها   ، یبعد سه   ی ها امکان  با  فراهم ارتباط  ها را 

 .ابد ی آن در سراسر جهان گسترش    ی ها رساخت ی ز   دی سازد. تنها با 

 نگرش آینده:

ا  دن   نترنت ینسل ششم  است  به   تال ی جید   ی ا ی قرار  آن  کند! سرعت  متحول  م   ی قدررا  که  بود  در   4K  لم ی ف  توان ی خواهد  را 

از راه دور را با دقت   ی های خودران تا جراح  یهوشمند و خودروها   یاز شهرها   تواند ی م   6Gکرد.    افتیدر   هی از ثان   ی کسر 

! یی فضا  یها گاه یبا پا  ر ی ارتباط بدون تأخ ای  شوندی که در اتاق ظاهر م   یبعد ه س یها هولوگرام   د ی . تصور کن د ی نما  یبانی بالا پشت 

ن  تر ع ی تر، سر را متصل   ز ی چقرار است همه   ی فناور   ن ی ا  اما  انرژ   یجهان   ی ها رساخت ی به ز   از ی و هوشمندتر سازد،   یو مصرف 

 باشد.  ی همگان قابل دسترس ی دارد تا برا   ن یی پا 
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 : یتال ی جید  یدوقلوها 

               

 

 

 

 

 

 

 

مانند    یواقع   ستمی س  ای  ء یش   کیاز    یمجاز   یانسخه  تالیجید  یدوقلو   ک ی  یحت  ایکارخانه    ما،یموتور هواپ  کیاست، 

  توان یمثال، م  ینمود. برا  ی سازنهیرا به  زی چکرد و همه  ییاز وقوع شناسا  ش یمشکلات را پ  توانیم  یفناور  ن یشهر. با ا

 .از ساخت در برابر زلزله چگونه عمل خواهد کرد ش یپل پ کیکرد که  یبررس

شهرها    توانندیم  تال یجی د  یدوقلوها:ندهیآ شب   یحت  ایکل  را  انسان  تصم  یساز هیبدن  تا  و    ها یری گمیکنند  هوشمندتر 

 دارند. ازیقدرتمند ن یهاانهیفراوان و را یها انجام شود، اما به داده ترمن یا

 نگرش آینده:

  ی مجاز   ی ا نسخه   د یعمل خواهند کرد. تصور کن  ی واقع   ی ا یدن   یهوشمند برا   ی ا نه ی مانند آ   تال یج ی د   ی دوقلوها   نده، ی در آ 

 دیتوان ی مثال، م   یقرار است رخ دهد. برا   ی ز یکه نشان دهد چه چ   د یبدن خود داشته باش   ی حت  ا ی شهر، کارخانه    ک ی از  

کن م   کی   د یمشاهده  مقاومت  چگونه  زلزله  برابر  در  پ   ی مار یب   ک ی   ا ی   کندی پل  چگونه  بدن  در دی نما ی م   شرفت یدر   .

 کیتراف   توانند ی کنند. در شهرها، م   ی نیب شیاز وقوع پ   شی را پ   آلات نیماش   ی خراب   توانند ی م   تال یج ی د   ی صنعت، دوقلوها 

انرژ  مصرف  به   ی و  ا ند ی نما   نه یرا  تصم  ی فناور   نی .  است  دق   ی ر یگ م یقرار  ن   تر ق یرا  اما  و   م یعظ   ی ها داده   ازمند یکند، 

 است.  شرفته یپ   ی ها انه ی را 

 



 

175 
 

 :  انسان و ربات یهمکار 

 

 

 

 

 

 

 

 

معنا   یفناور  ن یا به  ی همکار  یبه  ربات  و  ربات  میت   کیعنوان  انسان  است.  وظاکارآمد    ا ی  ی تکرار  ن،یسنگ  فیها 

ها قطعات را  ها رباتمثال، در کارخانه  یهستند. برا  یری گ می و تصم   ت ی ها مسئول خلاقو انسان  دهندیخطرناک را انجام م

 ندهیها قرار است در آرباتآینده:  .رندی گیمورد استفاده قرار م  قی دق   یهایانجام جراح  یبرا  یو در پزشک  کنندیمونتاژ م

حاصل    نان ی اطم   دیکنند. تنها با  ت ی در کنار انسان فعال  یدر همه مشاغل از آموزش تا فضانورد  کینزد  یعنوان همکاران به

 حفظ شوند.  یانسان ی هاشود که شغل

 نگرش آینده:

آ همکاران ربات  نده،یدر  به  تبد  ی برا  یمی صم  ی ها  کن   لیانسان  تصور  شد.  کارخانه  د ی خواهند  رباتدر  وظاها،    فیها 

بر عهده بگ  نی سنگ  باش  تی و شما فقط بر خلاق   رندی را    اری بس  یهایجراح  توانندیها مربات  ،ی. در پزشک دی تمرکز داشته 

را بهتر درک کنند و   یها احساسات انسانممکن است ربات ی. حتندینماها به سالمندان کمک در خانه ا یانجام دهند  قی دق

حاصل شود    نان ی اطم  دیدهد، اما با  ش ی را افزا  یمنیو ا  یور قرار است بهره  ی فناور  ن یبتوانند با افراد گفتگو داشته باشند. ا

 بمانند. ینشوند و همواره تحت کنترل انسان باق یانسان  یهاشغل ن ی گزیها جاکه ربات
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 : یعی و ساخت مواد طب یچهاربعد   ،یبعد سه  چاپ 

                 

 

 

 

 

 

 

 

  مای قطعات هواپ   ی حت   ایپروتز    ، یبازمانند اسباب  ی واقع  یا ی کاغذ، اش   یجااما به  کند،یعمل م  نتر یمانند پر  ی بعدچاپ سه

  دهند، یشکل م ریی که در گذر زمان تغ کندیاستفاده م یگام فراتر رفته و از مواد  کی ی. چاپ چهاربعد دینمایم دی را تول 

لوله ترم  یامثلًا  را  طب کندیم  میکه خود  مواد  با  مواد  زی ن  یع ی . چاپ  م  اهی گ  ایمانند چوب    یاز  مح   ردی گیبهره  به    ط ی تا 

آندهیآ.نرساند  بی آس  ستیز در  لباس    توانیم  نده،ی:  ا  یحت  ایخانه،  از  استفاده  با  را  ا  یفناور  ن ی غذا  کرد!    نی چاپ 

 تر گردد. صرفهبهکمک کند، اما لازم است مقرون ستیز طیبه حفظ مح تواندیم ی تکنولوژ

 نگرش آینده:

غذا    ی حت   ا ی خانه، خودرو    توانند ی قرار است جهان را دگرگون سازند! افراد م   ی و چهاربعد   ی بعد سه چاپ    نده،یدر آ

پر  با  نما   نتر ی را  چهاربعد ند ی چاپ  چاپ  مواد   ی .  م   ی از  تغ   کند ی استفاده  زمان  طول  در  م   ر یی که  مثلاً    دهند، ی شکل 

  ط ی کند که به مح   د ی تول   ی محصولات   تواند ی م   ز ی ن   ی ع ی طب   د . چاپ با موا شوند ی صورت خودکار سرهم م که به   یی ها مبل 

  نی بافت زنده وجود خواهد داشت. ا   ی حت   ا ی   ی امکان چاپ اندام مصنوع   ، ی پزشک   ی نرسانند. در حوزه   ب ی آس   ست ی ز 

ساخت   ی فناور  صنعت  است  پزشک قرار  مح  ی وساز،  از  حفاظت  با  ستیز  طیو  اما  سازد،  متحول  در  ارزان  دیرا  و  تر 

 .دتر شودسترس
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 :  یکوانتوم ی هاانه یو را محاسبات 

              

 

 

 

 

 

 

  ی که برا  یحل کنند، کار  هیرا در چند ثان  دهی چی تا مسائل پ  رندی گیکوانتوم بهره م  بی عج  ن یاز قوان  یکوانتوم  یها انهیرا

م  هاونی ل ی م  یمعمول  یها انهیرا طول  به  بهانجامدیسال  معنوان.  بشکنند    دهی چیپ  یرمزها  توانندیمثال،  جد  ایرا   دیمواد 

جهان را ممکن سازند، اما    یسازهی شب  یحت  ای  شرفتهی پ  ینو، رمزنگار   یداروها  توانندیم  ها انهیرا  ن ی: اندهیآ.ندیکشف نما

 است.  نهیپرهز  اری ها همچنان بسساخت آن

 نگرش آینده: 

آ  ی کوانتوم  یها انهیرا غ  توانندیم  ندهی در  نما  رممکن ی مسائل  بهندیرا حل  معنوان.  ثان  توانندیمثال،  چند    ی داروها  هیدر 

  نیبهتر توانندیم ک،ی لجست ی. در حوزهندینما یسازهی جهان را شب  یحت  ایرا بشکنند  دهی چیپ ی کنند، رمزها  یطراح دیجد

قرار است    یفناور  ن ی. اندینما  یطراح   یکارآمدتر  یهاستمی س  ،یانرژ  یدر حوزه  وکنند    دای کالا را پ  لیتحو  یبرا  ری مس

پزشک  به سطح  یعلم،  را  را   دیجد  یو صنعت  اما ساخت  مقرون  داریپا  یکوانتوم  یهاانهیببرد،  همچنان  بهو    ک یصرفه 

 .شودیچالش محسوب م

 

 

 

 

  



 

178 
 

 : یاانه یرا   یی نایچهره و ب  صی تشخ

                

 

 

 

 

 

 

 

 

 

 

 

به ا  صیتشخ باز کردن قفل   د،ی هست  یکه چه کس   شودیصورت شما متوجه م  دنیبا د  انهیمعناست که را  ن یچهره  مانند 

  ص ی تشخ   یخودران برا  یرا درک کنند، مثلًا در خودروها  ریتا تصاو  کندیکمک م  هان ی به ماش   ی اانهیرا  یینای . بیگوش

  ی فناور  ن ی : اندهیآ.کاربرد دارد  زی ها ن فروشگاه  ی حت   ای  یکشاورز   ت،یدر امن   ی فناور  ن ی. اشودیاستفاده م  یی علائم راهنما

 بود. ار ی هوش   یخصوص  مینسبت به حفظ حر دیرا بهبود بخشد، اما با دیخر  یو تجربه تی امن تواندیم

 نگرش آینده:

خطر    ابانی که در خ   ییهان یدورب  دی ! تصور کن دیابرقهرمان عمل نما  کی  یهامانند چشم  تواندیم  ندهیدر آ  یاانهیرا  یینای ب

قفل درها،    تواندیچهره م  ص ی . تشخ کنندیرا درک م  ییکه علائم راهنما  ی خودران  یخودروها  ای  دهندیم  ص یرا تشخ

  یشنهادهای دهد و پ  ص ی شما را تشخ   حاتی ترج   تواندیها، م. در فروشگاهدیرا باز نما  یبانک  ی هاحساب  ی حت   ا ی  هایگوش

و    یخصوص  میمراقب حر  دیرا ارتقاء دهد، اما با  یسرگرم  یو حت  دیخر  ت،ی قرار است امن  یفناور  ن یمتناسب ارائه دهد. ا

 ها بود.احتمال سوءاستفاده از داده
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 : هاباتو چت  یصوت  یها رابط 

           

 

 

 

 

 

 

ها  بات. چتدی ها ارتباط برقرار کنبا صحبت کردن با دستگاه  دهندیالکسا به شما اجازه م  ا ی  یری مانند س  یصوت   ی هارابط

 .دهندیها پاسخ مبه پرسش  ای کنندیرزرو م طی مثلًا بل ند،ینمایو مشکلاتتان را برطرف م کنندیبا شما گفتگو م زی ن

 د یهمراهتان باشند، اما با  شه ی احساسات شما را درک کنند و هم  ی شخص  یارهای ابزارها قرار است همچون دست  ن ی: اندهیآ

 .دیعمل آبه یر ی ها جلوگاز سوءاستفاده از داده

 نگرش آینده:

تنها با صحبت کردن    دیباهوش در کنار شما خواهند بود. تصور کن  یمانند دوست  ندهیها در آباتو چت  یصوت   ی هارابط

احساسات شما را درک کنند و    توانندیها مبات. چتدیی نما  تیریرا مد  تانیکار  ی هابرنامه  یحت  ایخانه، خودرو    دی بتوان

نما گفتگو  شما  با  مشاور  آموزندیهمچون  در  شخص به  توانندیم  ش،.  معلم  خر  یعنوان  در  و  کنند   ن یبهتر  د،یعمل 

ا  شنهادهای پ دهند.  ارائه  تکنولوژ  یفناور  ن ی را  با  تعامل  است  آسان  یقرار  نمارا  با  د،یتر  امن  دیاما  اطمداده  تی از    نانی ها 

 حاصل کرد.
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 :)دِرون(  نی بدون سرنش  یماها یهواپ

        

 

 

 

 

 

 

 

  ی حت  ای  ی بسته، کشاورز  ل یتحو  ،ی بردارلمی ف  یو برا  کنندیهستند که بدون خلبان پرواز م  ی کوچک  یماهای ها هواپدرون

  ی رسانکمک  ی عی طب  یا یدر بلا   ایکنند    ی مزارع را بررس  توانندیمثال، معنوان. بهرندی گیمورد استفاده قرار م   یبردارنقشه

بسته: درونندهیآ.ندینما قرار است  پ  ترعیها را سرها  نقش    یفایا  ی نجات و فضانورد  ات ی در عمل  ا یدهند    لی تحو  ک ی از 

 گردد.  می تنظ   یدرست ها بهآن یپرواز ن یاما لازم است قوان ند،ینما

 نگرش آینده:

آدرون در  تسخ  ندهی ها  را  آسمان  است  آنندینما  ری قرار  م!  سربسته  توانندیها  را  پ   ترعیها  در    لیتحو  کی از  دهند، 

شناسا  یکشاورز کنند    یی به  کمک  عمل  ایآفات  انسان  ات ی در  پنجات،  را  حتندینما  دا ی ها  گروه   ی.  است  از    یممکن 

بتوانند سازهدرون بسازند    ییهاها  مانند پل  ا  خیاکتشاف در مر  ی راب  ایبزرگ  قرار است    یفناور  ن یبه کار گرفته شوند. 

 و اجرا گردد.  ن یها تدوآن یمنیو ا یپرواز ن ی و اکتشاف را سرعت ببخشد، اما لازم است قوان ی کشاورز ل، یتحو
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 : نانو و علم مواد ی فناور

            

 

 

 

 

 

 

 

 

  ی برا  یقی دق   ی داروها  تواندیم  ی فناور  نیکوچک )نانومتر( است. ا  ار ی بس  اس ی کار با مواد در مق  یبه معنا   ی نانوتکنولوژ

ب فوق  ای  هایماری درمان  تول ساخت  یبرا  یقومواد  بهدینما  دی وساز  نانوبوتعنوان.  ممثال،  انسان    توانندیها  بدن  در 

دهند  یسرطان  یهاسلول قرار  هدف  نانوتکنولوژندهیآ.را  ر  هایماری ب  تواندیم  ی:  نو  ایسازد    کن شهیرا   یبرا  ین یمواد 

 است. خطریها ب و سلامت انسان ستیز  طی مح  یحاصل شود که برا  نانی اطم  دیکند، اما با دی تول   ماهای فضاپ

 نگرش آینده:

نانوبوت  ندهیدر آ  ی نانوتکنولوژ و    ییرا در بدن شناسا  یسرطان   ی هاسلول  توانندیها مهمچون جادو عمل خواهد کرد! 

  د ی تر تول سبک  ی ماهای فضاپ  ا یمقاوم در برابر زلزله    ییهاساختمان  توانندیم  یی. مواد نانوندیدرمان نما  یبه جراح   ازی بدون ن

وساز را  و ساخت  ستیز  طیمح  ،یقرار است پزشک  یفناور  ن یکنند. ا  هیممکن است بتوانند هوا و آب را تصف   یکنند. حت 

 ضرر ندارد.  عتیانسان و طب  یسلامت یحاصل کرد که برا نانی اطم دیاما با د،یمتحول نما
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 : هوشمند   ی ها لباس 

                    

 

 

 

 

 

رنگ خود را    ی حت   ای  ندینما  م ی کنند، دما را تنظ   ی ضربان قلب را بررس  توانند یحسگر هستند و م  یهوشمند دارا  ی هالباس

به  ریی تغ م  کیمثال،  عنواندهند.  م   تواندیژاکت  چه  دهد  اندهیآ.دیاسوزانده  یکالر  زانینشان  ملباس  ن ی:  به    توانندیها 

 تر شوند.تر و مقاوماطراف تعامل داشته باشند، اما لازم است ارزان طیبا مح ایکمک کنند  یسلامت

 نگرش آینده:

که ضربان قلب را    یژاکت   دی شوند. تصور کن   لیروزمره تبد  یاز زندگ  یهوشمند قرار است به بخش   یهالباس  نده،یدر آ

تنظ  کند،یم  یبررس را  خورش  ی حت   ای  دینمایم   میدما  نور  م   ی گوش  دیبا  شارژ  را  مکند یشما  ورزشکاران    توانند ی! 

  ی را بهبود بخشد، ول  یمد و راحت  ،یقرار است سلامت   یفناور  ن ی. ادینمایم  لی ها را تحل بپوشند که عملکرد آن  ییهالباس

 همه قابل استفاده باشد.  یتر گردد تا براتر و مقاومارزان دیبا
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 : یبر یسا تیامن

 

 

 

 

 

 

  ی هاتعداد دستگاه  ش یدر برابر هکرهاست. با افزا تالیجید  ی ای در دن ها ستمی ها و س محافظت از داده یبه معنا ی بریسا ت ی امن 

 .دینمایمحافظت م یشخص  یها داده ای ی مثال، از اطلاعات بانکعنواناست. به افته ی یشتر ی ب  تی موضوع اهم  ن ی متصل، ا

  ی کند، ول  یری جلوگ   دهی چ یاز حملات پ  تواندیم  یبریسا  تیامن   ، یو محاسبات کوانتوم  ی : با کمک هوش مصنوعندهیآ

 . می گام از هکرها جلوتر باش  کیهمواره  دیبا

 نگرش آینده: 

از هوش مصنوع  یای دن  یبرا  تال ی ج یسپر د  کیهمانند    ندهیدر آ  یبریسا  تی امن  استفاده  با  و   ی متصل عمل خواهد کرد. 

م هکر   تواندیکوانتوم،  پ  یحملات  پ  ینی ب ش یرا  نما  ش یو  متوقف  وقوع  کن دیاز  تصور  داده  ییا ی دن   دی .    ، یبانک  یهاکه 

ا  یشخص   ا ی  یپزشک ا  منیکاملًا  ا   ی فناور  ن ی باشند.  و دستگاه  ی هوشمند، خودروها  یاز شهرها  ستقرار    یهاخودران 

 .ردی بگ ی شی هوشمند پ یهمواره از هکرها دیبا یمتصل محافظت کند، ول
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 :خودران ه ینقل  لیوسا

           

 

 

 

 

 

 

 

با استفاده از حسگرها و هوش مصنوع  ی هان ی ماش ن  ی خودران  م  از ی بدون  مثال، شرکت  عنوان. بهکنندیبه راننده حرکت 

تصادفات    زان ی خودروها م  ن ی کند. ا  یصورت خودکار رانندگاست که خودرو بتواند به  یی هایتسلا در حال توسعه فناور

خودران خواهند شد    یها مملو از خودروها: جادهندهیآ.دهند یم  ارکاربران قر  اری در اخت   یشتری را کاهش داده و زمان ب

 حل شوند.  یو اخلاق یمن یرا کاهش خواهند داد، اما لازم است مسائل ا یو آلودگ  کی که تراف

 نگرش آینده:

صورت  که به  دیشو  ییسوار خودرو  دی دهند! تصور کن  رییها را تغجاده  یخودران قرار است چهره  یهان ی ماش  نده،یدر آ

به مقصد م ا  رساندیخودکار شما را  بتوان  نیو در  نما  ا ی  دی تماشا کن  لم ی ف  د ی مدت  از    نی. ادیی مطالعه  با استفاده  خودروها 

  ی در شهرها  توانندیم  یخواهند کرد. حت  نهیرا به  کی داده و تراف  هش تصادفات را کا   زانی م  یحسگرها و هوش مصنوع 

زمان و   یی جوقرار است در صرفه ی فناور  ن ی . اندیرا انتخاب نما  یبهتر ی رهای ارتباط برقرار کرده و مس گریکدی هوشمند با 

 آن برطرف شود.  یو اخلاق یمن یمسائل ا دیکند، اما با  فای ا ینقش مهم یانرژ
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 : یدن یپوش ی هاگجت

 

 

 

 

 

 

 

 

اطلاعات سلامت  تی واقع  ی هانکیع  ایهوشمند    یهامانند ساعت  یدنی پوش   یهاگجت   ی ای دن  ی حت   ایها  اعلان  ،ی افزوده، 

 .ابندی را ب ری مس  AR نکیبا ع ایضربان قلب را نشان دهند  توانندیمثال، معنوان. بهدهندیم ش ی را نما تالیجید

اندهیآ کنند  گجت  ن ی:  کار  انسان  فکر  با  است  ممکن  زندگ  تی واقع  ایها  وارد  را  نما  یافزوده   دیبا  یول  ند،یروزمره 

 تر شوند.تر و ارزانسبک

 نگرش آینده: 

آ بخش   ی دنی پوش  ی هاگجت  نده،یدر  تبد  یبه  انسان  بدن  ساعت  ل یاز  شد.    AR  ی هانکیع  ایهوشمند    یهاخواهند 

روزمره کنند. تصور    یافزوده را وارد زندگ  تی واقع  یحت  ایرا نشان دهند    ری مس  ند،ینما  یسلامت انسان را بررس  توانندیم

خارج   ینک یع  دی کن  زبان  به  یکه  همرا  براصورت  م  تانیزمان  م  ای  دینمایترجمه  کنترل  کردن  فکر  با  اشودیتنها    نی! 

 تر گردد.صرفهبهتر و مقرونسبک دیبا ی را بهبود بخشد، ول یکار و سلامت ،یقرار است سرگرم یفناور

  



 

186 
 

 : یاهسته  ی همجوش

 

 

 

 

 

 

 

 

خورش   ی انرژ  دی تول  یبرا  ی روش  یاهسته  یهمجوش مانند  که  م  دی است  انرژ  کندیعمل  ب  یو  و   دی تول   تینهایپاک 

:  ندهیآ.شودیآن کار م  یرو  هاشگاهیبگذارد. در حال حاضر در آزما  یخطرناک برجا  یهاکه زبالهبدون آن   د،ینمایم

ا انرژ  تواندیبرسد، م  تیبه موفق   یفناور  ن یاگر  نما  یمشکل  با  یانرژ  ماهای به فضاپ  ی و حت   دیجهان را حل  اما   دیبدهد، 

 شود.   یات ی و عمل ی اقتصاد

 نگرش آینده: 

مانند خورش  یانرژ  ن یتأم  ی منبع اصل  تواندیم  ی اهسته  ی همجوش  نده،یدر آ ب  یانرژ  د، ی در جهان گردد!    ت ینهایپاک و 

ا  یها خواهد کرد، بدون زباله  دی تول   یانرژ  ن یرا تأم  ماهای فضاپ  ی ها و حت شهرها، کارخانه  تواندیم  یفناور  ن یخطرناک. 

کمک کند،    ستیز  طیدهد و به نجات مح  انیرا پا  یلی فس  یهاسوختبه    یقرار است وابستگ  یا هسته  ی. همجوشدینما

 شود.   دای آن پ یسازیاتی ارزان و عمل یبرا یروش دیبا یول
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 :کشاورزی مدرن و هوشمند

 

 

 

 

 

 

 

 

 

 

از درون  یکشاورز م  ی ها، حسگرها و هوش مصنوعهوشمند  منابع کمتر، غذا  کندیاستفاده  با  شود.    دی تول  یشتری ب  یتا 

 .ندینمایم یها آفات را بررس درون ایدارد  ازی به آب ن  یچه زمان  اهی گ کنندینمونه، حسگرها مشخص م  یبرا

از کشاورزان کوچک    تی لازم است حما  یکمک کنند، ول  ی به رفع گرسنگ  توانندیم  ی : مزارع خودکار و عمودندهیآ

 . ردی انجام گ زی ن

 نگرش آینده: 

ها و ها، ربات. مزارع خودکار با دروندیکمک نما  یجهان  یبردن گرسنگ   ن ی به از ب  تواندیم  ندهیهوشمند در آ  یکشاورز

برا  دی با مصرف کمتر آب و کود تول  یشتری ب  یقادر خواهند بود غذا  یهوش مصنوع  ن  یکنند.    از ی مثال، حسگرها زمان 

تازه و سالم    یغذا  توانندیدر دل شهرها م  ی. مزارع عمودبرندیم  ن ی ها آفات را از بو درون  کنندیبه آب را اعلام م  اهی گ

اندینما  دی تول کشاورز  یفناور  ن ی.  است  پا  یقرار  قابل  دارتریرا  بادسترسو  اما  سازد،  کشاورزان    دیتر  از  آن  کنار  در 

 شود.   تیحما زی کوچک ن 
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 :تال یجید  یها عاملستم یس

 

 

 

 

 

 

 

 

روز  روزبه  ها ستمی س  نی. اگردندیها در آن اجرا مها هستند که برنامهمغز دستگاه  د،یاندرو  ا ی  ندوزی مانند و  ها عاملستمی س

 .شوندیتر مهوشمندتر و متصل

آندهیآ در  دستگاه  ها عاملستمی س  نده،ی:  در  تمام  را  م  کپارچهی  ستمی اکوس  کیها  زندگ  ندی نمایمتصل  ساده  یو  تر  را 

 بمانند.  یهمچنان امن و کاربرپسند باق دیبا ی خواهند کرد، ول

 نگرش آینده: 

آ • دستگاه  هاعاملستمی س  نده،یدر  در  تمام  را  م  کپارچهی  ستمی اکوس  کیها  متصل  هم  کن ند ینمایبه  تصور    دی . 

  ها ستمی س   نیا  یهماهنگ باشند. هوش مصنوع   عاملستمی س  ک یشما با    خچال ی  ی تاپ، خودرو و حت لپ  ، یگوش

تر و  را ساده  تالیجی د  یاست زندگ  قرار  یفناور  ن ی . اندینما  ین یبش یشما را پ  یازهای تر خواهد کرد تا نرا باهوش

 حفظ شود. زی و سهولت استفاده ن  ت یامن  دیبا یتر کند، ولهماهنگ

 

 

 

 

 



 

189 
 

 : موجودات زنده   ی ک ی و جهش ژنت   ک ی ژنوم 

 

 

 

 

 

 

 

 

و  کی ژنوم و  مطالعه  مژن  شیرایبه  ب  پردازد یها  تقو  ایدرمان    هایماری تا  زنده  برا  تی موجودات  م  یشوند.    توان یمثال، 

را    هایماری ب  تواندیم  کی: ژنوم ندهیآ  .را درمان نمود  ی ارث  ی هایماری ب   ایرشد کنند    یکرد که در خشکسال  د ی تول  یاهان ی گ

جد   ایکند    کن شهیر مح  یبرا  یدیموجودات  به  اخلاق  دیبا  یول  د،ینما  جادیا  ستی ز  طی کمک  مسائل  به  و    ینسبت 

 بود.  اری هوش  یط ی محستیز

 نگرش آینده: 

مانند سرطان را درمان    یارث   ی هایماری قادر است ب  یفناور  ن ی ! ادینما  فیرا از نو تعر  یزندگ  تواندیم  ک ی ژنوم  نده،یدر آ

شرا  ی اهانی گ  ا یکند   در  که  نما  طیبسازد  رشد  حتندیسخت  گونه  ی.  است  شوند  منقرض  یهاممکن  بازگردانده    ا یشده 

به مح  یبرا  ی واناتی ح هر فرد    DNAبر اساس    شدهیسازیشخص  یداروها  ،ی ساخته شوند. در پزشک  ستیز  طیکمک 

ا  جیرا شد.  سلامت   یفناور  ن یخواهد  است  کشاورز   یقرار  با  یو  اما  سازد،  متحول  اخلاق  دیرا  مسائل  دقت  و    یبه 

 شود.  ی آن بررس یط ی محستیز
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 : رباتیک

 

 

 

 

 

انجام آن    ای  ستندی ها قادر به انجام آن ناست که انسان  ییانجام کارها  یها براساخت و استفاده از ربات  ی به معنا  کی ربات

ربات  شانیبرا است.  م دشوار  مختلف  توانندیها  بازوها  یاشکال  از  باشند؛  کارخانه  یکیمکان  یداشته  پهپادها  در  تا    ا یها 

اانسان  ی هاربات بربات  نینما.  موتور  اها  سنسورها،  از  مصنوعاستفاده  هوش  و  مح  ی ها  و   طیقادرند  کرده  درک  را 

 . ندینما یری گمیتصم

 نگرش آینده: 

ب  زی چقرار است همه  کی ربات   نده،یدر آ از درمان  متحول سازد؛  ربات  مارانی را  تا ربات  یها با  که در    ییهاجراح گرفته 

  اد یها  ربات  ، یهوش مصنوع  شرفتی شرکت خواهند کرد. با پ  ییفضا  یهاتیدر مأمور  ا یرسان خواهند بود  خانه کمک

در    یاندهی داشته باشند. در واقع، آ  ی ع ی ها تعامل طب و با انسان  ندینما  یری گ می تنها کار کنند، بلکه تصم خواهند گرفت که نه

که از  البته به شرط آن  افت؛یما حضور خواهند    یپرستار در زندگ  یحت  ایعنوان همکار، همراه  ها بهاست که ربات  ش ی پ

 هوشمندانه استفاده شود.  ی ها به شکلآن

 به نظرت دنیا به کجا میرسه؟؟ 

این تکنولوژی  در به    زی چقرار است همهها  آینده،  نما  گریکدیرا  تا شهرتان و حت از خانه  ند؛یمتصل  بدنتان! تصور    یتان 

ب   یی ای دن  د ی کن  آن  در  م  شیپ  هایماری که  درمان  بروز  برا  شوند،یاز  حت  یغذا  و  است،  فراهم    ک یبا    دی توان یم   یهمه 

 !د یی سفر نما خیبه مر VRهدست 

. رندی مورد استفاده قرار گ  من یصورت عادلانه و ابه  هایفناور  ن یا  میحاصل کن   نانی اطم  دیاست که با  ن یمهم ا  ینکته  اما

اراده    دیبا  زی هستند. ما ن  ری مس  نیمهم ا  ی هاژن از چالش   ش یرایمانند و  یو مسائل اخلاق  ی بریسا  تی امن  ، یخصوص  میحر

 . .می نو عقب نمان یای و از دن می را بساز ندهیآ م،یها گام بردارحوزه ن ی که در ا  می داشته باش 

  



 

191 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 هوش مصنوعی 
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 مغز مصنوعی چیست؟  -1 درس

گیری و  شده در جهان است. این اندام توانایی تفکر، یادگیری، تصمیمترین ساختارهای شناختهمغز انسان یکی از پیچیده

سال دارد.  مهندسان تلاش کردهحتی خلاقیت  و  دانشمندان  که  رایانههاست  در  را  طبیعی  این شگفتی  شبیهاند  سازی  ها 

نتیجه تلاشکنند.  این  میی  که  سیستمی  است؛  مصنوعی«  »مغز  نام  به  مفهومی  پیدایش  دادهها  از  و  تواند  بگیرد  یاد  ها 

انسان مانند  بگیرد، درست  می  .تصمیم  مغز مصنوعی چگونه ساخته  میاما  و چگونه کار  این شود؟  به  پاسخ  برای  کند؟ 

 .سازی مصنوعی آن داشته باشیمها، ابتدا باید نگاهی به مغز طبیعی انسان و سپس به مدلسؤال

 هاانسان و نورون : مغز  1بخش 

 های هوشمند ها: سلولنورون 

مغز انسان از میلیاردها سلول عصبی به نام »نورون« ساخته شده است. هر نورون مانند یک ایستگاه پردازش اطلاعات عمل  

یا سایر نورونکند. نورونمی اطراف  به دیگر  ها را پردازش میکنند، آنها دریافت میها اطلاعات را از محیط  کنند و 

 .دهندها انتقال مینورون

 :یک نورون سه بخش اصلی دارد 

 ی اطلاعات( کنندهها )دریافتدندریت •

 جسم سلولی )مرکز پردازش(  •

 آکسون )مسیر انتقال پیام( •

نورون این  اتصال  شبکهبا  یکدیگر،  به  میها  تشکیل  پیچیده  و ای  تفکر  زبان،  احساسات،  حافظه،  ایجاد  باعث  که  شود 

 .شودهای حرکتی در انسان میمهارت

 ی مصنوع یعصب  هایشبکه  - عتیاز طب دی: تقل۲بخش 

 ست؟یچ یمصنوع  نورون

  ن ی. اکندیم یسازهی را شب ی نورون واقع کیاست که رفتار  یو منطق یاضیر یمدل  ینورون مصنوع  انه،یعلوم را در

 دی تول   یو خروج کنند یپردازش م یها را طبق قواعدآن کنند،یم  افتیرا در یاطلاعات عدد یمصنوع  یهانورون

 .شودمنتقل   گرید یها به نورون تواندیهر نورون م  ی. خروجکنندیم
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 ی مصنوع  یعصب یهاشبکه

ها از  شبکه نی. اردی گیشکل م   « یمصنوع  ی»شبکه عصب شوند،یبه هم متصل م ینورون مصنوع  یادیکه تعداد ز یهنگام

 :اندشده  لی تشک یسه بخش اصل 

 .شوندیقسمت م  ن ی خام وارد ا  یهاداده :(Input Layer) یورود هیلا •

 .صدا، عدد، متن  ر،ی: تصومثال

 .کنندیم ری و تفس  یبنددسته ،یاطلاعات را بررس  :(Hidden Layers) پنهان ی هاهیلا •

 .شبکه هستند لیو تحل  یری ادگیمحل  هاهیلا ن یا

 .کندیشبکه را به کاربر اعلام م  لی تحل جه ینت  :(Output Layer) یخروج  هیلا •

 .سگ کی ایگربه است  کیمربوط به  ریتصو  کهن یا ص ی : تشخ مثال

ها در طول آموزش  وزن  ن ی. ا کندیم  نیی آن ارتباط را تع  تی»وزن« است که نقش اهم  کی   یها دارانورون  نی اتصال ب   هر

 .ردی بگ اد ی یتا مغز مصنوع کنندیم ریی تغ

 گیرد؟ : مغز مصنوعی چگونه یاد می۳بخش 

شبکه در  یادگیری  الگوریتمفرآیند  کمک  به  مصنوعی  عصبی  »پس های  مانند  میهایی  انجام  خطا«  این  انتشار  در  شود. 

ها را تنظیم  های ارتباطی بین نوروندهد و وزنکند، خطاها را تشخیص میهایی را بررسی میها، شبکه بارها دادهالگوریتم

نتایج دقیقمی به دست آوردکند تا  با آزمون و خطا و تمرین مداوم، خود را تنظیم  به  .تری  طور خلاصه، مغز مصنوعی 

 .هاستکند. این فرآیند شبیه تجربه و یادگیری انسانمی

 : مقایسه مغز طبیعی و مصنوعی ۴بخش 

 ( ی)شبکه عصب یمغز مصنوع مغز انسان یژگیو

 ( یاضی)ر یمصنوع نورون ی ستینورون ز پردازش  واحد

 هامحدود به داده  یول عیسر ریپذانعطاف  اریبس  یول ترآهسته  پردازش  سرعت

 تمیها و الگوربه داده  محدود گسترده و خلاقانه  اریبس یریادگی قدرت

 افزار(به برق و سخت  ازی)ن   ادیز نسبتاً نه یو به  کم ی مصرف یانرژ

 ندارد  دارد ی و آگاه احساس
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 در کلاس یمغز مصنوع یسازهشبی - یری تصو یساز: مدل ۵بخش 

 با طناب و کارت  ی: ساخت شبکه عصبیگروه  تی فعال

 :لازم لی وسا

 ها نورون یبرا ییهاکارت

 ها اتصال نورون ینخ برا ا ی طناب

 ی پنهان و خروج ،یورود یبرا یرنگ  کاغذ

 :اجرا مراحل

تقس   آموزاندانش  گروه  سه  ورودشوندیم  میبه  خروج  ،ی:  طراح   ها کارت.یپنهان،  نورون  شکل  نام  یبه    ی گذارو 

ب  ها طناب.شوندیم اتصال  عنوان  منورون  ن ی به  استفاده  فرض  کی.شوندیها  تشخ  یداده  شبکه  وانی ح  صی)مثلًا  وارد   )

مس  شودیم نما  ری و  م  ش یپردازش  نوروندانش   ان،یپا  در.شودیداده  نقش  بازآموزان  را  نت   کنندیم   یها  را    یینها  جهی و 

 .کنندیاعلام م

 وگوی کلاسی گفت 

 تواند جایگزین مغز انسان شود؟ آیا مغز مصنوعی می •

 نظر شما، یادگیری ماشین شبیه یادگیری انسان است؟ به •

 در آینده، مغز مصنوعی چه کاربردهای جدیدی خواهد داشت؟  •

 فصل  انی پا یهانی تمر

 .دی ده حی را توض  یو نورون مصنوع  یستیتفاوت نورون ز .۱

 .دی هر بخش را شرح ده  فهی و وظ دیرا نام ببر  یمصنوع یشبکه عصب کی یاجزا .۲

 .دیمثال بزن ی واقع یدر زندگ یمصنوع  یکاربرد شبکه عصب  کی .3

 به آموزش دارد؟  ازی ن یچرا مغز مصنوع  .4

 کنند؟ یم ریی و چگونه تغ ستی چ  ی ها در شبکه عصب نقش وزن. 5
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 گیرد؟ هوش مصنوعی چگونه یاد می  -۲ درس

طور که انسان از  رود. همانهای هوش، چه در انسان و چه در ماشین، به شمار میترین ویژگییادگیری یکی از مهم

گیرد و ها یاد میهای خاص خود از دادهگیرد، هوش مصنوعی نیز به روشها و بازخوردها یاد میها، تمرین تجربه

شویم که شامل »یادگیری  بخشد. در این فصل، با سه روش اصلی یادگیری ماشین آشنا میعملکرد خود را بهبود می

 .نظارت« و »یادگیری تقویتی« هستندبا نظارت«، »یادگیری بی

 (Supervised Learning) یادگیری با نظارت : 1بخش 

کند که هم ورودی )مثلًا تصویر یا  ها استفاده میای از دادهدر این روش، هوش مصنوعی برای یادگیری از مجموعه

عدد( و هم خروجی صحیح )پاسخ درست( در آن مشخص است. در واقع، این روش مانند مدرسه رفتن است که  

 .گیردهای درست، یاد میآموز با دیدن مثالدهد و دانش آموز نشان میمعلم پاسخ صحیح را به دانش 

 :مثال ساده 

خواهیم به یک برنامه یاد بدهیم که گربه را از سگ تشخیص دهد. به آن تصاویر زیادی از گربه و  فرض کنید می

می نشان  میسگ  تصویر  هر  برای  و  این  دهیم  از  مصنوعی  هوش  است«.  سگ  »این  یا  است«  گربه  »این  نویسیم 

هایی مربوط به گربه و کدام مربوط به سگ است. در نهایت،  گیرد که چه ویژگیخورده یاد میهای برچسبداده

    .تواند تصویر جدیدی را ببیند و بگوید: »این احتمالاً گربه است« می

 (Unsupervised Learning) نظارتیادگیری بی: ۲بخش 

به هوش مصنوعی داده میدر این روش، داده باشند. هدف،  شوند بدون آن ها  یا پاسخ صحیحی داشته  که برچسب 

 .رودکار میها بههاست. این روش بیشتر برای کشف روابط پنهان بین دادهبندی دادهشناسایی الگوها و گروه

 :مثال ساده 

می که  داریم  برنامه  یک  کنید  گروهتصور  شباهتخواهیم  براساس  را  حیوانات  از  نمیهایی  اما  کند،  پیدا  دانیم  ها 

های ظاهری  ها را بر اساس ویژگیکدام حیوان چه نامی دارد. اگر تصاویر مختلفی از حیوانات به برنامه بدهیم، آن

هایی مانند »حیوانات شبیه به گربه«، »شبیه به سگ« و...  مانند اندازه گوش، رنگ پوست، تعداد پا و غیره، به گروه

 .ها چیستکه بداند نام واقعی حیوانکند؛ بدون آنتقسیم می

 (Reinforcement Learning)  یادگیری تقویتی: ۳بخش 

کند و براساس این نوع یادگیری شبیه به آموزش با تشویق و تنبیه است. هوش مصنوعی در یک محیط فعالیت می

گیرد و اگر اشتباه کند، امتیاز  کند. اگر عملکردش درست باشد، پاداش مینتایج عملکرد خود، بازخورد دریافت می

 .گیردمنفی. با تکرار و تجربه، بهترین تصمیم را یاد می
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 :مثال ساده 

خواهد یاد بگیرد چگونه از یک مارپیچ عبور کند تا به مقصد برسد. در ابتدا ممکن است  فرض کنید یک ربات می

بست برسد یا از مسیر منحرف شود. اما هر بار که مسیر درستی را طی کند، پاداش  مسیرهای اشتباه زیادی برود، به بن 

 .گیرد که برای گرفتن بیشترین پاداش، باید مسیر صحیح را انتخاب کندکم یاد میگیرد. کممی

 مقایسه سه روش یادگیری 

 ینمونه کاربرد هایژگیو یریادگیروش 

 چهره، ترجمه خودکار صیتشخ خورده داردبرچسب  یهابه داده  ازین نظارت  با

 داده  یسازفشرده  ان،یمشتر یبندگروه  بدون برچسب  یهاپنهان در داده  ی الگوها کشف نظارتیب

 یوتر یکامپ یهای ربات، باز آموزش تجربه و پاداش  ق یاز طر یریادگی یتیتقو

 فعالیت کلاسی 

 عنوان: بازی یادگیری ماشین

 :آموز تشکیل شودسه گروه دانش   .۱

 ها(دهندهگروه اول: معلم )برچسب •

 گروه دوم: مدل هوش مصنوعی )یادگیرنده(  •

 ها( ها )دارای تصاویر یا نوشتهگروه سوم: داده •

 .ها داده بدهند و در حالت یادگیری با نظارت، پاسخ درست را نیز اعلام کنندمعلمان باید به مدل   .۲

ها تا چه  بندی انجام دهند و معلمان بررسی کنند که گروهها خود باید تلاش کنند گروهنظارت، مدلدر حالت بی  .3

 .اندحد درست

 .دهندگیرند، معلمان پاداش یا تنبیه )امتیاز مثبت یا منفی( میمی ها تصمیمدر حالت تقویتی، مدل  .4

 وگو در کلاس گفت 

 هاست؟ تر به یادگیری انساننظر شما کدام روش یادگیری شبیهبه •

 ها پاسخ درست را بدهیم؟آیا همیشه باید به ماشین  •

 چرا یادگیری از تجربه ممکن است بهتر از یادگیری از معلم باشد؟ •

 :  ن یتمر

 .دیها را شرح دهو تفاوت آن دی کن  فیرا تعر  یری ادگیسه نوع   .۱

 .دی سیبنو یواقع یمثال از زندگ  کی ،یری ادگیهر نوع  یبرا  .۲

 با نظارت است؟ یری ادگ یبهتر از  نظارتیب یری ادگی یط یدر چه شرا  .3

 چرا؟  م؟یکن یاستفاده م یری ادگ یاز چه نوع  م، ی شطرنج آموزش ده  یباز یرا برا ن یماش کی می اگر بخواه  . 4
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 گیری هوشمند ها و تصمیم داده -۳ درس

آموختن    یطور که انسان براهستند. همان  یری گمیو تصم  یری ادگی  یبرا  هیها مانند مواد اولداده  ،یهوش مصنوع   یای در دن

تجربه شنبه  د  هادهی ها،  مصنوع   ازی ن   هادهیو  هوش  داده  یری ادگی  یبرا  زی ن   یدارد،  ه به  داده،  بدون  است.  وابسته    چی ها 

ها خوب، درست و  همه داده  ایاست: آ  نیتر ا. اما سؤال مهمردی بگ   یم ی تصم  ای  ردی بگ  ادی را    یزی چ   تواندینم  یتمی الگور

و در    م ی کنیم  ی بررس  نی ماش   ی ری ادگیسپس نقش آن را در    م، ی شویفصل، ابتدا با مفهوم داده آشنا م  ن ی اند؟ در اعادلانه

 . میپردازیناعادلانه« م  یها مهم »داده یبه مسئله تینها

 ست؟ی : داده چ1بخش 

 :داده  ف یتعر

تصو  یاطلاعات  هاداده عدد،  شکل  به  که  متن    ر،یهستند  ا  یبی ترک  ایصدا،  م  هان یاز  دادهشوندیثبت  م.   ک ی  توانندیها 

از   ساده  باشند  یشدهضبط  یصدا   ایکتاب،    کیدر    یاجمله  وان، ی ح   کیعکس  مصنوع  در .انسان  ها  داده  ،ی هوش 

اصل داده  ها تمیالگور  ی خوراک  هرچه  بهستند.  باک   شتر ی ها  ماش  ترتیفی و  م  ن یباشند،  را    تواندیبهتر  و    ردی بگ   اد یالگوها 

 .ردی بگ  میتصم

 :مثال

 .دهدیم صیرا تشخ واناتی که ح یاآموزش برنامه یها براها و سگگربه ریتصاو •

 .کندیحل م یاضیر نیکه تمر یاآموزش برنامه یآن برا یهاو پاسخ یاضیر  سوالات •

 گفتار.  صیتشخ   ستمی آموزش س یافراد مختلف برا یصدا •

 نیماش  یریادگ ی: نقش داده در ۲بخش 

مانند   ی هوش مصنوع  ی ها تم یها همان گل خام هستند، و الگور مجسمه از گل است. داده   ک یمانند ساختن    ن ی ماش  یر ی ادگ ی 

 .بسازد   ییبا ی ز  ی مجسمه   تواند ی هنرمند هم نم ن یبهتر   ی وجود نداشته باشد، حت   یساز. اگر گل خوب دستان هنرمند مجسمه 

 :می کنیاشاره م یری ادگیداده در  یدی به چند نقش کل نجایا در

 .داندینم زی چ  چی بدون داده ه ن ی : ماش یری ادگی منبع •

 .ردی گ یم  ادیو  سازدیم  ییالگوها  ن ی ها، ماش داده ی: از رویالگوبردار •

 .ردی بگ میتصم دیموضوعات جد یدرباره تواندیگرفته، م ادیکه   ییهابر اساس داده ن ی: ماشیسازمیتصم •

 :مثال

 .از آن نداشته است یاشب را بشناسد؛ چون تجربه تواندیآن نم م،یروز نشان ده ریبرنامه فقط تصاو کیبه  اگر
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 شود؟ ها ناعادلانه باشند چه می: وقتی داده ۳بخش 

افتد؟ ها کامل یا درست نباشند، چه اتفاقی میها نقش مهمی در یادگیری دارند. اما اگر این دادهتا اینجا دیدیم که داده

گونه فکر کند.  گیرد که همانها فقط از یک گروه خاص یا یک نوع رفتار تهیه شده باشند، ماشین یاد میاگر بیشتر داده

 .های اشتباه یا ناعادلانه شود تواند منجر به تصمیماین موضوع می

 .نامندها« میاین مشکل را »سوگیری داده

 :مثال

های آموزشی آن از افراد با پوست  ی افراد را تشخیص دهد، اما بیشتر دادهایم که باید چهرهای ساختهفرض کنید برنامه

شود، ممکن است او را درست تشخیص  رو میروشن بوده است. در این صورت، وقتی برنامه با فردی با پوست تیره روبه

 .وجود آمده استها بهندهد. این مشکل نه به خاطر بد بودن برنامه، بلکه به خاطر ناعادلانه بودن داده

 ها توجه کنیم؟بخش چهارم: چرا باید به عدالت در داده 

 :ها ناعادلانه باشند، هوش مصنوعی ممکن استاگر داده

 .افراد خاصی را نادیده بگیرد یا اشتباه قضاوت کند •

 .های نابرابر ایجاد کندفرصت •

 .باعث تبعیض در خدمات شود )مثلًا در استخدام یا پذیرش دانشگاه( •

پذیری باشد. بنابراین دانشمندان هوش  هوش مصنوعی ابزار بسیار قدرتمندی است. اما این قدرت باید همراه با مسئولیت

 .درستی در نظر گرفته شوندها بهها و دیدگاهی گروهها دقت کنند تا همهمصنوعی باید در انتخاب داده

 وگو در کلاس گفت 

 های نادرست باشد؟ای اشتباه کند؟ آیا ممکن است دلیل آن دادهاید که برنامهحال دیدهآیا تا به •

 ها را بهتر انتخاب کند؟ ها کامل نیستند؟ چه کسی باید آنچرا بعضی داده •

برنامه اگر شما می  • کردید تا عادلانه آوری می های آن را جمع ی هوشمند بسازید، چگونه داده خواستید یک 

 باشد؟
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 ی کلاس ت یفعال

 : ساخت مجموعه داده عادلانه ت یفعال عنوان

 .دی کن م ی نفره تقس  4 ای 3 یهاکلاس را به گروه. ۱

 ها و...()مثلًا چهره، لباس، غذا، گل شودیموضوع داده م کیبه هر گروه  .۲

 .شود   ت ی ها تنوع و عدالت رعا که در مجموعه آن   ی ا گونه کنند، به   ی آور جمع   ن ی آموزش ماش   ی برا   ی ر ی تصاو   د ی ها با گروه . 3

  تیکه چگونه عدالت را در آن رعا دهندیم حی و توض کنندیم یخود را معرف یهاها مجموعه دادهگروه  ان،ی. در پا4

 اند. کرده

   ن یتمر

 .دارد ن یماش یری ادگیدر  یو چه نقش  ستی که داده چ دی کن فیبه زبان ساده تعر. ۱

 .ساز استچرا مشکل  دی ده حی و توض دی ناعادلانه بزن ی هامثال از داده کی. ۲

 د؟ی کنیم تیها رعارا در انتخاب داده  ییزهای . چه چدیبساز هاوهی م ص ی تشخ  یبرا یا برنامه دی خواهیم دی فرض کن . 3

 ها توجه کند؟به عدالت در داده دیبا ی چرا هوش مصنوع. 4
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 اخلاق در یادگیری ماشین  -۴ درس

انسان نیست، اما تصمیم گذارد. از انتخاب یک  ها تأثیر میگیرد که بر زندگی انسانهایی میهوش مصنوعی مانند یک 

ها، همه و همه ممکن است تحت تأثیر  ها و بیمارستانگیری در بانکآهنگ در گوشی، تا پیشنهاد خرید، یا حتی تصمیم

الگوریتمالگوریتم این  اگر  حال  بگیرند.  قرار  یادگیرنده  میهای  چه  بگیرند  تصمیم  ناعادلانه   شود؟ ها 

پایه مفاهیم  با  فصل،  این  میدر  آشنا  ماشین  یادگیری  در  اخلاق  میای  بررسی  و  چرا  شویم  در    انصافکنیم 

 .های هوشمند اهمیت زیادی داردگیریتصمیم

 ها چیست؟ : تبعیض در داده 1 بخش

تر از گروه دیگر قرار بگیرند. در دنیای هوش مصنوعی، این  یعنی یک گروه از افراد یا اشیا به ناحق برتر یا پایین   تبعیض

 .باشند (Bias) های ورودی دارای سوگیریافتد که دادهاتفاق زمانی می

 :تعریف ساده 

داده  در  این   هاتبعیض  دادهیعنی  آنکه  از  ماشین  که  میهایی  یاد  نمایندهها  فقط  و گیرد،  باشند  خاصی  گروه  ی 

 .شان بدهندهای دیگر را نادیده بگیرند یا اطلاعات نادرست دربارهگروه 

 :مثال

برنامه • دارد چهرهاگر  احتمال  باشد،  دیده  آموزش  مردان  با تصاویر  فقط  تشخیص چهره  یا  ی  کمتر  را  زنان  ی 

 .اشتباه تشخیص دهد

برنامه  • داده اگر  اساس  بر  بیشتر  وام  اعطای  برای  بانک  دیده ی  آموزش  منطقه خاص  یک  افراد  به  مربوط  های 

 .ها واجد شرایط باشندتری بدهد، حتی اگر آنی اعتبار پایین باشد، ممکن است به افراد مناطق دیگر نمره

 منصف باشد؟ دیبا ی: چرا هوش مصنوع ۲ بخش

انسان  یاز اصول مهم در همه  یک ی)عدالت(    انصاف انتظار دار  یجوامع  ما  با    زی ن  هایکه فناور  میاست.  باشند و  منصف 

 .مردم به صورت برابر رفتار کنند یهمه

به برخ  ادی  ن یاگر آن ماش  شود،یسپرده م  ن ی به دست ماش   یری گ می تصم  یوقت  باشد که   ا یافراد کمتر توجه کند    یگرفته 

 .بر جامعه داشته باشد یو جد یاثرات منف  تواندیم  ن یقائل شود، ا  ضی تبع  ینسبت به گروه 

 AI ضرورت انصاف در لیدلا

 .رودیم ن یاز ب  ی ناعادلانه عمل کند، اعتماد عموم ن ی. اگر ماشکنندیاعتماد م ی: مردم به فناور یبه فناور اعتماد •

 .باشد بارانیافراد ز ی برخ یناعادلانه ممکن است برا یهامی : تصم بی از آس یری شگی پ •

 .استفاده از خدمات هوشمند داشته باشند یفرصت برابر برا دیها: همه باحقوق انسان حفظ •

 یندهینسل آ  اموزند، ی ب  زی اخلاق و انصاف را ن  ،یری ادگیدر کنار    هان ی : اگر ماشندهیبه نسل آ  یاخلاق   آموزش •

 خواهد بود.  تریانسان یفناور
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 ناعادلانه یریگمیچند مثال ساده از تصم ی: بررس۳ بخش

 : میپردازیم ن یناعادلانه توسط ماش  یهامیساده و قابل فهم از تصم یبخش، به چند نمونه ن یا در

 مثال ح یتوض ی مشکل اخلاق 

 یگرفتن تنوع ظاهر   ده ی ناد 

 هاانسان 

اند، از آن ظاهر بوده  شتر ی ها ب داده   چون

 .اند ها مناسب فقط آن   کند ی برنامه فکر م

فقط  غات، ی تبل  ی انتخاب عکس برا  ی برنامه 

 ش ی افراد با ظاهر خاص را نما  ری تصاو 

 .دهد ی م 

 ی م ی قد  ی های از باز  شتر ی ها ب داده   چون یت ی جنس  یساز شه ی کل 

 .اند شده  ی الگوبردار

 ی هات ی فقط به شخص ی ا انه ی را   یباز   ک ی 

 .دهد ی مذکر نقش قهرمان م 

 جی را   یها فقط از لهجه  ی صوت  ی ها داده  یزبان  ی عدالت ی ب 

 .اند جمع شده 

 لی به دل   ن، یآنلا   ی دهنمره   ستم ی س  ک ی 

صحبت او را اشتباه   نده، یخاص گو  ی لهجه 

 .دهد ی م  ص ی تشخ

 

 ناعادلانه هایتصمیم تشخیص –: فعالیت کلاسی ۴ بخش

 های رفع آندرک عملی تبعیض در هوش مصنوعی و شناخت راه :هدف

 :روش اجرا

 .شودکلاس به چند گروه تقسیم می .1

 :شودبه هر گروه یکی از سناریوهای زیر داده می .2

o مدرسه سیستم  دانش یک  زندگی  محل  اساس  بر  که  آنای  کلاسآموزان،  به  را  مختلف ها  های 

 .فرستدمی

o کندی ترجمه که جملات زنان را دقیق ترجمه مییک برنامه. 

o داندهای اروپایی را زیبا میی هنری که فقط چهرهیک برنامه. 

 :ها بایدگروه  .3

o  مشکل ناعادلانه را شناسایی کنند. 

o ها(حدس بزنند علت آن چیست )مثلًا نوع داده. 

o توان آن را منصفانه کردپیشنهاد دهند که چگونه می. 

 .دهدی کار خود را برای کلاس ارائه میدر پایان، هر گروه نتیجه .4
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 ی کلاسی وگو گفت 

 گرفته باشد؟  میکه به نظر شما ناعادلانه تصم دیابرخورد کرده یاتا به حال با برنامه ایآ •

 شوند؟ یم یناعدالت ن ی باعث ا یها هم گاهانسان ایها ناعادلانه هستند؟ آاز داده ینظر شما چرا بعض به •

 انصاف کند؟  تیرا مجبور به رعا ی وجود داشته باشد که هوش مصنوع یقانون دیبا ایآ •

   ن یتمر

 .ها به چه معناستدر داده ضیکه تبع   دی ده  حیبا زبان خودتان توض .۱

 .دی سیبنو لی مهم است؟ دو دل  ن یماش یری ادگ یچرا انصاف در  .۲

 .دی کن   انی ب ن یماش  ایناعادلانه توسط برنامه  یری گ می مثال از تصم  کی .3

 ساخت.  یترمنصف یهوش مصنوع توانیکه چطور م دی ده شنهادی پ. 4

 

 

 


